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After completing this chapter, you should be able to: 

 

i. Explain the concept of ICT and its related terminologies. 

ii. Describe the information processing cycle. 

iii. Outline the uses of ICT for educational/social/economic purposes. 

iv. Analyse the impact of ICT on educational, social and economic development 

v. Identify career opportunities in ICT. 
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Chapter

 1 

INFORMATION AND COMMUNICATIONS  

TECHNOLOGY (ICT) 
 

 

 

INTRODUCTION 

 

Everyday in our waking lives we are invariably greeted by ICT. You were probably shaken 

off your bed by a mobile phone. What you used next is pretty much unknown to me, but I am 

sure you crossed the road on your way to school and probably saw a traffic light which kept 

you safe from ―knocking over‖ a vehicle, a bicycle perhaps. You get to school, and if you are 

a fresh student, the secretary puts information/data 

about you on his/her computer. You might have 

used other gargets which fit into the category. 

 But one thing you have to know is as different as 

they are, they have one thing in common; they are 

ACTIVITY 
 

Let students brainstorm and 
come out with the meaning of 
ICT and its related terminologies 
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ICT gargets. 

I am sure your first question is what makes these ICT gargets? Let‘s talk about that. 

 

THE CONCEPT OF ICT 
 

ICT stands for "Information and Communications Technology".  

The term ICT refers to the combination of telephone networks with computer networks 

through a single cabling or link system. ICT should be read as "Information Technology and 

Communication Technology" literally to make clear its meaning. 

The main concept of ICT is to link various devices and activities to the computer. Now the 

next question is how does ICT do that? Let us consider that. 

 
 

ICT TERMINOLOGIES 

 

ICTs 

We have already talks about ICT being information and communications technology. ICTs 

on the other hand stands for information communications technologies. ICTs refers to the 

various devices and machines that come together to make clear the meaning of ICT. As we 

have discovered already ICT links the individual gadgetries together. Therefore, we can say 

that ICT links the various ICTs together. 

 
  

Data  

Data is anything in the form of numbers, text, images and sound that is suitable for 

processing and storage by a computer. 

Before a computer can perform any function it must be fed with the required data. For 

example, if you want a computer to perform a calculation, you first have to feed it with the 

specific numbers say, 4 + 2, and that is the data which the computer processes. 

Examples of data: 

The record of students in a school. 

The stock of goods in a supermarket. 

The amount of goods sold by a store. 

The number hours that an employee is supposed to work. 

 

Most data are meaningless unless fully processed. It is therefore important for the computer 

to understand the data it is fed with before it can process it. A processed data is known as 

information. A computer can only process a specific data when it has the appropriate program 

to run it with.  

A collection of data organized for storage in a computer memory and designed for easy 

access by authorized users is known as database. Data is often confused with programs and 

information. 
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Program  

A Computer Program is a set of instructions that directs a computer to perform some function 

or combination of functions.  

In the above data (4 + 2), before the computer can give you an answer it has to get specific 

instructions. 

For the instructions to be carried out, a computer must execute a program, that is, the 

computer reads the program, and then follows the steps encoded in the program in a precise 

order until completion. A program can be executed in many different times, with each 

execution producing a potentially different result depending on the options and data that the 

user gives the computer. 

 
 

Information  

Information is the answer given by the computer after a successful processing of data. 

  For example, in our above data, 4 + 2, the expected answer will be 6. Therefore, 6 is the 

information. For a user to get the expected information, they must enter a data which the 

computer understands. The information received can then be stored or distributed or yet still, 

be run on another program. In that case, the information becomes data again. For example 

the information we got above which is 6, can become data if it is used again in another 

program to be 6 + 4. 

 
 

E-learning  

Also known as electronic learning, E-learning refers to the acquisition of knowledge and 

skill using electronic technologies such as computer, the internet, intranet and extranet. 

E-learning is basically the computer and network enabled transfer 

of skills and knowledge. E-learning comprises the use electronic 

applications and processes to learn. E-learning applications and 

processes include Web-based learning, computer-based learning, 

virtual classrooms and digital collaboration. Content is delivered 

through the Internet, intranet/extranet, audio or video tape, 

satellite TV, and CD-ROM. It can be self paced or instructor led 

and includes media in the form of text, image, animation, 

streaming video and audio. 

Acronyms like CBT (Computer-Based Training), IBT (Internet-

Based Training) or WBT (Web-Based Training) have been used 

as synonyms to e-learning. Today one can still find these terms 

being used, along with variations of e-learning such as elearning, 

Elearning and eLearning. 

 
 

 

 

EXERCISE 
 

Students to explain some of the basic ICT 
concepts and terminologies and show their 
differences e.g. ICT and ICTs Data and Information 

Fig. 1.0 Primary School children on their 

computers 
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INFORMATION PROCESSING CYCLE 

 

Before a computer presents information from data, it must go through a set of systematic 

steps known as the information processing cycle. 

By definition, information processing cycle could said to be the sequence of events that the 

computer goes through in processing information. 

The information processing cycle includes: 

 input, processing, output, storage and distribution. 

 

The following diagram illustrates the information processing cycle. 

 

 

 

 

 

 

 

 

 

 

 

 

1. Input (Receiving data)  

Input is the act of collecting and putting raw data from the outside world into the computer 

so that it can be put into an information system. Inputting data include: 

 Putting the names of student onto a computer in order to know the number of student in 

the school.  

 Collecting jokes for a joke book and typing jokes into a word processor.  

 

Devices used to input data into a computer are known as input devices. Without input 

devices, a computer would only be a display device and not allow users to interact with it, 

much like a television set. 

 

Typical input devices include:  

 keyboards  

 mice 

 scanners, 

 bar code readers  

 joysticks  

 web cam  

 MIDI keyboard  

 gamepad  

 digital camera  

 microphone  

INPUT

PROCESSING

OUTPUT

STORAGE 

DISTRIBUTION

mouse 

web cam 

digital camera 
gamepad 

scanner Fig. 1.1: input devices 

http://www.computerhope.com/jargon/p/paddle.htm
http://www.computerhope.com/jargon/d/digicame.htm
http://www.computerhope.com/jargon/m/micrphon.htm
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2. Processing (of data) 

Data processing is done by the central processing unit of a computer. 

A central processing unit (CPU), microprocessor or sometimes simply processor, is the 

referred to as the brain of the computer. It is the key component in a digital computer 

capable of executing a program. It interprets computer program instructions and processes 

data.  

The speed of the CPU is determined by clock speed. The higher the clock speed, faster the 

computer. The speed of the CPU is measured in megahertz (MHz). 100 MHz = 100 million 

cycles/second of information processing.  

 

There are two typical components of a CPU. They are the:  

 The arithmetic logic unit (ALU), which performs arithmetic and logical operations. In 

other words, the ALU takes care of all the computations or calculations in the computer.    

 The control unit (CU), which extracts instructions from memory and decodes and executes 

them, calling on the ALU when necessary.  

 

 

 

 

 

 

 

3. Output  

In information processing, output is the process of transmitting the processing information. 

Essentially, output is the presentation of any data exiting a computer system. This could be 

in the form of printed paper, audio or video. In the medical industry this might include CT 

scans or x-rays. Typically in computing, data is entered through various forms (input) into a 

computer, the data is often manipulated, and then information is presented to a human 

(output). 

 Devices which output information are known as output devices. 

Example of output devices are: 

  

Monitors 

Printers  

Speakers 

LCD Projectors 

 

Fig. 1.2: Processors 

http://www.webopedia.com/TERM/c/ALU.html
http://www.webopedia.com/TERM/c/CU.html
http://www.webopedia.com/TERM/c/instruction.html
http://www.webopedia.com/TERM/c/memory.html
http://www.webopedia.com/TERM/c/execute.html
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4. Storage  

Storage or mass storage refers to various techniques and devices for storing large amounts 

of data. The earliest storage devices were punched paper cards, which were used as early 

as 1804 to control silk-weaving looms. Modern mass storage devices include all types of 

disk drives and tape drives. Mass storage is distinct from memory, which refers to 

temporary storage areas within the computer. Unlike RAM memory, mass storage devices 

retain data even when the computer is turned off.  

  

The smallest unit of storage is a file that contains such data as a letter, budget, images or 

any one of the thousands of items that you may have saved for future reference. 

Additionally, files can be executable program files, or system files reserved for the 

operating system. Mass storage is measured in kilobytes (1,024 bytes), megabytes (1,024 

kilobytes), gigabytes (1,024 megabytes) and terabytes (1,024 gigabytes).  

  

Examples of some mass storage devices are:  

 

 Floppy  Disks 

 Hard disks   

 Optical storage: Examples: CD, CD-R, CD-RW, DVD or DVD-R  

 Magnetic Tapes:  

 Flash Memory (USB drive or pen drives) 

 Zip drives 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1.3: Some output devices 

LCD monitor 
printer speaker 

Fig. 1.4: Some storage devices 

Hard disk  

DVD 

Zip drive 

Floppy disk 

USB drive 

http://www.webopedia.com/TERM/f/file.html
http://www.webopedia.com/TERM/M/K.html
http://www.webopedia.com/TERM/M/byte.html
http://www.webopedia.com/TERM/M/megabyte.html
http://www.webopedia.com/TERM/M/gigabyte.html
http://www.webopedia.com/TERM/M/terabyte.html
http://www.webopedia.com/TERM/M/hard_disk.html
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5. Distribution  

 The final stage in the information processing cycle is distribution. When the information 

is stored on a mass storage device, it can easily and conveniently be carried to anywhere. 

For example, a USB drive can be carried around in a trouser pocket without bulging out. 

Other media such as CDs and DVDs can be kept inside a book. In another instance, if the 

information is a poster printed on paper, its distribution will be done by pasting it on a 

wall.  

The information processing cycle may contain some more steps or some steps will have to 

be omitted. For example, if the information is a poster, the storage could be left out if after 

printing the user does not need it again. In this case we will have four steps instead of five. 

But it is very essential for all vital information to be store for future reference. 

 
 

 

 

 

 

 

 
 

USES OF ICT TOOL 

 

Information and communication technology (ICT) has become, within a very short time, one 

of the basic building blocks of modern society. Many countries now regard understanding 

ICT and mastering the basic skills and concepts of ICT as part of the core of education, 

alongside reading, writing and numeracy. ICT has been a real blessing to mankind in almost 

every area of our endeavor. The help provided by ICT in the field of education, economics 

and banking, social activities, etc is insurmountable. ICT is universally used. There is a high 

degree of inter-organizational ICT use. 

 
 

Uses of ICT in education 

 

 ICT helps students and teachers carry out their research effectively: with the advent of the 

internet, all necessary information is just a click 

away. The user just types in the search engine the 

keyword of what they want, and a vast array of 

information is displayed. 

 Various ICT related gargets help teachers make 

clear their meanings of basic concepts. 

 Electronic laboratories or E-labs help teachers and 

instructors perform laboratory experiments even in 

the absence of the appropriate equipments and 

EXERCISE 
 

Students to list the devices used in the 
stages of information processing cycle and 
describe the process 

Fig. 1.5: ICT is an essential aid in education 
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materials. Teachers do this by rerunning a pre-recorded experiment. 

 With a wide variety of presentation software on the market, students can easily present 

their ideas.  

 E-learning helps students learn at their own pace even without a teacher or instructor.  

 ICTs are used in classrooms to help students with physical disabilities grab some basic 

concepts talked about. 

 
 

Uses of ICT in society 

 ICTs such as mobile phones are used widely to communicate – send and receive 

messages (voice and text). 

 Network-based traffic lights are used to monitor our roads and control the movements 

of traffic. This helps prevent road related accidents. 

 ICT enables people to stay informed even when they are far away fro the source of the 

news. This is made possible by the internet and digital television.  

 Meteorologists depend on ICT to be able to predict the weather make-up, thereby 

keeping the public safe from weather related casualties. 

 Some common home appliances such as microwave ovens and refrigerators are fitted 

with some ICT gargets to make them work efficiently. 

 
 

Uses of ICT for Economic Development 

 

 ICT enables inter-departmental communication and information transfer within 

company or one company with another. This promotes productivity and efficiency. 

 It enable people to access their banking information easily without the need to visit 

the bank this is made possible by Electronic Banking (E-banking) and the ATM. 

 Policy makers use ICT related technologies to come out with economic forecasts - 

this ensures that all monetary issues are well planned and prepared for. 

 Investors can easily keep track of their money and investment wherever they are in 

the world because of ICT. This has eased down the pressure on investors in trying to 

come out with proper investments; potential investors can easily learn the act of 

investment. 

 ICT monitors the growth of the market. This helps to know how much a country, 

company or individual is making at a specific point in time. 

 
 

 

 

 

 

 

 

 

 

GROUP DISCUSSION 

In groups, students to discuss and 

come out with the educational, social 

and economic purposes of ICT 



 

 

 
 
 

Information and Communications Technology 

 

9 

IMPACT OF ICT  

Information and Communication Technology (ICT) has become an important tool for 

promoting a variety of public goals and policies. In the past years much attention has been 

given to the expected social benefits from using ICT in different fields such as 

transportation, education, public participation in planning etc. and to its potential to ease 

down on various current or emerging urban problems. The growing importance of ICT in 

daily life, business activities and governance prompts the need to consider ICT more 

explicitly in urban policies. Alongside the expectation that the private sector will play a 

major role in the ICT field, the expected benefits from ICT encourage also urban authorities 

to formulate proper public ICT policies. Against this background, various intriguing 

research questions arise. What are the urban policy-makers' expectations about ICT? And 

how do they assess the future implications of ICT for their city? An analysis of these 

questions will provide us with a better understanding of the extent to which urban authorities 

are willing to invest in and adopt a dedicated ICT policy.  

ICT by all implications is here to stay is its impact on all sector are overwhelming. The 

following are some of the impact that ICT has had on some selected sectors. 

 
 

On education 

 

The first mass produced computers were introduced to schools in the 1980s. Since then, 

ICT has taken root in the educational field. 

 

 Online distance education helps students to attend classes and submit assignments at the 

comfort of their own home. 

 

 The internet is store house for all source of information. All that the student or teacher 

needs to do is to type in their questions or keyword, and every information on that subject 

will be displayed. 

 

 Virtual classrooms helps students log on from home, school, etc into a special computer-

based classroom where information is presented to them just as in a real classroom. 

 

 Computer-aided teaching and learning helps students select subjects they want and also 

learn at their own pace. 

 

 School authorities can easily assess the information of teachers and students from their 

data base. 

 

 Students can also asses their WASSCE and BECE results online even before they become 

available at their school. 
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On society 

 

Some of the impact ICT has had on society are:  

 

 Availability of internet cafes which make assess to information 

online very convenient. 

 

 Fast and effective communication through email, mobile/telephone, 

fax etc. 

 

 Mp3 players, iPods, games etc helps people relax and pass their leisure whiles listening to 

music or playing games to ease tension. 

 

 More traffic means more road congestion and traffic accidents. This is not very much the 

case as traffic lights regulate traffic movement and reduce congestion. 

 

 What could be more comfortable than being in your sitting room or even bath room and 

yet able to buy or order things. E-shopping as it is called has made this possible.  

 

 CCTVs and even web cams serve as security cameras. People can monitor their homes and 

parents, their children when they are away. 

 

 Digital television make available hundreds of TV stations for the users; viewing comfort. 

 

 

On economic development 

 

Industries, banks and hospitals are some of the key beneficiaries of the powers of ICT. 

 

In the supermarket: 

 e-shopping and e-commerce do not only help customers buy what they want from anywhere, 

but also helps supermarkets and manufacturers reach a lot of customers all over the world, 

24/7.   

 Bar codes on products help supermarkets price their goods just by changing the prices on 

their database without the need to change the labels on the products. They can also easily take 

stock level of their good easily without counting and re-counting the product available. 

 
In banks: 

 Automated Teller Machines (ATMs) enable bank customers to withdraw 

money from their checking or savings accounts by inserting an ATM card 

and a private electronic code into an ATM. The ATMs enable bank 

customers to access their money 24 hours a day and seven days a week 

wherever ATMs are located, including in foreign countries.  

Fig. 1.6: An ATM 
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 Banks also offer debit cards that directly withdraw funds from a customer‘s account for the 

amount of a purchase, much like writing a check.  

 

 Banks also use electronic transfers to deposit payroll checks directly into a customer‘s 

account and to automatically pay a customer‘s bills when they are due. Many banks also use 

the Internet to enable customers to pay bills, move money between accounts, and perform 

other banking functions. 

 

In the manufacturing industry: 

 Computer –aided design/computer aided manufacture 

(CAD/CAM), helps engineers and designers develop and test new 

product easily before producing them. Cars, planes, ships and other 

machines are first designed and manufactured on computers before 

they go into production. 

 

 Robot technology is relied on for the jobs which cannot be done by 

humans. 

 
 

In the offices: 

 Video conferencing or teleconferencing enables people to hold meetings and do their 

presentations to others who are miles apart. 

 Offices now resort to storing data on one central computer which is accessed by all 

departments through local and wide area networks.  

 Telephone bill has reduced because information can easily be sent by email even much faster. 

Confidential documents, videos and audios can be sent from one office, city, town or country 

to another in a flash.via email. 

 
 

 

In the medical field: 

 Doctors and other medical officers can use the computed axial 

tomography (CAT) scan to study the internal part of a patient. 

 The use of robotic arms enables surgeons to perform surgeries 

even when they are distance away from the patient. The patients 

appear on the surgeon‘s computer, whether in the same or distant 

hospital. The surgeon uses a specially adapted mouse control the 

actions of the robotic arms. 

 Computer diagnosis, where diseases are diagnosed by matching the symptoms illnesses; 

computer monitoring where people recovering from some diseases are followed; computer 

prediction, the use of computer to know the effect of drugs before they come out are all 

possible through ICT.  

 

 

 

Fig. 1.7: An engineer on a computer model 

Fig. 1.8: ICT, a tool in medicine  
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CAREER OPPORTUNITIES 

 

Careers in ICT are ever expanding due to increasing demand of ICT personnel. Career 

opportunities in ICT include; 

 

 Internet Café administrator: A person who manages an internet café, makes sure that 

everything is working properly. 

 

 Programmer/ software engineer: A person who writes and debugs computer programs. 

Depending on the size of the project and the work environment, a programmer might work 

alone or as part of a team, be involved in part or all of the process from design through 

completion, or write all or a portion of the program. 

 

 Database administrator: A person who monitors a database, prevents it from being hacked 

into and keeps it up to date. 

 

 Network administrator: A person responsible for configuring the network so that it runs 

efficiently. For example, the network administrator might need to connect computers that 

communicate frequently to reduce interference with other computers.  

 

 System Administrator: The person or team of people responsible for configuring the 

computer and its software to use the network. For example, the system administrator may 

install network software and configure a server's file system so client computers can access 

shared files. 

 

 Hardware engineer/designer: A person who makes computer parts such as system unit and 

its components, monitors, keyboards, mice etc. 

 

 

 

 

 

 

 

 

 

GROUP DISCUSSION 

In groups, students to discuss and 

come out with the educational, social 

and economic purposes of ICT 

Assignment: 
Students to select ICT career of their choice and 
find out the requirements and job description and 
report in class. 
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TEST YOURSELF 

 

Theory questions 

 

1. a. What is the full meaning of ICT? 

b. Write a short note on ICT. 

 

2. Explain the information processing cycle and state two devices used in each step. 

 

3. Discuss the impact of ICT on the following areas: 

a. Education 

b. Medicine 

c. Society 

d. Banking 

e. Supermarkets 

 

4. Outline four careers related to ICT.  

 

5. Write a short note on the following 

a. ICTs 

b. Data 

c. Information 

d. E-learning 

e. Program  

 

6. With the aid of a diagram, describe how input, processing, output, storage and 

distribution are connected in the information processing cycle. 

 

7. Outline the uses of ICT in the following areas: 

a. Education 

b. Social 

c. Economic development 

 

8. Discuss the differences between data and information 

 

9. a. What is the role of the Central Processing Unit in the information processing cycle? 

b.   the central processing cycle is said to be he brain of the computer. Discuss that           

assertion.  

10. Discuss how ICT can be used to save life. 
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Multiple choice questions 

 

1. Which of the following is the full 

meaning of ICT? 

a. Information and Commissions 

Technology 

b. Information and Communication 

Technicality 

c. Informal and Communication 

Technology 

d. Information and Communications 

Technology 

 

2. Which of the following is an input 

device? 

a. Monitor 

b. Keyboard 

c. Central Processing Unit 

d. Hard disk drive 

 

3. The two components of the CPU are 

the Control Unit and … 

a. System Unit 

b. Arithmetic Local Unit 

c. Logical Unit 

d. Arithmetic Logic Unit 

 

4. Which of the following is an input 

device?  

a. Barcode reader 

b. LCD projector 

c. USB Drive 

d. Zip drive 

 

5. Devices which transmit processing data 

to the computer user are termed as.. 

a. Output devices 

b. Input devices 

c. Processors 

d. Storage devices 

 

6. If a person uses a printer he/she is 

using a/an…. 

a. Output device 

b. Input device 

c. Processor 

d. Storage device 

 

7. The information processing cycle 

always begins with…. 

a. Storage 

b. Input 

c. Output 

d. Distribution 

 

8. A computer‘s response to data could 

said to be a/an .. 

a. Raw material 

b. Input 

c. Information 

d. Program 

 

9. A set of instructions that tells the 

computer what to do is … 

a. Data 

b. Information 

c. Instruction 

d. Program 

 

10. Pick the odd one out. 

a. Input 

b. Instruction 

c. Distribution 

d. Storage  

 

11. Pick the odd one out. 

a. Monitor 

b. Keyboard 

c. Trackball 

d. Gamepad  

 

12. Pick the odd one out. 

a. Mouse 

b. Speaker 

c. Printer 

d. LCD projector 
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True or false questions  

13. ICT and ICTs are the same. 

 

14. Devices used for putting data onto the 

computer are known as input devices. 

 

15. The part of the CPU which is 

responsible for all calculations is 

known as the ALU. 

 

16. A joystick is an input device. 

 

17. A processed data is known as a 

program. 

 

18. Data is synonymous to information 

 

19. A monitor is an input device. 

 

20. A floppy disk can store information. 

 

21. A stored information can be 

distributed. 

 

22.  A collection of data organized for 

storage in a computer memory is 

known as database. 

 

 

Fill in the gaps with the words below. 

 

 

 

 

 

 

 

 

  

 

 

23. The ……………. does the processing of data. 

24. ……………. helps engineers and designers develop and test new product. 

25. A ………………. displays processed data. 

26. The component of the CPU which is responsible for computations is the …………… 

27. A processed data is known as …………………. 

28. …………….. devices enable a computer user issue a command to the computer. 

29. Information ……………… is done by storage devices. 

30. An example of input device is a ………………….. 

31. The third stage of information processing cycle is …………….. 

32. A computer user always inputs ………………. 

 

 

 

Input output      CPU monitor    

ALU    storage      web cam  data     

CAD/CAM information 
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Answers 

 

Multiple choice questions 

1. D 

2. A 

3. D 

4. A 

5. A 

6. A 

7. B 

8. C 

9. D 

10. B 

11. A 

12. A 

 

True or false questions 

13. False 

14. True 

15. True 

16. True 

17. True 

18. False 

19. False 

20. True 

21. True 

22. True 

 

Fill In 

23. CPU 

24. CAD/CAM 

25. monitor 

26. ALU 

27. information 

28. Input 

29. storage 

30. web cam 

31. output 

32. data 
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Introduction to Computers 

 
After completing this chapter, you should be able to: 

 

i. Identify types of computers. 

ii. State the uses of computers. 

iii. Identify the steps involved in booting, rebooting and shutting down computers. 

iv. Identify the possible threats to computers and their users. 

v. Demonstrate how to use the computer responsibly. 

 

 

 
OBJECTIVES 

 

 

 

 

 

 

 

 

 

Chapter
 2 

 INTRODUCTION TO COMPUTERS 

 

 

INTRODUCTION 

A computer is an electronic device that accepts data, processes it and outputs it as human-

understandable information. 

It can also be defined as a programmable machine that performs tasks, such as calculations or 

electronic communication, under the control of a set of instructions called a program. 

 

THE DEVELOPMENT OF COMPUTERS 

Computers have come a long way. Actual computing began with an analog machine in 1623, 

when a German scientist Wilhelm Schikard invented a machine that used 11 complete and 6 

incomplete sprocketed wheels that could add, multiply and divide. 
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Introduction to Computers 

French mathematician and physicist Blaise Pascal invented a machine in 1642 that added and 

subtracted, automatically carrying and borrowing digits from column to column. 

Seventeenth-century German mathematician Gottfried Leibniz designed a special gearing 

system to enable multiplication on Pascal‘s machine. 

 

In the early 19th century French inventor Joseph-Marie Jacquard 

devised a specialized type of computer: a silk loom. Jacquard‘s 

loom used punched cards to program patterns that helped the loom 

create woven fabrics.  

 

In the early 1820s  British mathematician and scientist Charles Babbage, developed the 

Difference Engine. Although never completed by Babbage, the Difference Engine was 

intended to be a machine with a 20-decimal capacity that could solve mathematical problems. 

Babbage also made plans for another machine, the Analytical Engine, considered the 

mechanical precursor of the modern computer. The Analytical Engine was designed to 

perform all arithmetic operations efficiently. 

 

 

 

 

 

 

 

 

 

 

 

 

Augusta Ada Byron, countess of Lovelace, was a personal friend and student of Babbage. 

She prepared extensive notes concerning Babbage‘s ideas and the Analytical Engine. 

Lovelace‘s conceptual programs for the machine led to the naming of a programming 

language (Ada) in her honor. Although the Analytical Engine was never built, its key 

concepts, such as the capacity to store instructions, the use of punched cards as a primitive 

memory, and the ability to print, can be found in many modern computers. 

Herman Hollerith, an American inventor, used an idea similar to 

Jacquard‘s loom when he combined the use of punched cards with 

devices that created and electronically read the cards. Hollerith‘s 

tabulator was used for the 1890 U.S. census, and it made the 

computational time three to four times shorter than the time previously 

needed for hand counts. Hollerith‘s Tabulating Machine Company 

eventually merged with two companies to form the Computing-

Tabulating-Recording Company. In 1924 the company changed its 

name to International Business Machines (IBM). 

Fig. 1.9: A punched card 

Fig. 2.0: Charles Babbage Fig. 2.1: the Difference Engine 

Fig. 2.2: Herman Hollerith 
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In 1936 British mathematician Alan Turing proposed the idea of a machine that 

could process equations without human direction. The machine (now known as a 

Turing machine) resembled an automatic typewriter that used symbols for math 

and logic instead of letters. Turing intended the device to be a ―universal 

machine‖ that could be used to duplicate or represent the function of any other 

existing machine. Turing‘s machine was the theoretical precursor to the modern 

digital computer. The Turing machine model is still used by modern 

computational theorists. 

In the 1930s American mathematician Howard Aiken developed the Mark I calculating 

machine, which was built by IBM. This electronic calculating machine used relays and 

electromagnetic components to replace mechanical components. In later 

machines, Aiken used vacuum tubes and solid state transistors (tiny 

electrical switches) to manipulate the binary numbers. Aiken also 

introduced computers to universities by establishing the first computer 

science program at Harvard University in Cambridge, Massachusetts. 

Aiken obsessively mistrusted the concept of storing a program within the 

computer, insisting that the integrity of the machine could be maintained 

only through a strict separation of program instructions from data. His 

computer had to read instructions from punched cards, which could be 

stored away from the computer.  

 

 

At the Institute for Advanced Study in Princeton, New Jersey, Hungarian-American 

mathematician John von Neumann developed one of the first computers used to solve 

problems in mathematics, meteorology, economics, and hydrodynamics. 

Von Neumann's 1945 design for the Electronic Discrete Variable 

Automatic Computer (EDVAC)—in stark contrast to the designs of 

Aiken, his contemporary—was the first electronic computer design to 

incorporate a program stored entirely within its memory. This machine 

led to several others, some with clever names like ILLIAC, JOHNNIAC, 

and MANIAC.  

Fig. 2.3: Alan Turing 

Fig. 2.4: Howard Aiken 

Fig. 2.5: Mark I calculating machine 

 

Fig. 2.6: John von Neumann 
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American physicist John Mauchly proposed the electronic digital computer called ENIAC, 

the Electronic Numerical Integrator And Computer. He helped build it along with American 

engineer John Presper Eckert, Jr., at the Moore School of Engineering at the University of 

Pennsylvania in Philadelphia. ENIAC was operational in 1945 and introduced to the public in 

1946. It is regarded as the first successful, general digital computer. It occupied 1,800 sq ft, 

weighed more than 27,000 kg and contained more than 18,000 vacuum tubes. Roughly 2,000 

of the computer‘s vacuum tubes were replaced each month by a team of six technicians. 

Many of ENIAC‘s first tasks were for military purposes, such as calculating ballistic firing 

tables and designing atomic weapons. Since ENIAC was initially not a stored program 

machine, it had to be reprogrammed for each task. 

 
Fig 2.7: ENIAC occupying 1,800 sq ft room 

Eckert and Mauchly eventually formed their own company, which was then bought by the 

Rand Corporation. They produced the Universal Automatic Computer (UNIVAC), which was 

used for a broader variety of commercial applications. The first UNIVAC was delivered to 

the United States Census Bureau in 1951. By 1957, there were 46 UNIVACs in use. 

 

Fig. 2.8: UNIVAC Computer System  
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Between 1937 and 1939, while teaching at Iowa State College, American physicist John 

Vincent Atanasoff built a prototype computing device called the Atanasoff-Berry Computer, 

or ABC, with the help of his assistant, Clifford Berry. Atanasoff developed the concepts that 

were later used in the design of the ENIAC. Atanasoff‘s device was the first computer to 

separate data processing from memory, but it is not clear whether a functional version was 

ever built. Atanasoff did not receive credit for his contributions until 1973, when a lawsuit 

regarding the patent on ENIAC was settled.  

Walter Houser Brattain, John Bardeen, and William Bradford Shockley developed the 

transistor, a device that can act as an electric switch. The transistor had a tremendous impact 

on computer design, replacing costly, energy-inefficient, and unreliable vacuum tubes. 

In the late 1960s integrated circuits (tiny transistors and other electrical components arranged 

on a single chip of silicon) replaced individual transistors in computers. Integrated circuits 

resulted from the simultaneous, independent work of Jack Kilby at Texas Instruments and 

Robert Noyce of the Fairchild Semiconductor Corporation in the late 1950s. As integrated 

circuits became miniaturized, more components could be designed into a single computer 

circuit. In the 1970s refinements in integrated circuit technology led to the development of 

the modern microprocessor, integrated circuits that contained thousands of transistors. 

Modern microprocessors can contain more than 40 million transistors. 

Manufacturers used integrated circuit technology to build smaller and cheaper computers. 

The first of these so-called personal computers (PCs)—the Altair 8800—appeared in 1975, 

sold by Micro Instrumentation Telemetry Systems (MITS). The Altair used an 8-bit Intel 

8080 microprocessor, had 256 bytes of RAM, received input through switches on the front 

panel, and displayed output on rows of light-emitting diodes (LEDs). Refinements in the PC 

continued with the inclusion of video displays, better storage devices, and CPUs with more 

computational abilities. Graphical user interfaces were first designed by the Xerox 

Corporation, then later used successfully by Apple Inc.. Today the development of 

sophisticated operating systems such as Windows, the Mac OS, and Linux enables computer 

users to run programs and manipulate data in ways that were unimaginable in the mid-20th 

century. 

Several researchers claim the ―record‖ for the largest single calculation ever performed. One 

large single calculation was accomplished by physicists at IBM in 1995. They solved one 

million trillion mathematical sub-problems by continuously running 448 computers for two 

years. Their analysis demonstrated the existence of a previously hypothetical subatomic 

particle called a glueball. Japan, Italy, and the United States are collaborating to develop new 

supercomputers that will run these types of calculations 100 times faster. 

In 1996 IBM challenged Garry Kasparov, the reigning world chess champion, to a chess 

match with a supercomputer called Deep Blue. The computer had the ability to compute more 

than 100 million chess positions per second. In a 1997 rematch Deep Blue defeated 

Kasparov, becoming the first computer to win a match against a reigning world chess 

champion with regulation time controls. Many experts predict these types of parallel 

processing machines will soon surpass human chess playing ability, and some speculate that 
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massive calculating power will one day replace intelligence. Deep Blue serves as a prototype 

for future computers that will be required to solve complex problems. At issue, however, is 

whether a computer can be developed with the ability to learn to solve problems on its own, 

rather than one programmed to solve a specific set of tasks. Computers continues to develop, 

and more and more powerful computers are being built today – who knows where we will go 

from here? 

 

TYPES OF COMPUTERS 

Computers come in three types-  

 Digital computers  

 Analogue computers  

 Hybrid computers 

 

Digital computers 

When you here the word digit, what come to your mind? Numbers (0,1,2,3………9). 

 A digital computer is defined as a computer that performs calculations and logical 

operations with quantities represented as digits (numbers), usually in the binary 

number system.  

The binary number system is made up of digits, just like our common decimal system (10 

digit system). But, while the decimal system uses digits 0 through 9, the binary system only 

uses digits 0 and 1, also known as ON or OFF and the primary language that computers 

communicate in. You can compare with regular household switches. If the switch if off, the 

PC reads numeral 0 - if it is on, it is read as numeral 1. See the illustration below: 

 

 

 

 

 

 

 

 

The PC is filled with these switches (in the form of transistors). There are literally millions of 

those in the electronic components. Each represents either a 0 or a 1, so we can process data 

with millions of 0's and 1's. 

In digital computers, even letters, words and whole texts are represented digitally. 

http://www.computerhope.com/jargon/o/onoff.htm
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Each 0 or 1 is called a bit. Bit is an abbreviation of the expression BInary digiT. It is called binary, 

since it is derived from the binary number system. A sequence of 8 bit is known as 1 byte. 

 

0 1 bit 

1 1 bit 

0110 4 bit 

01101011  8 bit or 1 byte 

 

 

Types of digital computers 

Digital computers come in various types and sizes. They can further be grouped as: 

 Supercomputers  

 Mainframe computers 

 Minicomputers 

 Microcomputers 

 

Supercomputers  

Supercomputers are designed to do high speed computations. They have large amount of 

main memory with high speed processor. They are normally referred to as parallel processors 

because they allow many instructions to be executed at the same time. Supercomputers are 

mostly used for scientific and engineering calculations. They are also used to create weather 

predictions. Large businesses and the military all rely on supercomputers.  Examples of 

supercomputers are the Cray supercomputer, CM -5 supercomputer and the IBM Series 360. 

 

 

 

 

 
 

 

 

 

 

 

 

 

Fig. 2.9: IBM Series 360 

Fig. 3.0: Cray Supercomputer 
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Mainframe computers 

Mainframe Computer are high-level computers designed for the most intensive computational 

tasks. They are usually shared by multiple users through a series of interconnected computers 

via a terminal. Mainframe computers require special air-conditioned rooms to keep them 

running. They control businesses and industrial facilities and are used by universities, banks 

etc. An example of mainframe is the IBM System 360 mainframe computer. 

 

 
Fig. 3.2: IBM System/360 Mainframe Computer 

 
 

Minicomputers 

Minicomputers are mid-level computers built to perform complex computations while 

dealing efficiently with a high level of input and output from different users connected via 

terminals. Minicomputers also frequently connect to other minicomputers on a network and 

distribute processing among all the attached machines. Minicomputers are used heavily in 

transaction-processing applications and as interfaces between mainframe computer systems 

and wide area networks. Recent minicomputers perform most of the functions of mainframe 

computers. 

 
 

Fig. 3.1: CM-5 supercomputer 
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Microcomputers 

Microcomputers are computing device that uses a microprocessor as its central processing 

unit, or CPU. They are the commonest computers today.  When we talk of personal 

computers, laptops, notebooks and even hand-held computers, we are referring to 

microcomputers.  In common usage, the term microcomputer is equivalent to personal 

computer. When they first appeared, microcomputers were considered single-user devices, 

and they were capable of handling only 4, 8, or 16 bits of information at one time. Newer 

microcomputer models such as the workstations have increased the speed and data-handling 

capabilities of their CPUs into the 32-bit and 64-bit, multiuser range. They have become very 

powerful to the extent that they sometimes do the tasks of minicomputers and even 

mainframe computers. 

Microcomputers come in different shapes and sizes with different functions. The following 

are some types of microcomputers. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

ANALOGUE COMPUTERS 

In contrast to digital computers, there are analogue computers. An analogue computer is a 

computer that represents data in terms of physical measures or quantities such 

as time, voltage, temperature, speed etc in a continuous range. Unlike digital 

computers, an analogue computer can perform only one specific function. For 

example a speedometer, which is an analogue computer, can only measure the speed 

of a moving object, and nothing else.  The following are example of analogue 

computers. 

 

 

 

 

 

 

 

 

 

Fig. 3.2: Some microcomputers 

Tower (desktop) computer 

Laptop computer  All-in-one computer 
Hand-held computer 

Fig. 3.3: Some analogue computers 
Analogue watch 

Speedometer  

Thermometer  

 Hand-held computer 

 All-in-one computer 

http://pespmc1.vub.ac.be/ASC/COMPUTER.html
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HYBRID COMPUTER 

We have discussed digital computers (which represent data by numbers) and analogue 

computers (which represent data by physical quantity). In between theses two classes of 

computers is the hybrid computer. Hybrid computers are computers that combine the 

features of both digital and analogue computers. The digital 

component normally serves as the controller and provides logical 

operations, while the analog component normally serves as a solver of 

differential equations. The integration from analogue to digital and vice 

versa, is obtained by digital to analog and analog to digital converter. A 

hybrid computer may use or produce analog data or digital data. It 

accepts a continuously varying input, which is then converted into a set 

of discrete values for digital processing. A hybrid computer system setup offers a 

cost-effective method of performing complex simulations. 

Examples of analogue computers are automated teller machine (ATM) 

and money counting machine. 

 
 

 

USES OF COMPUTERS 

―I think there is a world market for maybe five computers‖. That was a statement made in the 

1940s by the then chairman of IBM, Thomas Watson. Had Mr. Watson being a little ―long 

sighted‖ he would have known that the world really needs far more than five computers. 

Today, computers are in use in all walks of life. It is hard to imagine the world without 

computers. Usage of different types of computers has made life both 

smooth and fast paced. 

People use computers in many ways.  

In business 

 Computers track inventories with bar codes and scanners.  

 Check the credit status of customers.  

 Transfer funds electronically.  

 Communicate  

 

At homes  

 Tiny computers embedded in the electronic circuitry of most 

appliances control the indoor temperature,  

 Operate home security systems,  

 Tell the time.  

 Turn videocassette recorders (VCRs) on and off.  

 

 Computers in automobiles regulate the flow of fuel, thereby increasing gas fuel 

mileage,   

 Computers are used in anti-theft systems.  

 

    ATM  

Money counting machine  

http://en.wikipedia.org/wiki/Logical_operation
http://en.wikipedia.org/wiki/Logical_operation
http://en.wikipedia.org/wiki/Logical_operation
http://en.wikipedia.org/wiki/Differential_equations
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Computers also entertain, creating digitized sound on stereo systems or computer-animated 

features from a digitally encoded laser disc.  

 

Computer programs, or applications, exist to aid every level of 

education, from programs that teach simple addition or sentence 

construction to programs that teach advanced calculus. Educators use 

computers to track grades and communicate with students; with 

computer-controlled projection units, they can add graphics, sound, and 

animation to their communications. 

 

 Computers are used extensively in scientific research to solve mathematical problems 

investigate complicated data,  model systems that are too costly or impractical to build, such 

as testing the air flow around the next generation of aircraft.  

 

The military employs computers in sophisticated communications to encode and unscramble 

messages, and to keep track of personnel and supplies. 

 
 

BOOTING, REBOOTING AND SHUTTING DOWN OF COMPUTERS 

 

The computer is a complicated machine and should not be compared to any other electronic 

device we find at home, school or the office. The operation of computers follows systematic 

steps and rules which do not have to be ignored. Booting, rebooting and shutting down are 

the terms used to describe the process of starting, restarting and turning off the computer 

respectively. Now, let‘s take them one at a time. 

 
 

Booting the computer 

Booting the computer in general term means giving the computer a hard kick. Who will really 

wants to do that? Apart from hurting your foot, you should also know that your expensive 

computer might be damaged irreparably. You wouldn‘t want to do that. If that is not it then 

what does it mean to boot a computer? 

Booting the computer is the step by step process of turning on the computer and loading 

the operating system. 

The initial booting of the computer is normally referred to as cold booting. 

 
 

Steps in booting a computer 

Basically, a computer is made up of a systems unit with a keyboard and a mouse connected to 

it and a monitor, which is the display unit. The systems unit and the monitor need external 

power source, whiles the keyboard and the mouse get their power from the systems unit. 

 

 First connect the video cable from the monitor to the serial port at the back of the systems 

unit. 
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 Connect the keyboard and the mouse to their appropriate ports. 

 

NOTE: The ports of the keyboard and the mouse are similar. Switching 

them will not work; therefore make sure you connect them 

correctly.  

 

 Connect the AC power cable first to the rear of the systems unit and monitor before 

plugging into the mains. (To avoid damage to your computer 

as a result of power surge and voltage spikes it is 

recommended that you plug your devices into a power surge 

protector). 

 At this point it is safe to turn on the computer. Press the 

power button in front of the system unit.  You should hear the 

systems fan and the hard disk beginning to spin. 

 Turn on the monitor. If it is on already you will see it flicker 

into life. If nothing happens switch off the systems unit and 

check all your connections and then retrace the entire steps. 

When your computer is on it will first check the system configurations and the hardware 

and then finally, load the operating system.  

NOTE: Make sure to follow all instructions to the latter. 

 
 

Rebooting the computer 

Rebooting the computer means to restart it. That is to turn it off and then on again. Rebooting 

a computer involves more than just pressing the power button off and on. One has to follow 

some special procedure in order to reboot a computer. The actual turning off and on is done 

by the computer itself with a single instruction from the user. So by this we can say than 

rebooting is the process of restarting a computer after it has been on for some time. It is also 

known as warm booting. 

The question is when is it necessary for a user to reboot a computer? 

 

1. A request from the computer: Sometime after one installs a program, a message 

appears on the screen asking the user to restart the computer before the newly 

installed program will work. This is because during the installation of some programs 

not all the associated components of that program are installed until the computers 

restarts.  

 

 

 

 

 

 

 

 

Power 
Button 

Fig. 3.5: PS/2 mouse keyboard and ports 
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2. In another instance the user will see this message after making changes to the settings 

on the computer. 

 

 

 

 

 

 

 

 

 

3. Non-response from the computer. This is the case when the computer stops 

responding to user command, in a state known as freezing. In this state neither the 

mouse nor the keyboard functions. Freezing may be caused by giving wrong 

command to the computer or running a lot of programs at the same time. In the latter 

case it often occurs to computers with lower system specifications. 

 

4. Failure of the computer to load all the system components. When the computer starts 

it first loads Basic Input and Output Devices (BIOS) that is all the hardware; then the 

operating system and the individual software install on it. In some circumstances, the 

computer skips some of these steps, so when it starts it will warn you and might ask 

you to reboot. 

 

There you are. Now, how is rebooting done? There are three main methods by which a 

computer can be restarted: 

 
 

i. Using the restart tab 

 To reboot the computer using the restart tab 

1. Click the start button.    

This will cause the start menu to pop-up as shown below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3.6: a request from the computer to reboot 
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2. Click on the ―Turn Off‖ tab.   

A different screen with ―Stand By‖, ―Turn Off‖ and Restart‖ tabs appears. 

 

 

 

 

 

 

 

3. Click on the Restart tab. This will cause the computer to restart. 

 
 

ii. Using the CTRL-ALT-DEL 

Pressing the Ctrl, Alt and DEL keys on the keyboard simultaneously will display the 

task manager from which you can select restart from the shut 

down tab to restart your computer. In the older versions of 

Microsoft Operating System (Windows), pressing this key 

combination twice will automatically restart the computer.  

The Ctrl-Al-Del option is ideal if the computer freezes but the 

keyboard does not. 

 
 

iii. Using the reset button 

Some system units have a special button located near the ―power 

on‖ button which is used to restart the computer. The reset button is 

the easiest and the quickest way of rebooting the computer. If is 

most ideal if the computer and the other hardware connected to it 

are all irresponsive.  

 

Restarting the computer will close all open programs. The negative side is 

all unsaved works will be lost. Be advised that before you reboot your computer save and 

close all open programs, (if you have the option). 

 
 

Shutting down the computer 

Computers, like all electrical and electronic devices, need to be turn off when not in use, to 

safe energy and also reduce pressure on it. The process of turning off the computer is 

known as shutting down. Shutting down the computer is not as easy as turning off a 

television set; a lot goes into play. Most computers break down because of improper shut 

down procedure from users; while some just press the power button just as they do to their 

TV set, others go into the extreme of unplugging the power cable from the mains.  

How does one shut down the computer without causing any damage to it? Follow the steps 

below. 

 

Reset 
Button 

Fig. 3.7: the CTRL-ALT-DEL 

combination 
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1. Click on the start button.  

 

2. Click on ―Turn Off Computer‖ button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click on the :Turn Off‖ button.  

 

 

 

 

 

 

 

CAUTION: Turning off the computer will close all open programs. Make sure to save all 

projects before shutting down. Some programs will notify you to safe any unsaved changes 

made to it. 

 

 

 

 

 

 
 

THREATS TO COMPUTERS AND USERS 

 

A threat could said to be a person, animal or thing that is likely to cause harm, pain or 

damage. Computers and their users are plagued by numerous threats, both known and 

unknown. In this section will discuss some threats to computers and computer users, their 

causes and possible prevention and remedy. 

 
 

 

ASSIGNMENT 
 

Students to write the procedure for booting, 
rebooting and shutting down a computer. 
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COMPUTER THREATS 

 Computers, like most things in the world, are far from safe. Computers are always exposed 

to a variety of threat mostly as a result of negligence from the users. Computer threats are in 

two folds – there are threats which are focused on the programs and the operating system on 

the computer. We shall call them software related threats; and there are those which affect the 

physical components of the computer. We shall refer to them as hardware related threats. 

 
 

Software-related threats 

 

Software are programs or applications that can be run on the computer system, e.g. word 

processing, database packages etc. (more on software later). 

If you ever thought that once a program is installed on a computer system it is safe, think 

again. There are a lot of malicious software on the cyber-market, the sole purpose of which is 

to make the genuine software on computer systems vulnerable. Software threats include 

Viruses, worms, Trojans, spasm, spyware, phishing, IP spoofing, hackers, hijackers, adware, 

dialers, hoaxes and stranger-danger. 

 

1. Viruses 

Computer programs that copy themselves from one program or computer to another . They 

often disrupt your computer system or damage your data. Viruses are usually received by 

email attachments or downloads so be careful opening anything from a dubious source. They 

can affect anyone, for example, the destructive Mydoom worm affected one out of three 

small and mid-sized businesses. Like biological viruses, different computer viruses do 

different tasks some of which include: 

Boot Sector: A virus which infects the boot sector or partition table of a disk.  Computers are 

most often infected with this type of virus after being started with an infected boot floppy or 

CD. 

 

Companion: Also known as a "Satellite" virus, this does not actually modify the code of the 

target program, but is hosted by an infected copy of the target which is placed ahead of it on 

the execution path.  This is achieved by giving the infected version the same name as the 

target program, but with a file extension of higher priority.  For example, if the user of a PC 

running Microsoft Windows attempts to run a file called myprogram, the computer will look 

to run a file called myprogram.bat or myprogram.com or myprogram.exe in that order.  

Therefore, a companion virus which targets the myprogram.exe file would create an infected 

copy called myprogram.bat or myprogram.com so that it gets run instead of the real program. 

 

Cryptovirus: A virus that uses asymmetric encryption techniques and includes a public key 

in its payload.  Usually, the private key of the asymmetric key pair will be retained by the 

virus author/attacker so that only he can decrypt the data that was encrypted with the 

corresponding public key contained in the virus.   The concept could equally be applied to 

Worms or Trojan horse programs giving us "Cryptoworms" and "Cryptotrojans" 
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respectively.  Such malware would commonly be used for extortion, whereby data on a 

victim's hard disk is encrypted and held to ransom. 

 

File infector: The traditional type of virus which infects .com .exe or other executable files. 

 

Macro: A virus, very often written in Visual Basic, which is triggered when a parent 

application performs some action on an infected document.  A macro virus contained in a 

.doc file might be triggered when the parent application (Microsoft Word, say) opens, closes 

or saves the file, for example.   

 

Multi-partite: A virus which has the capability to infect a computer's boot sector, partition 

table and/or its executable programs.  It therefore has the characteristics of both "boot sector" 

and "file infector" viruses. 

 

Polymorphic: A virus which has the ability to alter its appearance.  The body of a 

polymorphic virus has two basic parts - the executable part (which is encrypted) and the 

decryptor (which is used to decrypt the executable part so that it can be run).  By using a 

variety of techniques the appearance (but importantly, not the basic functionality) of the 

decryptor can be altered, greatly assisting the virus in evading detection by antivirus 

software. 

 

2. Spyware  

Like a spy, a spyware monitors a user's actions, and send all the information about the user 

and their computer to somebody else. Spyware may send the addresses of sites you have 

visited or worse still, transmit personal information. With today's concerns about identify 

theft this is a real worry. For example, CoolWebSearch may hijack web searches, home page, 

and other Internet Explorer settings. Spyware is normally received as part of shareware (a 

software made available for free download), downloaded from the web. 

 
 

3. Trojans or Trojan Horse  

The name Trojan horse is taken from the legend in which the Greeks built a large wooden 

horse with the pretence that it was a peace offering for their foes, the 

Trojans.  The Trojans accepted the gift and carried it into their, 

erstwhile impregnable, city of Troy.  Little did they realize, until it was 

too late, that the wooden horse was hollow and that the Greek army was 

concealed inside! Just like the legend, a Trojan is a program which has 

some hidden, malign purpose, other than the one it purports to have.  

For example, a program which claimed to be a game but which also 

secretly installed some spyware or adware components on a user's 

computer would be considered to be a Trojan horse program, because 

the real purpose of the program was to install the malware and not to 

provide an entertaining game for the user.  Commonly, a so-called 

Remote Access Trojan (or RAT) may open a backdoor on a Fig. 3.8: the symbolic Trojan Horse 
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computer allowing an intruder to connect without the user's knowledge or consent.  

 

4. Spam   

An unwanted or unrequested mail often promoting products of a dubious financial or sexual 

nature. Don't leave your email address on websites and internet bulletin boards as they are 

harvested by spammers. Recent evidence suggests that some spammers have now teamed-up 

with virus writers so that even more spam can be sent, using the infected computer to send 

spam to all the email addresses contained in a user's address book for example.  

 
 

5. IP/Address Bar Spoofing  

A technique to gain unauthorized access to computers, whereby the intruder sends messages 

to a computer with an address indicating that the message is coming from a trusted host. 

 
 

6. Adware 

An adware is a program that puts advertisements on your screen. These take many forms 

including popups, popunders and advertisements that appear later, even if your browser is 

closed. Some are sent using the Windows Messenger service which allows a spammer to 

direct an advertisement straight to your computer by sequentially sending messages to IP 

addresses. Always irritating, they are also often of a pornographic nature. A generic term 

referring to a class of software that causes a victim's web browser to display annoying pop-up 

advertisements and advertising banners.  Sometimes adware may be installed in conjunction 

with a companion spyware program.  Whilst the spyware program tracks and reports on the 

user's web browsing behaviour, the adware program provides targeted advertisements based 

on that behaviour. 

 

7. Phishing  

Phishing (pronounced ―fishing‖) are emails purporting to come from reliable sources such as 

Paypal, Ebay or your bank. Often wanting you to verify your account details such as your 

password, oincode etc. they can look very realistic but are generally scams to harvest 

usernames and passwords. Always open a new browser winder and type the address there, 

rather than clicking on the link provided. 

 
 

8. Hijackers  

Hijackers take control of your web browser and may reset your home page, search bar and 

search pages. They can redirect you to undesirable sites or stop you going to particular sites. 

 
 

9. Hackers  

A hacker is a computer user who gains unauthorized access to a computer system or data 

belonging to somebody else. Even though some hackers known as ethical or white hackers 

break into computer system to check their vulnerability, most hackers normally the unethical 
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or black hackers hack for selfish gains. With so much personal data available online to 

anyone with a password you must be sure your password is secure. If you are using your 

mother's maiden name, your cat's name or your birthday then your password is at risk. Here 

are two tips for making a secure password. Method One - pick two random unrelated three 

letter words and two digits. Mix them up and what do you have? A secure password such as 

"red19cat" or "hotpin73". Method Two - pick a short sequence of words such as Now Is The 

Winter Of Our Discontent Made Glorious' and you have a password of "nitwoodmg". You 

could even change the I's and O's to digits. 

 
 

10. Nigerian scam  

Otherwise known as an Advanced Fee Fraud, the 419 scam takes its name from the section of 

Nigerian law which legislates for this kind of illegal activity, although the perpetrators of 

such scams are by no means any longer confined to Nigeria.  There are several variations on 

the theme but the scam is generally conducted via the spamming of potential victims by 

email.  These emails will often purport to come from a legal firm, financial institution, or 

perhaps the relative of a deceased political leader or wealthy businessman for example.  The 

email will spin a beguiling story about the existence of a vast fortune which is tied up in some 

kind of legal or financial limbo but which can be liberated, so the scammers claim, with the 

victim's assistance (often the provision of details of a bank account in the victim's home 

country into which the fortune will supposedly be deposited).  As a reward for their help the 

victim is promised that they can keep a substantial share of the loot!  However, at some point 

during the proceedings the scammers will contact the victim claiming some kind of 

administrative problem which can be overcome if the victim will send them a sum of money 

to grease the wheels - this is where the "advanced fee" fraud comes in.  If the victim falls for 

this the scammers will continue to make similar requests, often teasing the victim by claiming 

that just one more payment will be enough to liberate the fortune.  Of course there is no 

fortune and the victim has lost their money! 

 

There are hundreds of other software threats all over, mostly on the web. These threats have 

one purpose of breeching the security system of other people‘s computers. If 

you see any suspicious file on your computer, it might be virus, Trojan horse 

or any other malware. Do not open it, just get rid of it. how do you get rid of 

malware? While malware are software, there are other software which fight 

malware as vaccine fight infections. These software are known as anti-virus. 

There are a number of anti-viral software available, getting the right one is 

sure to make your system safe from all software related threats. 

 
 

Hardware-related threats 

 

Hardware threats, what are they? The next topic is exclusively on hardware; but before that 

let us try and get an idea of the term hardware. Hardware refers to all components of the 

computer that can be seen and touched, examples of which are monitors, keyboards, mice etc. 

Fig. 3.9: Kaspersky antivirus 

http://www.kaspersky.com/


 

 

 

36 

 
 
 

Introduction to Computers 

We can, therefore, say that hardware threats are threats which affect the touchable or physical 

components of the computer. There are quite a number of hardware threats, some of which 

are as follows:  

 

1. Dust 

A particle of dust is negligible, but a pile of it can simply not be looked over. The following 

are some of the effects of dust on computers: 

i. Blocks ventilation: computers heat up easily due to continuous processing of data; 

and because of that all computers have fans in them to cool them down. If dust 

settle in the computer it causes the fan to work at a slower rate; this reduces the 

amount of air it blows. Less air means more heat in the computer, and that can 

easily break down the computer. 

 

ii. Settle on the internal components: most of the components in the computer feel 

less comfortable with dust or dirt. If dust settle on them they give lower output if 

any at all. For example the RAM chips will stop working if their connection parts 

get dirty; and that means the computer too will not boot. 

 

iii. Makes the computer dirty: who likes dirty stuff? A dirty computer, like any other 

thing, is a real eyesore; and that is exactly what dust does to the computer. 

 

Because of these and other reasons, dust must be eliminated from computers by: 

 

a. Cleaning the computer hardware regularly. 

b. Locating computers away from open windows. 

c. Covering computers up when not in use. 

 

2. Power Fluctuation 

 

How often do you feel that your electric light-bulb or fluorescent light looks brighter or 

dimmer than usual? That is as a result of the irregularities in the flow of electricity known as 

power fluctuation. Power fluctuations, voltage spike and electrical surge put pressure on the 

computer and all the other hardware connected to it, and may end up causing serious damage 

to the computer system. Power fluctuations mostly occur when the power is restored after an 

outage. Power fluctuations can hardly be avoided, but their impact on your computer system 

can be reduced or avoided. HOW? You might ask. 

 

 Using a voltage stabilizer, an electrical device that keeps the voltage at a constant 

rate. This helps reduce the impact of voltage spike on the 

computer. 

 Using a surge protector keeps your system safe from 

electrical surge. 

 Using an uninterruptible power supply (UPS), a device 

that keeps your electrical and electronic devices on for some Fig. 4.0: surge protector 
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time after a power outage. This will give you enough time to save all changes to your 

works and safely shut down your computer. 

 Turn off all power outlets and unplug the computer‘ power cables from them when 

not in use. 

 
 

3. Rodents 

Rodents, the ubiquitous rodents; what will they not chew, books, shoes, clothes, and now 

computer cables? That is it. rodents like mice, rats  and guinea pigs are 

always around and are trying to share everything we possess with us. If 

rodents chew parts of the power cables, the exposed wires can touch 

each other and short when the power is turned on. This can cause fire or 

do serious damage to you and your computer. It is therefore advisable to 

keep the computer and its surrounding tidy, and make sure to sweep out 

all food crumbs which easily invite rodents. If your computer room is 

already infested with rodent get a mouse trap or an exterminator to get rid of them.  

 
 

4. Liquids  

Who ever thought that liquids such as water, tea and other drinks, which we humans can 

hardly do without, are actually enemies to the computer? YES, most liquids are good 

conductor or electricity and if they get into the computer, will link the parts of the main 

circuit which are not supposed to touch, and that will certainly cause fire apart from 

irreparably damaging your computer. So, to prevent this, keep all liquids away from your 

computer system. 

 
 

5. Disasters   

Disasters, whether natural or man-made, such as flood, earth quake, fire outbreak, are some 

of the most dangerous threats which affect computers. Most disasters are unpredictable and 

when they strike the type of computers they destroy most are the supercomputers and 

mainframes which contain a bulk of a company or organisation‘s information. Flood can be 

avoided by stationing mainframe computers away from low-lying areas. The impact of fire 

can be reduced if fire extinguishers and smoke detector are present at where the computer(s) 

are.  

 

6. Theft and Robbery  

Thieves are everywhere, and they are always looking for 

expensive things like computers to steal. They are ready to 

break into the most secure of all places to steal computers and 

other computer accessories. Laptops, notebooks and handheld 

computers are even easier to steal. Always keep all your 

computer systems in a safe and secure place. Do not leave 

potable computers near windows or in an unattended vehicle. 

Fig. 4.1: mouse 

Fig. 4.2: computer theft is on the rise 
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THREATS TO COMPUTER USERS  

 

Sitting down regularly at a single place in a single position and doing the very same thing 

routinely does not really look appealing; yet unfortunately, that is what computer users go 

through. Being confined to one posture day in and day out really has a lot of bodily problems 

which include vision problems, wrist pains, stress, backaches and repetitive strain injury. 

Let‘s consider what these do and how we can combat them. 

 
 

1. Vision problems 

Being in front of the display unit for a very long time can pose the threat of eyestrain of even 

headache. To prevent these or reduce potential problems in the future, observe the following 

simple guidelines: 

 The screen should be positioned approximately an arm‘s 

length away. 

 The room should be well lit. 

 A copy or document holder should be positioned at 

screen level keep the eyes at stable position. 

 The brightness and contrast of the screen should be 

adjustable and must be set at levels which are good for 

reading on the screen. 

 Images on the screen should not flicker, but be stable. 

 Get an anti-glare shield if necessary, to reduce the 

amount of light entering the eye from the display unit. 

 Take frequent break, perhaps 15 – 20 minutes break after 

every hour. 

 Keep the screen clean of dust. 

 Position the computer at right-angle to the window to 

prevent reflected sunlight. 

 Have regular eye tests. 

 

2. Wrist pains 

 The arms are required to hang by your side with the hands on the keyboard and or the mouse. 

This continuous position puts pressure on the wrists and results in wrist pains. Wrist pains 

can be reduced by: 

 Keeping the keyboard at right-angle to 

your body. 

 Acquiring keyboards with soft keys.  

 Use a wrist-rest to support the wrist. 

 Use ergonomic keyboards which keep 

the arms at a more natural angle than the 

standard keyboard. 

 Taken regular breaks away from the 

keyboard and the mouse.  

Fig. 4.3: the correct sitting posture 

Fig. 4.4: ergonomic keyboard 
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3. Backache  

Backache is caused by bad posture. The question is, how do you maintain a good posture? 

 Get stable chairs which will also give you the freedom to move even whiles sitting. 

 Acquire a foot stool if the your feet do not touch the ground 

 The seat should be adjustable in height so that your eyes will at the same level with 

the top of the screen. 

 The backrest of the seat should also be adjustable so that you will feel comfortably 

seated. 

 Te desk should be at a correct height and should be big enough to accommodate all 

the various hardware. 

 Regular breaks and exercises are sensible ways to help relieve or prevent backache. 

 
 

4. Repetitive strain injury (RSI) 

RSI is a physical symptoms caused by excessive and repetitive use of the body, (mostly 

the upper body). Repetitive stress injuries typically occur when tasks are performed under 

difficult conditions, using awkward postures and poorly designed equipment. One of the 

key cause of RSI is the prolonged use of the computer keyboard.  RSI can affect the neck, 

upper limbs and the shoulders. Sufferers experience numbness and tingling in the upper 

body and in severe cases, have difficulties holding even a pen. To avoid RSI follow the 

guidelines above (on wrist pains and backache). 

 
 

5. Stress 

Computers help people work faster and much efficient than they used to. This has resulted in 

teachers and executives expecting more from their students and workers than usual. In trying 

to keep the pace people work at odd hour, having little time for themselves. This has made 

many people workaholics (i.e. not being able to stop 

working) because of their fear of being fired if they fail to 

meet demand. To reduce stress people will have to:  

 Engage in more social activities. 

 Have enough sleep and not go to bed with their 

works and worries. 

 Be less anxious of the outcome of their work. 

 

Fig. 4.5: take time to rest 
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RESPONSIBLE USE OF COMPUTERS 

 

Computers have changed the fabric of the world in all sectors, and computer users have the 

luxury to do almost everything they want. While most people use the computer for good 

purposes, others have found a bad use for the computer. It has, thus become imperative for 

policy makers to strategize and come out with some rules which will not only guide the way 

computers are used, but also the way information is transmitted - known as computer ethics. 

 
 

COMPUTER ETHICS 

 

With their increasing power and versatility, computers make day-to-day life simple. 

Unfortunately, as computer use becomes more widespread, so do the opportunities for 

misuse. Computer hackers often violate privacy and can tamper with or destroy records. 

Viruses or worms can replicate and spread from computer to computer, erasing information 

or causing malfunctions. Other individuals have used computers to electronically embezzle 

funds. New ethical issues also have arisen, such as how to regulate material on the Internet 

and the World Wide Web. Long-standing issues, such as privacy and freedom of expression, 

are being re-examined in light of the digital revolution. Individuals, companies, and 

governments are working to solve these problems by instituting some regulatory laws such as 

copyright, privacy concerns and censorship. 

 

 

 

Fig. 4.6: a disorganized office could cause an accident 
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 Copyright 

Copyright are exclusive rights granted to the author or creator of an original work, including 

the right to copy, distribute and make changes to their work. Copyright does not protect ideas, 

only their expression or fixation. The goal of copyright law is to encourage authors to invest 

effort in creating new works of art and literature. Copyright is one branch of the larger legal 

field known as intellectual property, which also includes trademark and patent law. Copyright 

law is the legal foundation protecting the work of many major industries, including book 

publishing, motion-picture production, music recording, and computer software development.  

Not every work of authorship is eligible for copyright. To qualify for copyright protection, a 

work must be both fixed and original. The law considers a work to be fixed if it is recorded in 

some permanent format. Acceptable ways of fixing a work include writing it down, storing it 

on a computer floppy disk or compact disc (CD), recording it on videotape, or sculpting it in 

marble. If an musician thinks of a new song and sings it to an audience without writing it 

down or recording it on a CD or cassette, copyright does not protect the song because it is not 

fixed. To be original, the work must not be copied from previously existing material and must 

display at least a reasonable amount of creativity. For example, if an author writes the words 

―food is good‖ on a piece of paper, copyright does not protect the words because they lack 

sufficient creativity. Consequently, short phrases and titles are usually not protected by 

copyright.  

Copyright only protects the words, notes, software or images that the creator has used. It does 

not protect any ideas or concepts revealed by the work. If, for example, a scientist publishes 

an article explaining a new process for turning water into wine, the copyright prevents others 

from copying the words of that article. It does not, however, prevent anyone else from using 

the process described to turn water into wine. To protect the process, the scientist must obtain 

a patent. Similarly, if a novelist writes a book about a man obsessed about walking on water, 

other people may write their own books on the same subject, as long as they do not use the 

exact words or a closely similar plot. 

 

Privacy  

When something is private to a person, it usually means there is something within them that 

is considered inherently special or personally sensitive. Privacy is the ability of an individual 

or group to seclude themselves or information about themselves and thereby reveal 

themselves selectively. The boundaries and content of what is considered private differ 

among cultures and individuals, but share basic common themes. The degree to which private 

information is exposed therefore depends on how the public will receive this information, 

which differs between places and over time.  

Most of the time peoples right to privacy is invaded by some ICT related concept. In modern life the 

everyday use of digital technology creates numerous instances in which personal 

information—name, address, phone number, birthday, driver's license number, e-mail 

http://en.wikipedia.org/wiki/Exclusive_rights
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address, or social security number—is collected from the consumer. Increasingly, people are 

unable to keep personal information private and are often unaware of how or when this 

information is being collected, utilized, sold, or otherwise manipulated. Everything from a 

doctor's visit to shopping to sending personal mail could present an opportunity for an 

unwanted invasion of privacy. 

 

 

 

 
 

Censorship  

Censorship is the control of the information and ideas circulated within a society. The 

rationales for censorship have varied, with some censors targeting material deemed to be 

indecent or obscene; heretical or blasphemous; or seditious or treasonous. Censorship has 

been achieved through the examination of books, plays, films, television and radio 

programs, news reports, and other forms of communication for the purpose of 

altering or suppressing ideas found to be objectionable or offensive. Thus, the 

rationale for censorship is that it is necessary for the protection of three basic social 

institutions: the family, the church, and the state. In all these sectors the internet is 

the major culprit.  

Censorship takes different forms and approach, for example, most religions abhor certain 

things and advise their followers to refrain from them. In other cases countries censor some 

materials which are considered threats to national security. Censorship in the above issues 

could vary from one country or society to another, but one area where there is total unanimity 

in censorship is in the display of pornographic and violent materials. Children are mostly the 

victim of pornography and violence, especially those on the internet and parents are, 

therefore, advised to monitor their children regularly and to check what they do online. 

 

Fig. 4.7: computer and its related technology could deprive you of your privacy 
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TEST YOURSELF  

 

Theory questions 

 

1. Write a short note on the following types of computers: 

a. Digital computer 

b. Analogue computer 

c. Hybrid computer 

 

2. Describe how to boot, refresh and shut-down a computer. 

 

3. Discuss computer threats 

 

4. State and explain three computer ethics 

 

5. How do the following threats affect the computer? 

a. Power fluctuation 

b. Rodents 

c. Theft 

d. Virus 

 

6. State three uses of computers  

a. In education 

b. At home 

c. At the office 

 

7. State three ways of preventing the following threats to computer users: 

a. Stress 

b. Vision problem 

c. Backache 

d. Repetitive strain injury 

e. Wrist pains 

 

8. a.. Explain the necessity for rebooting a computer. 

b. describe three ways of rebooting a computer 

 

9. Computers are essential part to human survival. Discuss. 

 

10. Write a short note on the following types of digital computers 

a. Supercomputers 

b. Mainframe computers 

c. Minicomputers 

d. microcomputer
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Multiple choice questions 

 

1. Which of the following is not a type of 

computer? 

a. Keyboard   

b. Digital computer 

c. Hybrid computer  

d. Analogue computer 

 

2. The type of computer that converts all 

data into digital format is known as…. 

a. Analogue computer 

b. Digital computer 

c. Hybrid computer 

d. Convertor  

 

3. A sequence of 8 bit is called… 

a. Bits b, Byte 

d. Kilobyte d. Digital  

 

4. The Cray computer is an example of…  

a. Analogue computer 

b. Supercomputer 

c. Minicomputer 

d. Microcomputer  

 

5. Which of the following types of digital 

computers is referred to as a parallel 

processor? 

a. Analogue computer 

b. Supercomputer 

c. Minicomputer 

d. Microcomputer 

  

6. The process of turning on the computer 

is referred to as …. 

a. Running 

b. Kicking 

c. Shutting 

d. Booting  

 

7. The type of computer which combines 

the functions of digital and analogue 

computers is referred to as… 

a. Hybrid computer 

b. Digital computer 

c. Analogue computer 

d. Data computer 

 

8. The type of digital computer which 

uses microprocessor is known as… 

a. Super computer 

b. Minicomputer  

c. Microcomputer 

d. Mainframe computer 

 

9. A laptop compute is an example of … 

a.  Supercomputer 

b. Analogue computer 

c. Hybrid computer 

d. Microcomputer  

 

10. Another name for restarting the 

computer is known as… 

a. Reshutting 

b. Rebooting 

c. Booting 

d. Shutting down 

 

11. Which of the following is a hybrid 

computer? 

a. Thermometer 

b. Pen drive 

c. Automated teller machine 

d. Simple computer 

 

12. Pick the odd one out. 

a. Supercomputer 

b. Mainframe computer 

c. Digital computer 

d. Microcomputer 

 

13. Pick the odd one out. 

a. Digital computer 

b. Hybrid computer 

c. Analogue computer 

d. Laptop computer 
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Answers 

 

1. A 

 

2. B 

 

3. B 

 

4. B 

 

5. B 

 

6. D 

 

7. A 

 

8. C 

 

9. D 

 

10. B 

 

11. C 

 

12. C 

 

13. D 
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Hardware 

 
After completing this chapter, you should be able to: 

 

i. Describe the categories of computer hardware. 

ii. Identify the vital components of the computer. 

iii. Describe commonly used Input/Output devices and their functions. 

iv. Identify the main types of storage devices. 

v. Identify devices which serve as both input and output. 

 

 

 
OBJECTIVES 
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INTRODUCTION 

 

How do we identify a computer from other known electronic and mechanical devices? By the 

display unit or monitor, the system unit, the keyboard or keypad, the mouse etc. all these 

components can be identified because they can be seen and touched and because of that we 

refer to them as hardware. Thus, hardware refers to the components of the computer 

which can be seen and touched. The term hardware is sometimes substituted with 

peripherals.  
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CATEGORIES OF HARDWARE 

 

Hardware falls into four man categories base on the functions of the components. The 

categories are: 

 

 Input devices 

 Output devices 

 Storage devices 

 System unit 

 

1. Input devices 

Input devices are the components of the computer which are used to enter data into the 

computer. Input devices play a vital role in the information processing cycle. They serve as 

the link between the computer and the computer user. There 

are various types of input devices – keyboard, mouse, 

joystick are al examples of input devices. 

 

 

 

 

 
 

2. Output devices 

Devices that present processed information from the computer to the user are referred to as 

output devices. Examples of output devices are printer, monitor, speakers and LCD projector. 

More on that later. 

 

 

 

 

 

 

 

 

 

 

 
 

3. Storage devices  

Hard disk drives, USB flash drives, compact disks are all examples of storage 

devices. These are the devices that store or keep processed information for 

future use.  

 

Fig. 4.7: Input devices 

Fig. 4.8: output devices 

Fig. 4.9: storage device 
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4. System unit 

All the above components are able to communicate to the computer 

because of one very important hardware – the system unit. The system 

unit is a box-like metal or plastic case which houses the other electronic 

components of  a computer. The system unit is simply indispensable to the 

extent that it is sometimes referred to as the computer itself, though just a 

part of it. 

 

In the proceeding sections we will discuss the various input devices in 

detail. 

 
 

 

THE VITAL COMPONENTS OF THE SYSTEM UNIT 

 

Though computers come in many different forms, a typical personal computer‘s system unit 

consists of a case called chassis. There are different sizes, shapes and two distinct orientations 

of the chassis, even though they are basically rectangular. Some system units stand erect and 

are normally place on the computer table of under it. This type of system unit is called tower 

system unit. Another type lies flat on the computer table; this type is referred to as desktop 

system unit. even still, there is another type in which the system unit and the monitor are 

joined together. This type is known s all-in-one. 

The system unit is sometimes referred to as the central processing unit or CPU or just 

processing unit because it houses the central processing unit, which is arguably the most 

important component in a computer. The system unit contains some other components such 

as the motherboard, the power supply unit, RAM and ROM chips, disk drives, ports etc. 

These components normally appear or connected to the front, the back and some remain 

inside the system unit. 

 

The front side of the system unit  

From the front side of the system unit appears 

the power on switch or button, power switch 

light indicator, compact disk read only 

memory (CD ROM) drive(s) and the floppy 

disk drive. Some system unit also show 

universal serial bus (USB) ports, audio jack, 

zip disk drive and restart button at the front. 

 

 

 

 

 

 

 

Fig. 5.0: system unit 

Optical 

disk drive 

Floppy 

disk drive 

Power & restart 

buttons 

USB port 

Audio jack 

Fig. 5.1: front part of the system unit 

http://en.wikipedia.org/wiki/Personal_computer
http://en.wikipedia.org/wiki/Computer_case
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The back side of the system unit 

Most of the connectors or plugs for the input and output devices are found at the back of the 

system unit. Most of the connectors are ports. Ports are sockets which are used to attach 

hardware to the system unit. There are two types of ports – serial port and parallel port.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The number of connectors at the back of the system unit could increase due to the  number of 

optional components added. 

 
 

Inside the system unit 

 

Have you ever taken a peek inside a system unit before? We keep referring to the system unit 

as the central processing unit as thought the system unit is made up of one bulky CPU. But in 

actual the CPU occupies just a small space in the system unit. The CPU is implanted on a 

large circuit board known as mother board. There are other important components such as the 

power unit, the RAM chips, the ROM chips, the hard disk(s), and a host of others. Let us 

consider some of the components in details. 

Fig. 5.2: front part of the system unit 

AC Power outlet 
Power unit’s fan. 

 

PCI expansion slot 

 

Audio In and OUT jacks 

 

USB ports 

 

Video adapter port 

 

PS/2 keyboard port 

 

PS/2 mouse port 

 

RJ-45 Gigabit LAN 

 

Serial port 

 

Firewire port 
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The central processing unit (CPU) 

If you‘re in the market for a new computer, it‘s necessary to understand the function of a 

CPU. Also known as the Central Processing Unit or processor, the CPU is essentially the 

―brains‖ of your computer. Without the CPU, you wouldn‘t be able to play games, type 

research papers, or surf the Internet. Your computer would basically be a very expensive 

worthless junk. 

Sometimes people mistakenly believe the case or chassis of a computer is the CPU. However, 

a CPU is an internal component of the computer. You can‘t see it from the outside of the 

system; you would have to peek inside and remove both the CPU heatsink (component used 

to lower the temperature of an electronic device by dissipating heat into the 

surrounding air) and fan to get a good look.  

CPUs are sometimes called microprocessors, although these two terms are not quite 

interchangeable. The microprocessor, first introduced in the 1970s, 

reduces the word size of a CPU from 32 bits to 4 bits in an attempt 

to allow the transistors of the logic circuits to fit on a single part. 

Often, it takes more than one microprocessor to perform all of the 

functions of a CPU. Microprocessors are also commonly used in 

cell phones, automobiles, and children‘s electronic toys. 

Fig. 5.3: inside the system unit 

Fig. 5.4: CPU under a heatsink 

http://www.wisegeek.com/what-is-a-computer.htm
http://www.wisegeek.com/how-does-a-cpu-work.htm
http://www.wisegeek.com/what-is-a-paperweight.htm
http://www.wisegeek.com/how-do-microprocessors-work.htm
http://www.wisegeek.com/what-is-a-microprocessor.htm
http://www.wisegeek.com/what-is-a-transistor.htm
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Modern CPUs are small and square and contain multiple metallic connectors or pins on the 

underside. The CPU is inserted directly into a CPU socket, pin side down, on the 

motherboard. Each motherboard will support only a specific type or range of CPU so you 

must check the motherboard manufacturer's specifications before attempting to replace or 

upgrade a CPU.  

Today, Intel is the best-known manufacturer of computer CPUs. Other manufacturers are 

AMD and Motorola. No matter what type of computer you have, however, your CPU works 

by executing a series of stored instructions known as a program. Most CPUs conform to the 

von Neumann architecture, which says that the CPU must fetch, decode, execute, and write-

back the data in a fairly rapid succession. 

Since the CPU is one of the most 

important parts of a computer, it should 

come as no surprise that it is also the most 

expensive. In fact, if your computer is 

more than three years old and your CPU 

has been damaged by static electricity or 

some other factor, you may want to 

consider upgrading to an entirely new 

computer. A newer, faster CPU will often 

provide enough additional computing 

power to make the purchase a wise 

investment.  

As we learnt earlier, there are two typical components of a CPU. They are:  

Arithmetic-Logic Unit (ALU): ALU is a high-speed circuit part in the CPU. The 

arithmetic-logic unit (ALU) performs arithmetic (math) operations, logic 

(comparison) operations and related operations. The ALU retrieves alphanumeric data 

from memory and then does actual calculating and comparing. It sends the results of 

the operation back to memory again. 

 A control unit is the circuitry that locates, retrieves, interprets and executes each 

instruction in the central processing unit. The control unit directs electronic signals 

between primary storage and the ALU, and between the CPU and input/output 

devices. 

 

The motherboard  

The motherboard is the main circuit board in a computer. The most important computer chips 

and other electronic components that give function to a computer are located on the 

motherboard. The motherboard is a printed circuit board that connects the various 

elements on it. The motherboard is sometimes referred to as the main board, system board, 

or, on Apple computers, the logic board. The motherboard is indispensable to the computer 

Fig. 5.5: Some types of CPU 

http://www.webopedia.com/TERM/c/motherboard.html
http://en.wikipedia.org/wiki/Apple_Inc.
http://en.wikipedia.org/wiki/Logic_board


 

 

 

52 

 
 

Hardware 

and provides connector for other hardware; mind you, all the ports and sockets are extended 

from the motherboard.  

 

 

 

 

 

 

 

 

 

 

 

 

 

The power supply unit (PSU) 

The computer has got its own power supply unit which does not provide it with electricity, 

but pulls the required amount of power from electrical sockets and converts it from 

alternating current (AC) to low voltage direct current 

(DC). This is because the computer runs on DC and not 

the regular AC which comes from the power company.  

A bad power supply could cause a lot of headache. To 

ensure that your power supply works efficiently to 

keep your computer running: 

 

 Clean the computer regularly .As the computer 

runs dust, lint and other particle collect inside the 

power unit and create more heat which is one of 

the major causes of power failure.  Get a 

professional to clean it up for you if you are not 

very familiar with the architecture of the computer. 

 

 Make sure the chassis is well ventilated. Ensure all fans are running in the computer and 

that no dust is collecting within the fins – disrupting air flow.  Sometimes it helps to have 

Fig. 5.6: Motherboard  

board  

Fig. 5.5: Some types of CPU 

Fig. 5.7: power supply unit 
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a professional inspect your computer, to confirm proper airflow and ―safe‖ case 

temperatures. 

 Use a surge protector. Lighting, power outages, power spikes etc, can cause your 

power supply to fail prematurely, if a surge protector is not used at all times. 

 

 Buy a new power supply. Power supplies have a certain amount of “life-hours”, and 

eventually fail. If your power supply is old and you start experiencing power related problems 

such as:  

Failure of your computer to boot fully 

You hear some strange from the power supply 

You smell “burnt” smells coming from your computer. (Which could spell burnt or burning 

PSU circuitry) 

Then it is time to have your computer checked out by a. Many bad power supplies fail and destroy 

other components – motherboards, CPU etc. 

 

Random Access Memory (RAM)  

Next most critical element of a processing hardware is Random Access Memory (RAM), 

often referred to as "primary storage" or "main memory". RAM receives and temporarily 

stores data and program instructions from the CPU. This data bank communicates with the 

CPU, constantly exchanging information and constantly 

changing as long as the computer is on  

   

RAM is an active, electronic state. When the power is on, 

RAM retains data. When the computer is turned off, all data in 

RAM is erased unless you have saved it to some mass storage 

device. Each time the computer boots, the computer goes 

through its startup routine and lastly loads operating system instructions 

into the RAM.     

RAM temporarily stores information from your operating system, 

applications, and data in current use. This gives your processor easy 

access to the critical information that makes the programs run. The 

amount of RAM you have determines how many programs can be 

executed at one time and how much data can be readily available to a 

program. It also determines how quickly your applications perform and 

how many applications you can easily toggle between at one time. Simply 

put, the more RAM you have, the more programs you can run smoothly and 

simultaneously.  

   

RAM is measured in hertz. Hence, kilohertz, megahertz and gigahertz.  

   

Types of RAM   

 DRAM (Dynamic RAM) This is the most common type of computer 

memory. DRAM needs refreshing and is refreshed hundreds of times each second in 

order to retain data. During recharging it cannot be accessed by the CPU.  
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 SRAM (Static RAM) SRAM is approximately 5 times faster (and twice as expensive, as 

DRAM). It does not have to be constantly refreshed.  

 SDRAM (synchronous dynamic RAM) is the standard memory offering in the PC 

industry and is faster than DRAM because it's synchronized to the system clock. . It is 

designed for mainstream home and business applications, email, and basic audio and 

video streaming. It provides single-channel memory and is available on our mainstream 

and value desktop system.  

 DDR SDRAM (double data rate synchronous dynamic RAM) takes all the features of 

ordinary SDRAM and increases the frequency bandwidth to improve system performance 

and speed.  

 RDRAM (Rambus dynamic RAM) is able to load a new stream of data before the 

previous stream has completed, resulting in faster access speeds. The RDRAM memory 

features dual-channel processing which doubles data throughput to further enhance 

performance. This type of memory is optimized for high-end multimedia tasks involving 

video and audio. Dual Channel RDRAM is shipped on our performance desktop systems 

powered by Pentium 4 processors  

 VRAM: Memory designed for storing the image to be 

displayed.  

 CACHE RAM is a small block of high-speed memory 

located between the Processor and main memory and is 

used to store frequently requested data and instructions. 

When the processor requests data, it will check in the 

cache first.  

  

 

Read Only Memory (ROM) 

Read-only memory is the other type of internal memory. ROM memory is used to store items 

that the computer needs to execute when it is first turned on. For example, the ROM memory 

on a PC contains a basic set of instructions, called the basic input-output system (BIOS). The 

PC uses BIOS to start up the operating system. BIOS is stored on computer chips in a way 

that causes the information to remain even when power is turned off. 

Information in ROM is usually permanent and cannot be erased or written over easily. A 

ROM is permanent if the information cannot be changed—

once the ROM has been created, information can be retrieved 

but not changed. Newer technologies allow ROMs to be semi-

permanent—that is, the information can be changed, but it 

takes several seconds to make the change. For example, a 

FLASH memory acts like a ROM because values remain stored 

Fig. 5.8: some types of RAM 

Fig. 5.9: ROM 

javascript:void(0)
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in memory, but the values can be changed. 

 There are different  variations of the ROM chip and include:  

 PROM (Programmable Read-Only Memory): A permanent storage device that 

becomes a read-only memory after it is written once by the customer rather than by 

the chip manufacturer. For example, a software producer can write instructions onto 

the PROM using special equipment.  

 EPROM (Erasable Programmable Read-Only Memory): EPROM is a reusable 

PROM-chip that can be erased by a special ultraviolet light. EPROM holds its content 

until erased and new instructions can be written on it.  

 EEPROM (Electrically Erasable Programmable Read-Only Memory): 

EEPROM-chip can be erased, either within a computer or externally, by electric 

power. The process usually requires more voltage than the common +5 volts used in 

logic circuits. 

 

Hard disk drive 

The hard disk drive is the most important external memory of the computer. It is referred to 

as external memory or secondary storage (as oppose to primary storage – RAM and ROM) 

because the CPU cannot access it directly for data; more on that pretty shortly. The hard disk 

is a rigid rectangular box which is used to record computer data 

magnetically. A hard disk drive consists of a stack of inflexible 

magnetic disks mounted on a motor. Each surface of each disk is 

divided into a number of concentric circles. As the disks spin at 

high speeds, read/write heads at the end of a metal fork swing in 

and out to access sectors of the disks. 

 

Hard disks provide faster access to data and are capable of storing 

much more information than the other known external memories. 

Because platters are rigid, they can be stacked so that one hard-disk 

drive can access more than one platter. Most hard disks have from two 

to eight platters. 

 

Today, hard disk drives are measured in gigabytes (GB) and terabytes (TB); that is a move 

from the kilobytes (KB) and the megabytes (MB) they used 

to be measured in during the early days of computers. If you 

want to purchase a new hard disk drive you much make sure 

t go for the new ones since hard disk drive ware off with 

age, and an old hard disk drive may break down easily. 

When a hard disk breaks down, it is said to have crashed. 

You must also know the total data storage capacity of the 

hard disk drive. The total data capacity is always printed at 

the back of the case.   

Fig. 6.0: hard  disk  

Fig. 6.1: inside the hard disk  
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Bus slot 

You might think of a bus as a vehicle or mechanism for transporting something. That is very 

true just that in computer architecture, a bus is not a bulky machine on wheels which move 

from one town to another. A bus in this context is a system (usually a set of wires) that 

transfers data between the components in a computer system. A bus is essentially a shared 

highway that connects different parts of the system—including the central processing unit 

(CPU), disk-drive controller, memory, and input/output ports—and enables them to transfer 

information. Usually controlled by a microprocessor, the bus 

is, in computers such as the Apple Macintosh and IBM and 

compatible models, specialized for carrying different types of 

information. One group of wires (actually, traces on a printed 

circuit board), for example, carries data; another carries the 

addresses (locations) where specific information can be 

found; yet another carries control signals to ensure that the 

different parts of the system use their shared highway without 

conflict.  

Buses are characterized by the number of bits they can transfer at a 

single time. A computer with an 8-bit data bus, for example, transfers 8 bits of data at a time, 

and one with a 16-bit data bus transfers 16 bits at a time. Because the bus is integral to 

internal data transfer and yet computer users often need to add extra components to the 

system, most microcomputer buses allow for expansion through one or more expansion slots 

(connectors for add-on circuit boards). Such boards, when they are added, make an electrical 

connection to the bus and effectively become part of the system.  

There are two main types of buses – the processor bus and the input/output bus 

 
 

Fig. 6.2: PCI bus slots  

Fig. 6.3: how the bus system works  
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Expansion/optional slots 

The compute allows for expansion. That is new hard ware to be added to it. This is 

done with the aid of the expansion slots. Expansion slots are sockets inside a 

computer, designed to hold expansion boards and connect them to the system 

bus (data pathway). The number of sockets, or slots, determines the amount of 

expansion allowed. Most personal computers have from three to eight expansion 

slots. Expansion slots provide a means of adding new or enhanced features or more 

memory to the system. 

 

INPUT DEVICES 

I am sure by now based on the previous sections you are well acquainted with the term input 

devices. Let us refresh ourselves with the definition again; input devices are devices which 

allow the computer user to enter data into the computer. In other words they convert the user 

command into digital form (0s ans 1s) which the computer understands. Like all computer 

peripherals, input devices come in diverse varieties and for the sake of better understanding 

input devices have been categorized into groups or types based on their mode of data input. 

The groups are: 

 

 Keyboards 

 Pointing devices 

 Composite devices 

 Video and imaging input devices 

 Audio input devices

 

Keyboard  

A keyboard is a device with buttons or keys that a user presses to enter data characters and 

commands into a computer. Keyboards emerged from the combination of typewriter and 

computer-terminal technology. They are one of the basic pieces of personal computer (PC) 

hardware. There are two types of keyboards – the QWERTY keyboard and the Dvorak 

keyboard. 

 

QWERTY keyboard 

The QWERTY is the most common key pattern for typewriters and keyboards. It was named 

after the layout of the first six letters in the top row of its keys (from left to right). In the late 

1860s, American inventor and printer Christopher Sholes invented the modern form of the 

typewriter. Sholes created the QWERTY keyboard layout by separating commonly used 

letters so that typists would type slower and not jam their mechanical typewriters. Subsequent 

generations of typists have learned to type using QWERTY keyboards, prompting 

manufacturers to maintain this key orientation on typewriters. 

Fig. 6.4: expansion slots  
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Computer keyboards copied the QWERTY key layout and have followed the precedent set by 

typewriter manufacturers of keeping this convention. Modern keyboards connect with the 

computer CPU by cable or by infrared transmitter. When a key on the keyboard is pressed, a 

numeric code is sent to the keyboard‘s driver software and to the computer‘s operating 

system software. The driver translates this data into a specialized command that the 

computer‘s CPU and application programs understand. In this way, users may enter text, 

commands, numbers, or other data. The term character is generally reserved for letters, 

numbers, and punctuation, but may also include control codes, graphical symbols, 

mathematical symbols, and graphic images. On the QWERTY keyboard, some keys have 

been grouped together based on what they do. They are: 

 

 

 

Function keys: these keys generate short, fixed sequences of character codes that instruct 

application programs running on the computer to perform certain actions. They are labeled F1 

to F12.  

Letter/Typewriter keys: these are the normal keys on the typewriter, hence the name 

typewriter keys. They are made up of letters, numbers, punctuation signs and some specials 

signs such as currency signs, ampersand etc. 

Numeric keys: there is a separate numeric pad which contains numbers from 0 to 9 and some 

other characters, for entering numeric and arithmetic data. 

Arrow keys: these are directional buttons for moving the screen cursor to left, right, up or 

down the screen. 

Special purpose keys: As the name implies, these keys perform some other functions such as 

issuing a command, editing data etc. these keys include Ctrl for control; Alt for alternative; 

esc for Escape; Del for delete.  

 

 

 

Function keys Numeric keypad 

Letter keys Arrow keys 

Esc key 

Caps key 

Shift key 

Ctrl key 

Windows 

key 
Alt key 

Enter key 

Tab key 

Fig. 6.5: the make-up of QWERTY keyboard  

Space Bar 
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The Dvorak keyboard 

An alternative keyboard design not yet widely used but broadly acknowledged for its speed 

advantages is the Dvorak keyboard. In the 1930s, American educators August Dvorak and 

William Dealy designed this key set so that the letters that make up most words in the 

English language are in the middle row of keys and are easily reachable by a typist‘s fingers. 

Common letter combinations are also positioned so that they can be typed quickly. Most 

keyboards are arranged in rectangles, left to right around the QWERTY layout. Newer, 

innovative keyboard designs are more ergonomic in shape. These keyboards have separated 

banks of keys and are less likely to cause carpal tunnel syndrome, a disorder often caused by 

excessive typing on less ergonomic keyboards.  

 

 

Pointing devices 

A pointing device is an input device used to control an on-screen cursor for such actions as 

―pressing‖ on-screen buttons in dialog boxes, choosing menu items, and selecting ranges of 

cells in spreadsheets or groups of words in a document. A pointing device is also often used 

to create drawings or graphical shapes. The most common pointing device is the mouse. 

Other pointing devices include the graphics tablet, the stylus, the light pen, the joystick, the 

puck, and the trackball. 

 

Mouse  

Mouse (computer), common pointing device used with personal computers that have a 

graphical user interface (GUI). A user typically operates a mouse with one hand in order to 

move a cursor over images or text on a computer screen. Clicking buttons on the mouse 

activates, opens, or moves icons or other graphical objects on the screen when they are 

displayed under the floating cursor.  

Fig. 6.6: the make-up of Dvorak keyboard  
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A mouse is commonly attached to a personal computer by a cord that connects to a universal 

serial bus (USB) port. The rectangular USB interface allows the mouse to report its position 

at a very high rate. Other types of interfaces include a PS/2 port, which uses a smaller, round 

connector and reports the mouse‘s position at a lower rate. The PS/2 port is a dedicated 

mouse port built into the motherboard of the computer.  

The basic features of a mouse are a casing with a flat bottom, designed to be gripped by one 

hand; one or more buttons on the top; a multidirectional detection device on the bottom; and a 

cable connecting the mouse to the computer. By moving the mouse on a surface (such as a 

desk), the user typically controls an on-screen cursor. A mouse is a relative pointing device 

because there are no defined limits to the mouse‘s movement and because its placement on a 

surface does not map directly to a specific screen location. To select items or choose 

commands on the screen, the user presses one of the mouse's buttons, producing a ―mouse 

click.‖  

Most computer mice now have a small vertical wheel between two buttons to allow easy 

scrolling up and down a screen. Left-handed people can also reprogram mouse buttons to 

switch functions  

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Joystick  

A joystick an input device that looks similar to a control device you would 

find on an arcade game at game centre. A joystick allows an individual to 

easily move an object in a game such as navigating a plane in a flight 

simulator. A joystick usually has a square or rectangular plastic base to 

which is attached a vertical stem. Control buttons are located on the 

base and sometimes on top of the stem. The stem can be moved in all 

directions to control the movement of an object on the screen. The 

buttons activate various software features, generally producing on-

screen events. 

 
 

Trackball  

Take a normal mechanical mouse and turn it upside down. What do you see? Yes, A small 

ball. Try turning the ball around. What happens on the monitor? Yes, the cursor moves in 

Fig. 6.7: mouse  

Fig. 6.8: joystick  

http://www.computerhope.com/jargon/i/inputdev.htm
http://www.computerhope.com/jargon/o/object.htm
http://www.computerhope.com/jargon/g/game.htm
http://www.computerhope.com/jargon/f/flightsi.htm
http://www.computerhope.com/jargon/f/flightsi.htm
http://www.computerhope.com/jargon/f/flightsi.htm
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correspondence with the movements of the ball. That is exactly what a trackball looks like.  

Trackball can be roughly described as a mouse on its back. A trackball consists of a ball 

resting on two rollers at right angles to each other, which translate the ball's 

motion into vertical and horizontal movement on the screen. A trackball 

also typically has one or more buttons to initiate other actions. The only 

functional difference between a mechanical mouse and a trackball is in how 

the ball is moved: With a mouse, the ball is rolled by moving the  entire unit 

over a desktop or other surface; with a trackball, the housing is stationary, 

and the ball is rolled with the hand. A trackball is useful for fine work 

because the user can exert fingertip control. Another major advantage of a 

trackball is that it takes little desktop surface. 

 
 

Graphic/digitizing tablet & stylus 

A graphic or digitizing tablet is a flat plastic rectangle with subsurface electronics, used in 

conjunction with a pointing device in many engineering and design applications as well as in 

illustration work. When the pointing device is moved on the surface of the tablet, the location 

of the device is translated to a specific on-screen cursor position. The pointing device used 

with a graphics tablet is usually a special pen called a stylus. The stylus is usually attached to 

the tablet by a cord, though are cordless types. 

 
 

Light pen 

A light pen is a pointing device in which the user holds a 

special pen, which is attached to the computer, up to the 

screen and selects items or chooses commands on the screen 

(the equivalent of a mouse click) either by pressing a clip on 

the side of the light pen or by pressing the light pen against 

the surface of the screen. The wand contains light sensors and 

sends a signal to the computer whenever it records a light, as 

during close contact with the screen. The light pen is not to be 

confused with a stylus, which is rather attached to a digitizing 

tablet and not directly the computer.  

 
 

Imaging and Video input devices 

Imaging and video input devices are used to digitize images or video from the outside world 

into the computer. The information can be read in a variety of formats depending on the 

user's requirement. Some imaging and video input devices are: 

 
 

Digital camera:  A type of camera that stores the pictures or 

video it takes in electronic format instead of to film. There are 

several features that make digital cameras a popular choice when 

Fig. 6.9: trackball 

Fig. 7.0: light pen 

Fig. 7.1: digital camera 

http://en.wikipedia.org/wiki/Video
http://en.wikipedia.org/wiki/Digital_camera
http://www.computerhope.com/jargon/c/camera.htm
http://www.computerhope.com/jargon/p/picture.htm
http://www.computerhope.com/jargon/v/video.htm
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compared to film cameras. First, the feature often enjoyed the most is the LCD display on the 

digital camera. This display allows users to view photos or video after the picture or video 

has been taken, which means if you take a picture and don't like the results, you can delete it; 

or if you do like the picture, you can easily show it to other people. Another 

nice feature with digital cameras is the ability to take dozens, sometimes 

hundreds of different pictures. 

 
 

Webcam:  A camera connected to a computer that allows anyone connected 

to the Internet to view either a still pictures or motion video of a user or other 

object. Today, most webcams are either embedded into the display with laptop computers or 

connected to the USB or Firewire port on the computer. 

   

Image scanner: A device that reads letters, numbers, symbols or other graphics from a 

printed page and translates them into digital signal that the computer can understand. Flatbed 

scanner is the most popular scanner. It mode of operation is similar to a photocopier. The 

images or texts are placed face down on the flat bed of the glass and 

the lid is closed. The sensor moves across below the glass reading 

the information. The scanned image or text can be edited on the 

computer. Another type of scanners is the handheld scanners. These 

scanners are small enough to fit in the hand and are rolled across the 

document or image to be scanned. Handheld scanners are not always 

the preferred choice because more time is spent in scanning a single 

document and also the quality of the images produced is poor as 

compared to the flatbed scanners. 

 
 

Bar code reader : You might have come across bar codes a 

couple of times. These are series of parallel vertical lines, or bars, 

used to assign a unique identification code to an item. In a bar 

code, a number or character is represented in binary form by a 

short sequence of alternating black and white bars of varying 

width. A bar code combines several of these sequences to create a 

unique set of numbers or characters that identifies the item. Bar codes are normally found on 

products in supermarket, book stores and shops and show 

the prices of the products. 

A bar code reader is a device that is used to read bar codes. 

It uses a visible light to scan the bar codes, and the 

information is then transmitted to a computer for processing. 

Some types of bar code reader are: 

 Wands 

 Handheld scanners  

 Projection/vertical scanners  

 Built-in counter scanners 

Fig. 7.2: webcam 

Fig. 7.3: image scanner 

Fig. 7.4: barcode 

Fig. 7.4: barcode reader 

http://www.computerhope.com/jargon/l/lcd.htm
http://www.computerhope.com/jargon/d/display.htm
http://en.wikipedia.org/wiki/Webcam
http://www.computerhope.com/jargon/i/internet.htm
http://www.computerhope.com/jargon/p/picture.htm
http://www.computerhope.com/jargon/v/video.htm
http://www.computerhope.com/jargon/l/laptop.htm
http://www.computerhope.com/jargon/u/usb.htm
http://www.computerhope.com/jargon/f/firewire.htm
http://en.wikipedia.org/wiki/Barcode_reader
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Biometric systems   Methods for identifying a person on the basis of 

some biological or behavioral characteristic of the person. Many biological 

characteristics, such as fingerprints, and behavioral characteristics, such as 

voice patterns, are distinctive to each person. Biometric systems such as 

fingerprint identification scans the fingerprint and feed it to the computer for 

processing. Such systems are normally used as security measures to allow 

authorized persons to a room, place etc. other types of biometric systems 

include:   

 Facial recognition 

 Voice recognition 

 Hand geometry 

 Iris-base identification 

 Retinal pattern recognition 

 

Optical mark reader/recognition (OMR) 

An optical mark reader is a device that reads pencil marks on a 

specially designed paper and converts into digital form for 

computer usage. Optical mark readers are used for multiple choice 

answer sheets, where it scans the answers to the computer for 

analysis and grading.  

 

 

 

 

 
 

Optical character recognition (OCR) 

In computer science, the process of examining printed characters on paper and determining 

their shapes by detecting patterns of dark and light. Once the scanner or reader has 

determined the shapes, character recognition methods—pattern matching with stored sets of 

characters—are used to translate the shapes into computer text. Sometimes OCR is done with 

special readers, but often it is done using a standard optical scanner and specialized software. 

 
 

Audio input devices 

Audio input devices are used to either capture or create sound. These devices digitize sound 

for the computer. Audio input devices include: 

  Microphone  

 MIDI devices  

 

Microphone: Sometimes abbreviated as mic, a microphone is hardware 

 peripheral that allows computer users to input audio into their computers.  

The audio could be a voice command from the user or sounds from other sources.  

Fig. 7.5: multiple choice answer sheet 

Fig. 7.6: microphone 

http://en.wikipedia.org/wiki/Fingerprint_scanner
http://en.wikipedia.org/wiki/Microphone
http://en.wikipedia.org/wiki/MIDI_keyboard
http://www.computerhope.com/jargon/i/input.htm
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MIDI devices: MIDI is an acronym for Musical Instrument Digital Interface, a serial 

interface standard that allows for the connection of musical instruments and computers. 

Computers have special ports known as MIDI in. Theses allow the musical instrument to be 

connected to the computer. The commonest MIDI device is the (MIDI) keyboard.  

 

 

 

 

 

 

Composite (input) devices 

Input devices, such as buttons and joysticks, can be combined on a single 

physical device that could be thought of as a composite device. Many gaming 

devices have controllers like this. Technically mice are composite devices, as 

they both track movement and provide buttons for clicking, but composite 

devices are generally considered to have more than two different 

forms of input. Examples of composite input devices are: 

 Game controller  

 Gamepad (or joypad)  

 Paddle (game controller)  

 Wii Remote  

 

 

 

 

 

OUTPUT DEVICES 

Output devices are device that transmit processed information from the computer to the user.  

Information output is in two main forms: 

 

Soft copy:  Data or information which is shown on the display unit or stored on a storage 

device. Soft copy could be texts, videos, graphics or audio. 

 

Hard copy:  This refers to information that is printed out on paper.  

 

Examples of output devices are: 

 

 

 Monitor 

 Printer 

 Speaker 

Fig. 7.7: MIDI ports 

Sound card MIDI/game port MIDI keyboard port 

Fig. 7.8: composite devices 

Wii remote paddle 

gamepad 

http://en.wikipedia.org/wiki/Video_game
http://en.wikipedia.org/wiki/Game_controller
http://en.wikipedia.org/wiki/Gamepad
http://en.wikipedia.org/wiki/Paddle_(game_controller)
http://en.wikipedia.org/wiki/Wii_Remote
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Fig. 7.9 liquid crystals between two glass plates 

Fig. 8.0: LCD monitor    

 LCD projector

 

 Monitor  

Also known as video display unit (VDU), a monitor is a device connected to a computer 

that displays information on a screen. Modern computer monitors can display a wide variety 

of information, including text, icons (pictures representing commands), photographs, 

computer rendered graphics, video, and animation. 

There are two type of monitors. They are the liquid crystal display (LCD) monitors and 

cathode-ray tube (CRT) monitors.  

 

Liquid crystal display (LCD) 

 

Liquid crystal display (LCD) monitor are normally referred to as flat panel monitors, because 

they are flat and occupy less space. LCD monitors also emit less heat and are easy to 

transport because of their relatively light weight. LCD monitors 

are made from liquid crystal, substance that behaves like both a 

liquid and a solid. The molecules in liquid crystals can move 

past each other relatively easily, much like molecules in a 

liquid. However, all the molecules in a liquid crystal tend to be 

oriented in the same manner, much like the molecular 

arrangement in a solid crystal. Liquid crystals retain their dual 

liquid and solid nature only over a certain range of temperatures 

and pressures. The liquid crystals are trapped between 

two glass plates to make them firm. LCDs are 

commonly found with the display unit of laptop 

computers 

 

 

 

 

 

 

 
 

Cathode-ray tube (monitors) 

Most computer monitors use a cathode-ray tube (CRT) as the display device. A CRT is a 

glass tube that is narrow at one end and opens to a flat screen at the other end. The CRTs 

used for monitors have rectangular screens, but other types of CRTs may have circular or 

square screens. The narrow end of the CRT contains a single electron gun for a monochrome, 

or single-color monitor, and three electron guns for a color monitor—one electron gun for 

each of the three primary colors: red, green, and yellow. The display screen is covered with 

tiny phosphor dots that emit light when struck by electrons from an electron gun. 

http://en.wikipedia.org/wiki/File:LCD_RGB_subpixel.jpg
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Fig. 8.1: CRT monitor    

Fig. 8.2: phosphor dot  

Fig. 8.3: measuring screen size  

 

 

 

 

 

 

 

 

 

 

 

 

 

Monochrome monitors have only one type of phosphor dot while color monitors have three 

types of phosphor dots, each emitting either red, green, or blue light. One red, one green, and 

one blue phosphor dot are grouped together into a 

single unit called a picture element, or pixel. A pixel 

is the smallest unit that can be displayed on the 

screen. Pixels are arranged together in rows and 

columns and are small enough that they appear 

connected and continuous to the eye.  

 

Electronic circuitry within the monitor controls an electromagnet that scans and focuses 

electron beams onto the display screen, illuminating the pixels. Image intensity is controlled 

by the number of electrons that hit a particular pixel. The more electrons that hit a pixel, the 

more light the pixel emits. The pixels, illuminated by each pass of the beams, create images 

on the screen. Variety of color and shading in an image is produced by carefully controlling 

the intensity of the electron beams hitting each of the dots that make up the pixels. The speed 

at which the electron beams repeat a single scan over the pixels is known as the refresh 

rate. Refresh rates are usually about 60 times a second. 

 

Monochrome monitors display one color for text and pictures, such as white, green, or amber, 

against a dark color, such as black, for the background. Gray-scale monitors are a type of 

monochrome monitor that can display between 16 and 256 different shades of gray. 

Manufacturers describe the quality of a monitor‘s display by dot pitch, which is the amount 

of space between the centers of adjacent pixels. Smaller dot pitches mean the pixels are 

more closely spaced and the monitor will yield sharper images. Most monitors have dot 

pitches that range from 0.22 mm (0.008 in) to 0.39 mm (0.015 in). 

 

The screen size of monitors is measured by the distance from one corner 

of the display to the diagonally opposite corner. A typical size is 38 cm 

(15 in), with most monitors ranging in size from 22.9 cm (9 inches) to 53 

cm (21 inches). Standard monitors are wider than they are tall and 

are called landscape monitors. Monitors that have greater height 

Cathode-ray tube    

http://en.wikipedia.org/wiki/File:LCD_RGB.jpg
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Fig. 8.4: printer 

than width are called portrait monitors. 

 

The amount of detail, or resolution, that a monitor can display depends on the size of the 

screen, the dot pitch, and on the type of display adapter used. The display adapter is a 

circuit board that receives formatted information from the computer and then draws an 

image on the monitor, displaying the information to the user. Display adapters follow 

various standards governing the amount of resolution they can obtain. Most color monitors 

are compatible with Video Graphics Array (VGA) standards, which are 640 by 480 pixels 

(640 pixels on each of 480 rows), or about 300,000 pixels. VGA yields 16 colors, but most 

modern monitors display far more colors and are considered high resolution in comparison. 

Super Video Graphics Array (SVGA) monitors have 1024 by 768 pixels (about 800,000) 

and are capable of displaying more than 60,000 different colors. Some SVGA monitors can 

display more than 16 million different colors. 

 

 

Printers  

 

A printer is an output device that puts text or a computer-generated image on paper or 

on another medium, such as a transparency. Printers can 

be categorized in several ways based on the formation of 

images. Some of the categories are: 

Print technology: Chief among these, with 

microcomputers, are pin dot-matrix, ink-jet, laser, thermal, 

and (although somewhat outdated) daisy-wheel or thimble 

printers. Pin dot-matrix printers can be further classified by 

the number of pins in the print head: 9, 18, 24, and so on. 

Character formation: Fully formed characters made of 

continuous lines (for example, those produced by a daisy-wheel printer) 

vs. dot-matrix characters composed of patterns of dots (such as those produced by standard 

dot-matrix, ink-jet, and thermal printers). Laser printers, while technically dot-matrix, are 

generally considered to produce fully formed characters because their output is very clear and 

the dots are extremely small and closely spaced. 

Method of transmission: parallel (byte-by-byte transmission) vs. serial (bit-by-bit 

transmission). These categories refer to the means by which output is sent to the printer rather 

than to any mechanical distinctions. Many printers are available in either serial or parallel 

versions, and still other printers offer both choices, yielding greater flexibility in installation 

options. 

Method of printing: Character by character, line by line, or page by page. Character printers 

include standard dot-matrix, ink-jet, thermal, and daisy-wheel printers. Line printers include 

the band, chain, and drum printers that are commonly associated with large computer 
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installations or networks. Page printers include the electro-photographic printers, such as 

laser printers. 

Print capability: Text-only vs. text-and-graphics. Text-only printers, including most daisy-

wheel and thimble printers and some dot-matrix and laser printers, can reproduce only 

characters for which they have matching patterns, such as embossed type, or internal 

character maps. Text-and-graphics printers—dot-matrix, ink-jet, laser, and others—can 

reproduce all manner of images by ―drawing‖ each as a pattern of dots 

Based on the above categories, printers can be grouped into two:  

Impact printers and Non-impact printers 

Impact printers physically strike the paper and are exemplified by pin dot-matrix printers and 

daisy-wheel printers 

Nonimpact printers include every other type of print mechanism, including laser, ink-jet, and 

thermal printers. 

 

Plotters  

A plotter is an output device that is used to draw high quality graphs and other pictorial 

images on paper. Plotters are used in conjunction with 

computer aided-design applications to produce 

technical drawing and architectural plans more quickly 

and efficiently. There are two types of plotters – the 

flat-bed plotter and drum or roller plotter. Drum 

plotters are often preferred over flat-bed plotters 

because they can produce neat and accurate drawings 

on large sheets of paper. 

 
 

Speakers  

While microphones digitize audio for the computer, speakers convert digital signals to audio 

in the form of music, speech or (warning) beep for the outside world. Most computers come 

with small internal speakers that will beep to draw the users‘ attention to an error – for 

example if you hit a wrong key. To produce better quality 

sound additional speakers are attached to multimedia 

computers through a sound card. 

One advantage of computer speakers is it allows the visually 

impaired to know what is happening on the computer.   

 

 

Fig. 8.5: plotter 

Fig. 8.6: speakers 



 

 

 

69 

 
 

Hardware 

LCD Projectors  

An LCD projector is a device for displaying video, images or computer data on a screen or 

other flat surface. To display images, LCD (liquid crystal display) projectors typically send 

light from a Metal halide lamp through a prism that separates light to three poly silicone 

panels – one each for the red, green, and blue components 

of the video signal. As polarized light passes through the 

panels (combination of polarizer, LCD panel and 

analyzer), individual pixels can be opened to allow light to 

pass or closed to block the light. The combination of open 

and closed pixels can produce a wide range of colors and 

shades in the projected image. 

Metal Halide lamps are used because they output an ideal color temperature and a broad 

spectrum of color. These lamps also have the ability to produce an extremely large amount of 

light within a small area. 

 

TYPES OF STORAGE DEVICES 

  

Another range of important peripheral devices aside input and output devices are storage 

devices. These are devices that are used to keep record of data and information. 

Storage or mass storage refers to various techniques and devices for storing large amounts of 

data. Mass storage devices include all types of disk drives and tape drives. Mass storage is 

different from memory, which refers to temporary storage areas within the computer. Unlike 

RAM memory, mass storage devices retain data even when the computer is turned off.  

  

Mass storage is measured in:  

Kilobytes (1,024 bytes)  

Megabytes (1,024 kilobytes, approximately 1 million bytes)  

Gigabytes (1,024 megabytes, approximately 1 billion bytes)  

Terabytes (1,024 gigabytes, approximately trillion bytes)  

  

Storage devices have been grouped into two main levels such as primary and secondary 

storage devices. As discussed earlier, primary storage devices are the RAM and ROM. This 

discussion, though, will be centered on the secondary storage devices which include hard 

disk, floppy disk, flash memory (pen drive), optical storage, zip disk and tape. Now let us 

take them one after the other. 

 
 

Hard disk 

A hard disk or hard disk drive is a non-volatile storage device for digital data. By being 

volatile, hard disks retain the data or information stored on them even when the power is out. 

Fig. 8.7: LCD projector 

http://en.wikipedia.org/wiki/Liquid_crystal_display
http://en.wikipedia.org/wiki/Metal_halide_lamp
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http://www.webopedia.com/TERM/M/gigabyte.html
http://www.webopedia.com/TERM/M/terabyte.html
http://en.wikipedia.org/wiki/Non-volatile_storage
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Fig. 8.8: hard disk 

It features one or more rotating rigid platters on a motor-driven spindle 

within a metal case. Data is encoded magnetically by read/write heads 

that float on a cushion of air above the platters.  

Hard disk manufacturers quote disk capacity in SI-standard powers of 

1000, wherein a terabyte is 1000 gigabytes and a gigabyte is 1000 

megabytes. With file systems that measure capacity in powers of 1024, 

available space appears somewhat less than advertised capacity. For 

example you may see a capacity of 20 GB written on a hard disk case, but the 

actual capacity is less than 20 GB. 

The first hard disk drive was invented by IBM in 1956. They have fallen in cost and physical 

size over the years while dramatically increasing capacity. Hard disk drives have been the 

dominant device for secondary storage of data in general purpose computers. They have 

maintained this position because advances in their areal recording density have kept pace 

with the requirements for secondary storage. Form factors have also evolved over time from 

large standalone boxes to today's desktop systems mainly with standardized 3.5" form factor 

drives, and mobile systems mainly using 2.5" drives. Today's hard disk drives operate on 

high-speed serial interfaces, i.e., Serial ATA (SATA) or Serial attached SCSI (SAS). 

The presentation of an HDD to its host is determined by its controller. This may differ 

substantially from the drive's native interface particularly in mainframes or servers. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Floppy disk 

A floppy disk is a data storage medium that is composed of a disk of thin, flexible ("floppy") 

magnetic storage medium called mylar encased in a square or rectangular plastic shell. 
Originally the floppy disk was created for storing audio tracks with greater clarity. As the 

computer boom began the floppy disk quickly replaced the punch card. There are two types 

of floppy disks:  

Fig. 8.9: structure of a hard disk 
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5.25" - this type of disk can store anywhere from 100 kilobytes to 1.2 megabytes of data.  

3.5" - this disk is capable of storing from 720 kilobytes to 1.4 MB of data.  

Floppy disks are read and written by a floppy disk drive or FDD, A small motor in the drive 

rotates the disk at a regulated speed while a second motor-

operated mechanism moves the magnetic read/write head,(or 

heads, if a double-sided drive) along the surface of the disk. To 

write data onto the disk, current is sent through a coil in the 

head. The magnetic field of the coil magnetizes spots on the disk 

as it rotates; the change in magnetization encodes the digital 

data. To read data, the tiny voltages induced in the head coil by 

the magnetization on the disk are detected, amplified by the disk 

drive electronics, and sent to the Floppy disk controller. The 

controller separates the data from the stream of pulses coming 

from the drive, decodes the data, tests for errors, and sends the data 

on to the host computer system. 

Computer manufacturers worldwide are no longer providing floppy disk drives on new 

computers as other forms of storage offer much higher capacity at little or no extra cost. In 

particular USB flash drives have become massively popular and are replacing the floppy disk 

as the entry level form of data storage on all home computers for users of all levels. 

 

USB Flash Drive 

A USB flash drive, commonly known as pen drive, consists of a flash memory data storage 

device integrated with a Universal Serial Bus (USB) interface. USB flash drives are typically 

removable and rewritable, and physically much smaller than a floppy disk. Most weigh less 

than 30 g.  Storage capacities as of 2010 can be as large as 256 GB with steady improvements 

in size and price per capacity expected. Some allow 1 million write or erase 

cycles
 
and have a 10-year data retention cycle. 

USB flash drives are often used for the same purposes as floppy disks 

were. They are smaller, faster, have thousands of times more capacity, and 

are more durable and reliable because of their lack of moving parts.  

Flash drives use the USB mass storage standard, supported natively by 

modern operating systems such as Windows, Mac OS X, Linux, and other 

Unix-like systems. USB drives with USB 2.0 support can store more data 

and transfer faster than a much larger optical disc drive and can be read by 

many other systems such as the Xbox 360, PlayStation 3, DVD players and in some 

upcoming mobile smartphones. 

Nothing moves mechanically in a flash drive; the term drive persists because unlike floppy 

disk and optical disk computers read and write flash-drive data using the same system 

Fig. 9.0: 3.5 floppy disk 

Fig. 9.1 pen drive 

floppy disk 
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Fig. 9.3: optical disk drive 

floppy disk 

commands as for a mechanical, with the storage appearing to 

the computer operating system and user interface as just 

another drive. Flash drives are very robust mechanically. 

A flash drive consists of a small printed circuit board carrying 

the circuit elements and a USB connector, insulated electrically 

and protected inside a plastic, metal, or rubberized case which 

can be carried in a pocket or on a key chain, for example. The 

USB connector may be protected by a removable cap or by 

retracting into the body of the drive, although it is not likely to 

be damaged if unprotected. Most flash drives use a standard 

type-A USB connection allowing plugging into a port on a personal 

computer, but drives for other interfaces also exist. 

Most USB flash drives draw their power from the USB connection, and do not require a 

battery. Some devices that combine the functionality of a digital audio player with flash-

drive-type storage require a battery for the player function. 

 

 

Optical disk 

An optical disc is a flat, usually circular disc which stores binary data on a special material 

(often aluminium) on one of its flat surfaces. The data sits on top of 

a thicker substrate which makes up the bulk of the disc. The data 

follows a continuous, spiral path covering the entire disc surface and 

extending from the innermost track to the outermost track. The data 

is stored on the disc with a laser or stamping machine, and can be 

accessed when the data path is illuminated with a laser diode in an 

optical disc drive. 

 An optical disc drive (ODD) is a device that uses laser light or 

electromagnetic waves to read or write data to or from optical discs. 

Some drives can only read from discs while others are 

commonly both readers and recorders. Recorders are 

sometimes called burners or writers. Compact discs, 

DVDs, HD DVDs and Blu-ray discs are common types of 

optical media which can be read and recorded by such 

drives. 

When writing or reading an optical disks, ODD spins the disc at 

speeds of about 200 round per minute (RPM) up to 4000 RPM or more depending on the 

drive type, disc format, and the distance of the read head from the center of the disc (inner 

tracks are read at a faster disc speed).  

Fig. 9.2: optical disk 

floppy disk 

 

 

Fig. 9.1: inside a pen drive 

floppy disk 
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The reverse side of an optical disc usually has a printed label, generally made of paper but 

sometimes printed or stamped onto the disc itself. This side of the 

disc contains the actual data and is typically coated with a transparent 

material, usually lacquer. Unlike the 3½-inch floppy disk, most 

optical discs do not have an integrated protective casing and are 

therefore susceptible to data transfer problems due to scratches, 

fingerprints, and other environmental problems. 

Optical discs are usually between 7.6 and 30 cm (3 to 12 inches) in 

diameter, with 12 cm (4.75 inches) being the most common size. A 

typical disc is about 1.2 mm (0.05 inches) thick, while the track pitch (distance from the 

center of one track to the center of the next) is typically 1.6 µm (microns). 

An optical disc is designed to support one of three recording types: read-only (eg: CD and 

CD-ROM), recordable (write-once, e.g. CD-R), or re-recordable (rewritable, e.g. CD-RW). 

Optical discs are most commonly used for storing music (e.g. for use in a CD player), video 

(e.g. for use in a DVD player), or data and programs for personal computers.  

Compact disc drives store information on pits burned into the surface of a disc of reflective 

material (see CD-ROM). CD-ROMs can store up to 737 megabytes (MB) of data. A Compact 

Disc-Recordable (CD-R) or Compact Disc-ReWritable (CD-RW) drive can record data onto 

a specialized disc, but only the CD-RW standard allows users to change the data stored on the 

disc. A digital versatile disc (DVD) looks and works like a CD-ROM but can store up to 17.1 

GB of data on a single disc. Like CD-ROMs, there are specialized versions of DVDs, such as 

DVD-Recordable (DVD-R) and DVD-ReWritable (DVD-RW), that can have data written 

onto them by the user. More recently Sony Electronics developed DVD technology called 

Blu-ray. It has much higher storage capacities than standard DVD media. 

 
 

Magnetic tape 

 

Magnetic tape use magnetic tape similar to the tape used in VCR cassettes. They 

are made up of a thin plastic strip with a magnetic coating to one side which is 

wound around a reel or cartridge. The tape is read or written to by a tape drive. 

Tape drives have a very slow read/write time, nonetheless, tapes have a very 

high capacity; in fact, their capacity is second only to hard disk drives. Tapes are 

mainly used to back up data. 

 

Data access on tapes s known as serial access – meaning the tape must be run from one end to 

the other before you can locate the actual data you 

want. This is opposite the conventional direct access 

used by the computer to locate data on hard, floppy 

and optical disks. 

 

 

Fig. 9.4: 51 GB DVD 

disk 

Fig. 9.5: magnetic tape 

floppy disk 

Fig. 9.6: magnetic tape inside cartridge 
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Zip disk and drive 

A Zip drive is a small, portable medium-capacity removable disk storage system used 

primarily for backing up and archiving personal computer files. It was introduced by Iomega 

Corporation. Zip drives and disks come in three sizes - the 

100 MB size actually holds 100,431,872 bytes of data or 

the equivalent of 70 floppy diskettes, the 250 MB drive 

and disk and the 750 MB disk and drive.  

Zip drives became the most popular of the super-floppy 

type products which filled a niche in the late 1990s 

portable storage market. However it was never popular 

enough to replace the 3.5-inch floppy disk nor could ever 

match the storage size available on rewritable CDs and later rewritable DVDs. USB flash 

drives ultimately proved to be the better rewritable storage medium among the general public 

due to common availability of USB ports built into most models of personal computer. Zip 

drives fell out of favor for mass portable storage during the early 2000s.  

DEVICES WHICH SERVE AS BOTH INPUT AND OUTPUT 

 

We have discussed input and output devices at length; input devices send data from the 

computer user to the computer; whiles output devices send information from the computer to 

the user. There are other devices which are hybrid of input and output devices. That is they 

combine the functions of input and output devices by alternatively converting analogue 

signals from the user to the computer and vice versa. Examples of such devices are computer 

headset, modem. 

 
 

Computer headset  

A computer headset is basically a microphone and a speaker fused together. 

This means it can digitize audio input from the user to the computer and at the 

same time convert digital signal from the computer to an audio output. 

 
 

Modem  

A modem is an electronic device that allows computers to exchange 

information by connecting them via a telephone line. Modems consist 

of a modulator which converts computer information into telephone 

signal and a demodulator which converts telephone signal to digital 

signal for the computer.  

 

 

 

 

Fig. 9.7: Zip disk in a drive 

Fig. 9.8: computer headset 
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TEST YOURSELF  

Theory questions 

1. Discuss the following categories of hardware; 

i. Input 

ii. Output 

iii. Storage 

iv. Processing 

 

2. Describe the front, back, and the inside of a system unit. 

 

3. Write a short note on the following: 

i. Motherboard 

ii. Bus  

iii. ROM 

iv. RAM 

 

4. a. What are input devices? 

b. Write a short note on 4 input devices. 

 

5. Describe the QWERTY keyboard. 

 

6. Write a short note about the functions of the following input devices: 

i.  Mouse  

ii. Joystick 

iii. Trackball 

iv. Digital camera 

v. Barcode reader 

vi. Optical mark reader 

 

7. Describe the two types of computer monitor. 

 

8.  Write a short note on the following output devices: 

i. Printer 

ii. Plotter 

iii. Speaker 

iv. LCD projector 

 

9. Identify four types of storage devices. 

 

10. How do modems and computer headset work as both input and output devices. 
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Identify the following as input, output, processing or storage devices. 

(Tick the hardware category to which each device belongs)  

 

Device  Input  Output  Processing   Storage  

Pen drive     

Trackball       

Modem      

Processor      

LCD projector     

Barcode reader     

Magnetic tape     

Plotter      

Zip disk     

Biometric systems     

 

 

Write the following abbreviations in full. 

 

Abbreviation Meaning  

ATM  

SVGA  

GUI  

RAM  

DVD  

USB  

VDU  

MB  

RAM  

OCR  

OMR  
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After completing this chapter, you should be able to: 

 

i. Identify types of software. 

ii. Distinguish between Open Source and Proprietary Software 

iii. Identify different types, examples and uses of Application software. 

iv. Launch some Application software. 

v. Identify devices which serve as both input and output. 

 

 
OBJECTIVES 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chapter
 4 

 

SOFTWARE 

 

 

INTRODUCTION  

 

The last chapter was exclusively on hardware. Now, let us talk about the other brothers or 

perhaps, sister, software. In the actual sense, hardware and software complement each other, 

and that without one the other is as good as rubbish. You could think of software as food that 

the hardware eats to get energy to work. In a more technical sense, a software is set of 

instructions that tell various hardware what to do or how to do a specific task. From the 

above explanation it could be said that a computer system is made up of hardware and 

software, with hardware being the body (visible parts) and software, the soul (invisible part). 

Software is also known as programs, and they are interchangeable. 
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TYPES OF SOFTWARE PACKAGES 

 

Software as a whole can be divided into a number of categories based on the 

types of work they do. The two primary software categories are system 

software, which control the workings of the computer, and application 

software, which addresses the number of tasks for which people use 

computers. Let us consider them in depth.   

 

System software 

System software is software designed to operate the computer hardware and to provide and 

maintain a platform for running application software.  

The most basic types of system software are: 

 

 The operating system  which allows the parts of a computer to work together by 

performing tasks like transferring data between memory and disks or rendering output 

onto a display device. It also provides a platform to run high-level system software 

and application software.  

 The computer BIOS and device firmware, which provide basic functionality to 

operate and control the hardware connected to or built into the computer.  

 Utility software, which helps to analyze, configure, optimize and maintain the 

computer.  

 

System software is normally preinstalled on the computer and is usually not what a user 

would buy a computer for. It helps use the operating system and computer system. It includes 

diagnostic tools, compilers, servers, windowing systems, utilities, language translator, data 

communication programs, data management programs and more. The purpose of system 

software is to insulate the applications programmer as much as possible from the details of 

the particular computer complex being used, especially memory and other hardware features, 

and such accessory devices as communications, printers, readers, displays, keyboards, etc. 

 
 

The Operating system 

 

An operating system (OS) is a software that runs on computers and manages the computer 

hardware and provides common services for efficient execution of various application 

software. In other words an operating system is a set of programs that control the basic 

functions of a computer. 

 

The operating system has three major functions:  

 It coordinates and manipulates computer hardware, such as computer memory, printers, 

disks, keyboard, mouse, and monitor  

 It organizes files on a variety of storage media, such as floppy disk, hard drive, compact 

disc, digital video disc, and tape 

 It manages hardware errors and the loss of data. 
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For hardware functions such as input and output and memory allocation, the operating system 

acts as an intermediary between application programs and the computer hardware, although 

the application code is usually executed directly by the hardware. Operating systems are 

either single-tasking or multitasking. The old fashion single-tasking operating systems can 

run only one process at a time. For instance, when the computer is printing a document, it 

cannot start another process or respond to new commands until the printing is completed. 

All modern operating systems are multitasking and can run several processes simultaneously. 

Operating systems are found on almost any device that contains a computer—from mobile 

phones and video game consoles to supercomputers and web servers. 

 
 

Types of operating systems 

 

There are a lot of operating systems on the market. Some popular operating systems for 

computers include DOS, Microsoft Windows, Macintosh, Linux and Unix. 

 

DOS 

DOS is an acronym for Dist Operating System; you might come across MS-DOS (which 

stands for MicroSoft DOS) in some books or other sources, they are the same thing. MS-DOS 

is a non-graphical command line operating system introduced by Microsoft in August 1981 

for IBM compatible computers, and for many years was the most popular operating system. 

in use until the release of Windows operating system. DOS controls many internal computer 

functions such as how to process information, how to manage files and how interpret 

commands. For this reason it is described as command led system. 

DOS commands are still used today even on the newest version of Microsoft‘s operating 

system, Windows 7. When the command is input, the command processor or interpreter 

receives it and carry it out. DOS commands follow a set of rules. The words in the commands 

are often abbreviated versions of the actual words, and may appear intangible to the outsider, 

but the DOS interpreter understands it. For example if you want display the contents of the 

hard disk you could type ‗dir‘ in the command prompt and that will show the contents of the 

hard disk (normally labeled drive C) in DOS made. All DOS commands are entered with the 

keyboard.  

 

Fig. 10.1: content of drive C viewed in  DOS  Fig. 10.0: content of drive C viewed  in  Windows 
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Windows  

Windows was introduced in 1985 to better the performance of DOS. The name Windows 

comes from the computer term „windowing environment‟, which is an operating system that 

can divide the screen into separate areas called windows. Each window is independent on the 

other and has its own features that can be used to manipulate it.  

Unlike DOS, Windows allows users to enter commands with a point-and-click device, such 

as a mouse, instead of a keyboard only. The Windows operating system provides users with a 

graphical user interface (GUI), which allows them to manipulate small pictures, called 

icons, on the computer screen to issue commands. Windows is the most widely used 

operating system in the world. It is an extension of and replacement for Microsoft‘s Disk 

Operating System (MS-DOS). 

 

The Windows GUI is designed to be a natural, or intuitive, work environment for the user. 

With Windows, the user can move a cursor around on the computer screen with a mouse. By 

pointing the cursor at icons and clicking buttons on the mouse, the user can issue commands 

to the computer to perform an action, such as starting a program, accessing a data file, or 

copying a data file. Other commands can be reached through pull-down or click-on menu 

items. The computer displays the active area in which the user is working as a window on the 

computer screen. The currently active window may overlap 

with other previously active windows that remain open on the 

screen. This type of GUI is said to include WIMP features: 

windows, icons, menus, and pointing device (such as a mouse).  

 

GUI concept was invented in 1970s by scientist at Xerox 

Corporation, but this innovation was not an immediate 

commercial success. In 1983 Apple Computer featured a GUI in its 

Lisa computer. This GUI was updated and improved in its Macintosh computer, introduced in 

1984. 

 

Microsoft began its development of a GUI in 1983 as an extension of its MS-DOS operating 

system. Microsoft‘s Windows version 1.0 first appeared in 1985. In this version, the windows 

were tiled, or presented next to each other rather than overlapping. Windows version 2.0, 

introduced in 1987, was designed to resemble IBM‘s OS/2 Presentation Manager, another 

GUI operating system. Windows version 2.0 included the overlapping window feature. The 

more powerful version 3.0 of Windows, introduced in 1990, and subsequent versions 3.1 and 

3.11 rapidly made Windows the market leader in operating systems for personal computers, 

in part because it was prepackaged on new personal computers. It also became the favored 

platform for software development. 

 
 

Windows NT 

In 1993 Microsoft introduced Windows NT (New Technology). The Windows NT operating 

system offers 32-bit multitasking, which gives a computer the ability to run several programs 

simultaneously, or in parallel, at high speed. This operating system competes with IBM‘s 

Fig. 10.2: Windows GUI 
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OS/2 as a platform for the intensive, high-end, networked computing environments found in 

many businesses. 

 

Windows 95 

In 1995 Microsoft released a new version of Windows for personal computers called 

Windows 95. Windows 95 had a sleeker and simpler GUI than previous versions. It also 

offered 32-bit processing, efficient multitasking, network connections, and Internet access.  

 

In 1996 Microsoft debuted Windows CE, a scaled-down version of the Microsoft Windows 

platform designed for use with handheld personal computers. 

 
 

Windows 98 

Windows 98, a successor to Windows 95 was released to manufacturing on 15
th

 

May, 1998 and to the public exactly one month later. It was codenamed Memphis, 

and was an improved version of Windows 95. Like its predecessor, Windows 95, it 

is a hybrid and has a processing power of 16-bit/32-bit and compatible with MS-

DOS based boot loader. Windows 98 ended on July 11, 2006. 

 

 

Windows 2000 

Windows 2000, released on 17 February 2000, combined Windows NT technology with the 

Windows 98 graphical user interface. It was the successor to Windows NT 4.0, and is the 

final release of Microsoft Windows to display the "Windows NT" designation. 

 
 

Windows ME 

To grace the new millennium fully, Microsoft released a special edition of Windows known 

as Windows Millennium Edition (Windows Me) only a few months after Windows 2000, but 

Windows Me was not intended to be, nor did it serve as the replacement to Windows 2000. It 

rather provided a more stable version of the Windows 98 interface. Windows Me is designed 

for home use, while Windows 2000 is designed for business. 

 
 

Windows XP 

In 2001 Microsoft released a new operating system known as Windows eXPerience or 

Windows XP, the company‘s first operating system for consumers that was not based 

on MS-DOS. Windows XP, which is codename Whistler, is designed for both home 

and business use, and by this replaces both Windows 2000 and Windows ME. As 

of May, 2010 Windows XP is recorded to be the most widely used operating 

system with an approximate market share of 63.3%.  

 

Fig. 10.3: Windows 98 logo  

Fig. 10.4: Windows 

XP logo 
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Windows Vista 

On January 30, 2007, Microsoft released their much awaited Windows Vista 

worldwide, codename "Longhorn", and was made available for purchase and 

download from Microsoft's website. The release of Windows Vista came 

more than five years after the introduction of its predecessor, Windows XP, 

the longest time span between successive releases of Microsoft Windows 

desktop operating systems. Windows Vista is expressed in several variations 

developed for use on personal computers, including home and business 

desktops, laptops, tablet computers, and media center computers. 

Windows Vista contains many changes and new features, including an updated graphical user 

interface and visual style dubbed Aero, a redesigned search function, multimedia tools 

including Windows DVD Maker, and redesigned networking, audio, print, and display sub-

systems. Vista aims to increase the level of communication between machines on a home 

network, using peer-to-peer technology to simplify sharing files and media between 

computers and devices. 

 
 

Windows 7  

Less than three years after the release of Windows Vista, a new operating system, Windows 7 

was released to the general public on 22
nd

 October, 2009. Unlike its 

predecessor, Windows Vista, which introduced a large number of new features, 

Windows 7 was intended to be a more focused, incremental upgrade to the 

Windows line, with the goal of being compatible with applications and 

hardware with which Windows Vista is already compatible. 

The windows family of operating systems is ever increasing, and a new 

version with new and improved features will hit the market very soon. 

 
 

Macintosh Operating System (Mac OS) 

 

The Macintosh Operating system or Mac OS is the name for a series of operating systems 

developed by Apple Inc. (formerly Apple Computer, Inc.) for their Macintosh computer 

systems. Like Windows, Mac OS has an attractive graphical user interface. 

Apple‘s first operating system, simply referred to as System Software was 

released in 1984, and was later succeeded by Mac OS.  The early 

Macintosh operating system initially consisted of two pieces of software, 

called "System" and "Finder", each with its own version number.  

Like Windows, Macintosh operating system is a series of operating systems 

which have moved down the line from their introduction in 1984 to the 

present year. Mac OS was the first operating system to make use of Xerox 

Corporation‘s graphical user interface, with their Classic Mac OS in 1984.  

On 1999, Mac OS X, a new series of Apple‘s operating system was 

introduced to cut the long reign of Mac OS. Mac OS X is the successor to Mac OS 9, the final 

release of the "classic" Mac OS, which had been Apple's primary operating system since 

Fig. 10.5: Windows 

Vista package 

Fig. 10.6: Windows 7 logo  

Fig. 10.7: Mac OS logo  
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1984. The first version released was Mac OS X Server 1.0 in 1999, and a desktop-oriented 

version, Mac OS X v10.0 "Cheetah" followed on March 24, 2001. Releases of Mac OS X are 

named after big cats: for example, the newest version of Macintosh operating system X, Mac 

OS X v10.6 is usually referred to as "Snow Leopard".  

Apple also produces specialized versions of Mac OS X for use on four of its devices: the iOS 

for the iPhone, iPod Touch,  and iPad, as well as an unnamed version for the Apple TV 

 

UNIX 

UNIX is an  operating system originally developed in 1969 by a group of AT&T employees 

at Bell Labs for use on minicomputers. Today's Unix systems are split into various branches, 

developed over time by AT&T as well as various commercial vendors and non-profit 

organizations. In the early 1970s, many universities, research institutions, and companies 

began to expand on and improve UNIX. These efforts resulted in two main versions: BSD 

UNIX, a version developed at the University of California at Berkeley, and System V, 

developed by AT&T and its collaborators. 

Many companies developed and marketed their own versions of UNIX in subsequent years. 

Variations of UNIX include AIX, a version of UNIX adapted by IBM to run on RISC-based 

workstations; A/UX, a graphical version for the Apple Macintosh; XENIX OS, developed by 

Microsoft Corporation for 16-bit microprocessors; SunOS, adapted and distributed by Sun 

Microsystems, Inc.; Mach, a UNIX-compatible operating system for the NeXT computer; and 

Linux, developed by Finnish computer engineer Linus Torvalds with collaborators 

worldwide.  

UNIX operating systems are widely used in both servers and workstations. The UNIX 

environment and the client–server program model were essential elements in the 

development of the Internet and the reshaping of computing as centered in networks rather 

than in individual computers. 

 

Linux 

Linux, computer operating system using open source software. Linux is a UNIX-like 

operating system that is available as an alternative to commercial operating systems such as 

Windows, UNIX, or Macintosh OS. Because Linux is open source software, users have 

access to the source code and are allowed to use, modify, or redistribute the code.  

 

The original version of Linux was not developed as a commercial product. The 

Finnish software engineer Linus Torvalds wrote the first version of Linux. He 

released it to a public Internet forum in 1991. Other software engineers 

worldwide later on worked on developing it. With thousands of minds focused 

on improving the software, Linux rapidly became a fast, reliable, and 

widespread operating system. Linux continues to be free. 

 
 

Fig. 10.8: Linux logo  

http://en.wikipedia.org/wiki/Mac_OS_X_Server_1.0
http://en.wikipedia.org/wiki/Mac_OS_X_v10.0
http://en.wikipedia.org/wiki/Big_cat
http://en.wikipedia.org/wiki/Mac_OS_X_Snow_Leopard
http://en.wikipedia.org/wiki/IOS_(Apple)
http://en.wikipedia.org/wiki/IPhone
http://en.wikipedia.org/wiki/IPod_Touch
http://en.wikipedia.org/wiki/IPad
http://en.wikipedia.org/wiki/Apple_TV
http://en.wikipedia.org/wiki/Operating_system
http://en.wikipedia.org/wiki/American_Telephone_%26_Telegraph
http://en.wikipedia.org/wiki/Bell_Labs
http://en.wikipedia.org/wiki/Non-profit
http://en.wikipedia.org/wiki/Server_(computing)
http://en.wikipedia.org/wiki/Workstation
http://en.wikipedia.org/wiki/Client%E2%80%93server
http://en.wikipedia.org/wiki/Internet
http://en.wikipedia.org/wiki/Computer_networking


keyk 

 

 

84 

 
Software 

OS/2 

OS/2 is an operating system developed for the personal computer in the mid-1980s by 

International Business Machines Corporation (IBM) and Microsoft 

Corporation. The name stands for "Operating System/2," because it was 

introduced as part of the same generation change release as IBM's 

"Personal System/2 (PS/2)" line of second-generation personal 

computers. 

 

OS/2 is not as popular as other operating and is used only in a few 

sectors such as bank installations, especially Automated Teller Machines, 

run OS/2 with a customized user interface; Telecom companies such as 

Nortel use OS/2 in some voicemail systems. Nevertheless, OS/2 still 

maintains a small and dedicated community of followers.  

 

 

 

 

APPLICATION SOFTWARE 

 

Application software, also known as application is a computer program designed to help 

people perform an activity such as word processing, gaming etc. An application thus differs 

from an operating system. Depending on the activity for which it was 

designed, an application can manipulate text, numbers, graphics, or a 

combination of these elements. Some application packages offer 

considerable computing power by focusing on a single task, such as 

word processing; others, called integrated software, offer somewhat 

less power but include several applications.  

User-written software is software designed to meet the user's specific 

needs. User-written software include spreadsheet templates, word 

processor macros, scientific simulations, graphics and animation 

scripts. Even email filters are a kind of user software. The difference 

between system software such as operating systems and application 

software is not exact, however, and is occasionally the object of 

controversy. For example, one of the key questions in the United States v. Microsoft antitrust 

trial was whether Microsoft's Internet Explorer web browser was part of its Windows 

operating system or a separable piece of application software. 

 
 

Types of application software 

There are many types of application software: 

 

Fig. 10.9: OS/2 Warp logo  

Fig. 11.0: ATM running on OS/2  

Fig. 11.1: application software 

http://en.wikipedia.org/wiki/IBM_Personal_System/2
http://en.wikipedia.org/wiki/Personal_computer
http://en.wikipedia.org/wiki/Personal_computer
http://en.wikipedia.org/wiki/Personal_computer
http://en.wikipedia.org/wiki/Automated_Teller_Machine
http://en.wikipedia.org/wiki/Nortel
http://en.wikipedia.org/wiki/Computer_program
http://en.wikipedia.org/wiki/Integrated_software
http://en.wikipedia.org/wiki/End-user_development
http://en.wikipedia.org/wiki/Operating_system
http://en.wikipedia.org/wiki/United_States_v._Microsoft
http://en.wikipedia.org/wiki/Antitrust
http://en.wikipedia.org/wiki/Internet_Explorer
http://en.wikipedia.org/wiki/Web_browser
http://en.wikipedia.org/wiki/Microsoft_Windows
http://en.wikipedia.org/wiki/File:OS2_Warp_3.png
http://en.wikipedia.org/wiki/File:Atm_os2warp.jpg


keyk 

 

 

85 

 
Software 

Word processing software 

Also known as word processor, word processing software is a software used for the 

production (including composition, editing, formatting, and possibly printing) of any sort of 

printable material. 

Although features and design varied between manufacturers and models, with new features 

added as technology advanced, word processors for several years usually featured a 

monochrome (one colour) display and the ability to save documents on memory cards or 

diskettes. Later models introduced innovations such as spell-checking programs, increased 

formatting options, and dot-matrix printing 

Word processors are descended from early text formatting tools (sometimes called text 

justification tools, from their only real capability). Word processing was one of the earliest 

applications for the personal computer in office productivity. 

most modern word processors take advantage of a graphical user 

interface providing some form of What You See Is What You Get 

(WYSIWYG) editing Depending on the program and the equipment in 

use, word processors can display documents either in text mode, using 

highlighting, underlining, or color to represent italics, boldfacing, and 

other such formatting, or in graphics mode, wherein formatting and, 

sometimes, a variety of fonts appear on the screen as they will on the 

printed page. All word processors offer at least limited facilities for 

document formatting, such as font changes, page layout, paragraph 

indention, and the like. Some word processors can also check spelling, find synonyms, 

incorporate graphics created with another program, correctly align mathematical formulas, 

create and print form letters, perform calculations, display documents in multiple on-screen 

windows, and enable users to record macros that simplify difficult or repetitive operations 

Microsoft Word is the most widely used word processing software. Microsoft estimates that 

over 500,000,000 people use the Microsoft Office suite, which includes Word. Many other 

word processing applications exist, including WordPerfect, OpenOffice.org Writer, 

AbiWord, KWord, LyX and web-based word processors, such as Google Docs. 

 

Spreadsheet software 

A spreadsheet is a computer application that simulates a paper, accounting worksheet. In a 

spreadsheet program, data and formulas to calculate those data are entered into ledger-like 

forms (spreadsheets or worksheets) for analysis, tracking, planning, or “what-if” evaluations 

of the impacts of real or proposed changes on an economic strategy. It is commonly used for 

budgets, forecasting, and other finance-related tasks. Spreadsheets are frequently used for 

financial information because of their ability to re-calculate the entire sheet automatically 

after a change to a single cell is made.  

Fig. 11.2: Word processor 
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It displays multiple grids of rows and columns called cells, with each cell containing 

alphanumeric text, numeric values or formulas. Depending on the program, a single 

spreadsheet can contain anywhere from thousands to millions of 

cells. Some spreadsheet programs can also link one spreadsheet to 

another that contains related information, and can update data in 

linked spreadsheets automatically. Spreadsheet programs may also 

include macro facilities, and some can be used for creating and 

sorting databases. For printed output, spreadsheet programs usually 

provide graphing capabilities and a variety of formatting options for 

both printed pages and text, numeric values, and captions and 

legends in graphs. 

 To ease computation, these programs include built-in functions that 

perform standard calculations. A formula defines how the content of that cell is to be 

calculated from the contents of any other cell (or combination of cells) each time any cell is 

updated.  

Visicalc is usually considered the first electronic spreadsheet (although this has been 

challenged), and it helped turn the App e II computer into a success and greatly assisted in 

their widespread application. Lotus 1-2-3 was the leading spreadsheet when DOS was the 

dominant operating system. Microsoft Excel now has the largest market share on the 

Windows and Macintosh platforms. 

 

Database software (database management system) 

A database consists of an organized collection of data stored in a computer memory and 

designed for easy access by authorized users. Since their first, experimental 

appearance in the 1950s, databases have become so important in industrial 

societies that they can be found in almost every field of information. 

Government, military, and industrial databases are often highly restricted, 

and professional databases are usually of limited interest. A wide range of 

commercial, governmental, and nonprofit databases are available to the 

general public, however, and may be used by anyone who owns or has access 

to the equipment that they require.   

One way of classifying databases involves the type of their contents, for 

example: students‘ information, document-text, statistical. Digital databases are managed 

using database management systems (DBMS), which store database contents, allowing data 

creation and maintenance, and search and other access. A database management system 

(DBMS) consists of software that operates databases, providing storage, access, security, 

backup and other facilities. Database management systems can be categorized according to 

the database model that they support, such as relational or XML, the type(s) of computer they 

support, such as a server cluster or a mobile phone, the query language(s) that access the 

database, such as SQL or XQuery, performance trade-offs, such as maximum scale or 

Fig. 11.3: spreadsheet icon 

Fig. 11.4: DBMS icon 
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maximum speed or others. Some DBMS cover more than one entry in these categories, e.g., 

supporting multiple query languages. Examples of database management systems are 

Microsoft Access, Lotus, etc. 

 

Presentation software 

Presentation is the practice of showing and explaining the content of a topic to an audience 

or learner. It has become increasingly common for teachers and employers to 

ask their students or employees to give presentations on some selected topic. 

The purpose of these presentations is to demonstrate the students‘ or 

employees ability in handling him or herself and their knowledge in the 

selected topics. Presentation software have features which assist in planning 

and delivering presentations.   

Presentation software is a software package used to display 

information, normally in the form of a slide show. It typically includes three major functions: 

an editor that allows text to be inserted and formatted, a method for inserting and 

manipulating graphic images and a slide-show system to display the content. 

A presentation program is supposed to help both: the speaker with an easier access to his 

ideas and the participants with visual information which complements the talk. There are 

many different types of presentations including professional (work-related), education, 

entertainment, and for general communication. Presentation programs can either supplement 

or replace the use of older visual aid technology, such as Pamphlets, handouts, chalkboards, 

flip charts, posters, slides and overhead transparencies. Text, graphics, movies, and other 

objects are positioned on individual pages or "slides" or "foils". Slides can be printed, or 

(more usually) displayed on-screen and navigated through at the 

command of the presenter. Transitions between slides can be animated in 

a variety of ways, as can the emergence of elements on a slide itself. 

Typically a presentation has many constraints and the most important 

being the limited time to present consistent information. 

Many presentation programs come with pre-designed images (clip art) 

and/or have the ability to import graphic images. Custom graphics can 

also be created.   

With the growth of digital photography and video, many programs that handle these types of 

media also include presentation functions for displaying them in a similar "slide show" 

format. For example, Apple's iPhoto allows groups of digital photos to be displayed in a slide 

show with options such as selecting transitions, choosing whether or not the show stops at the 

end or continues to loop, and including music to accompany the photos. 

Certain presentation programs also offer an interactive integrated hardware element designed 

to engage an audience (e.g. audience response systems) or facilitate presentations across 

Fig. 11.5: presentation logo 

Fig. 11.6: PowerPoint logo 
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different geographical locations (e.g. web conferencing). Other integrated hardware devices 

ease the job of a live presenter such as laser pointers and interactive whiteboards. 

Some common presentation software includes Microsoft PowerPoint (the leading 

presentation software), Apple Keynote, Slide Effect and Open Office Impress. 

 

Educational software 

Educational software is a software, the primary purpose of which is teaching or facilitate self-

learning.  

An immense number of educational software has been developed and 

released since the mid-1990‘s onwards, aimed primarily at the home 

education of younger children. The design of educational software for 

home use has been influenced strongly by computer gaming concepts – 

in other words, they are designed to be fun as well as educational. 

Hence the term edutainment. In a broader sense, the term 

edutainment describes an intentional merger of computer 

games and educational software into a single suite. In the narrower sense used here, the term 

describes educational software which is primarily about entertainment, but tends to educate 

as well and sells itself partly under the educational umbrella. Software of this kind is not 

structured towards school curricula, does not normally involve educational advisors, and does 

not focus on core skills such as literacy and numeracy. 

Educational software is not only limited to homes, but are integrated to the academic 

curricula. Such software is called courseware.  Courseware is a term that combines the words 

'course' with 'software'. Its meaning originally was used to describe additional educational 

material intended as kits for teachers or trainers or as tutorials for students, usually packaged 

for use with a computer. The term's meaning and usage has expanded and can refer to the 

entire course and any additional material when used in reference an online or 'computer 

formatted' classroom.  

A further category of educational software is software designed for use in 

school classrooms. Typically such software may be projected onto a large 

whiteboard at the front of the class and/or run simultaneously on a 

network of desktop computers in a classroom. This type of software is 

often called classroom management software.  

Many publishers of print dictionaries and encyclopedias have been 

involved in the production of educational reference software. The first 

commercial reference software products were reformulations of 

existing content into CD-ROM editions, often supplemented with new 

multimedia content, including compressed video and sound. Now, some software like 

Microsoft Encarta and Encyclopedia Britannica help make researching for information 

pleasant. More recent products, such as Wikipedia, made use of internet technologies, to 

Fig. 11.7: MindTwister Math 

Fig. 11.8: Microsoft Encarta 
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supplement CD-ROM products, then, more recently, to replace them entirely. Other software, 

such as Mavis Beacon and Typing Tutor aims at teaching people how to use the computer. 

 

Graphics software 

Graphics software or image editing software is a program or collection of programs that 

enable a person to manipulate visual images on a computer. Computer graphics can be 

classified into two distinct types: raster graphics and vector graphics. 

Before learning about computer software that manipulates or displays 

these graphics types, you should be familiar with both.   

Many graphics programs focus exclusively on either vector or raster 

graphics, but there are a few that combine them in interesting and 

sometimes unexpected ways. It is simple to convert from vector 

graphics to raster graphics, but going the other way is harder. Some 

software attempts to do this. Most graphics programs have the ability to 

import and export one or more graphics file formats 

The use of a swatch is a palette of active colours that are selected and rearranged by the 

preference of the user. A swatch may be used in a program or be part of the universal palette 

on an operating system, it is used to change the colour of a project that may be text, image or 

video editing. Some popular graphics software include Adobe Photoshop and Corel Draw. 

 

Browsers  

Browser is a program that enables a computer to locate, download, and display documents 

containing text, sound, video, graphics, animation, and photographs located on computer 

networks. The act of viewing and moving about between documents on computer networks is 

called browsing. Users browse through documents on open, public-

access networks called internets, or on closed networks called 

intranets. The largest open network is the Internet, a worldwide 

computer network that provides access to sites on the World Wide 

Web (WWW or simply, the Web).   

Browsers allow users to access Web information by locating 

documents on remote computers that function as Web servers. A 

browser downloads information over phone lines to a user‘s computer through the user‘s 

modem and then displays the information on the computer. Most browsers can display a 

variety of text and graphics that may be integrated into such a document, including 

animation, audio and video. Examples of browsers are Netscape, Internet Explorer, and 

Mosaic. 

Fig. 11.9: Corel Draw X4 
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Browsers can create the illusion of traveling to an actual location in virtual space 

(hyperspace) where the document being viewed exists. This virtual location in hyperspace is 

referred to as a node, or a Web site. The process of virtual travel between Web sites is called 

navigating. 

Common features found in browsers include the ability to automatically designate a Web site 

to which the browser opens with each use, the option to create directories of favorite or useful 

Web sites, access to search engines (programs that permit the use of key words to locate 

information on the Internet, an internet or an intranet), and the ability to screen out certain 

types of information by blocking access to certain categories of sites. 

A browser‘s performance depends upon the speed and efficiency of the user‘s computer, the 

type of modem being used, and the bandwidth of the data-

transmission medium (the amount of information that can be 

transmitted per second). Low bandwidth results in slow movement 

of data between source and recipient, leading to longer transmission 

times for documents. Browsers may also have difficulty reaching a 

site during times of heavy traffic on the network or because of high 

use of the site.   

The most commonly used browsers for the Web such as Internet 

Explorer, Mozilla Firefox, Opera, Google Chrome and Safari are available for free or for a 

small charge and can be downloaded from the Internet. Browsers have become one of the 

most important tools—ranking with e-mail—for computer network users. They have 

provided tens of millions of people with a gateway to information and communication 

through the Internet. 

 

Authoring software 

Authoring software is an application development system designed primarily for creating 

programs, web pages, databases, and materials for computer-aided instruction. Authoring 

software is very technical, and like all technical software, a lot goes into it creation and 

usage. Common authoring software includes Microsoft FrontPage and Acrobat Dream 

Weaver.  

 
 

Desktop publisher 

Desktop Publishing is the use of a computer and specialized software to combine text and 

graphics to create a document that can be printed. Desktop publishing 

is a multiple-step process involving various types of software and 

equipment. The original text and illustrations are generally produced 

with software such as word processors and drawing and painting 

programs and with photograph-scanning equipment and digitizers. 

The finished product is then transferred to a page-makeup program, 

Fig. 12.0: Safari logo 

Fig. 12.1: Desktop Publishing 
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which is the software most people think of as the actual desktop-publishing software. This 

type of program enables the user to lay out text and graphics on the screen and see what the 

results will be; for refining parts of the document, these programs often include word-

processing and graphics features in addition to layout capabilities. As a final step, the finished 

document is printed either on a laser printer or, for the best quality, by typesetting equipment. 

Examples of desktop publishers are Microsoft Publisher and Adobe Page Maker.  

 
 

Games 

It is hard to talk of computer programs without talking of games. Games are a popular 

pastime for both children and adults. Categories include strategy games, 

sports games, adventure and exploration games, card and board games, 

puzzle games, fast-action arcade games, and flying simulations. Some 

software programs employ game-play elements to teach reading, 

writing, problem solving, and other basic skills. In computer games, 

players can use a keyboard to type in commands, a mouse to move a 

cursor around the screen, or sometimes both. Many computer games 

also allow the use of a joystick or game controller.   

 

 
 

DIFFERENCES BETWEEN OPEN SOURCE AND PROPRIETARY SOFTWARE 

Open Source Software is a type of software in which the original source code (the type of 

programming language and the method used) is openly available for users to examine and 

modify, and to use to run or to create computer programs. One of the best-known examples of 

open source software is Linux, which is widely used as an alternative to commercial 

operating system (OS). Open source software includes a license to use, modify, and 

redistribute the code. Commercially sold software products can be developed from open 

source software.  

Open source software is considered distinct from free software, which is also open source but 

can be used for any purpose and without any costs or restrictions. Both open source software 

and free software are different from software provided for free (freeware) by commercial 

software manufacturers that do not allow access to the original source code.  

A central features of open source software is that users can review the software, add features 

to it or hire programmers to add features, or fix errors known as 

bugs, rather than wait for the original software publisher or creator 

to bring out a new version. With open source software, 

programmers—many of them nonprofessionals—contribute to the 

computing community by making their improvements and bug fixes 

available to other users.  

Fig. 12.3: open source logo 
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This type of peer review is open to community input, standards, and verification, and is 

thought to lead to more reliable software. It is also thought to speed up the software 

development process. In some cases, the peer review may be uninfluenced by deadlines or 

other commercial concerns. However, as open source software development has evolved, 

companies such as the International Business Machines Corporation (IBM), Sun 

Microsystems, Inc., Microsoft Corporation, Apple Inc., and others have offered an increasing 

number of open source products. 

Growing segments of both government and business have adopted some open source 

software such as Linux. Other commonly used open source products include the Apache open 

source program for Web servers and the Web browser Mozilla Firefox. OpenOffice offers 

open source applications similar to commercial products such as Microsoft Office. 

Potential drawbacks to using open source software include incompatibility with different 

applications or devices run with commercial software platforms such as Microsoft‘s 

Windows or Apple‘s Mac OS. Security features included in commercial software may also 

block some open source software. Similarly, open source software may lack security features, 

making it vulnerable to hacking or infection with harmful software such as computer viruses. 

Finding help in solving problems that occur with open source software may require much 

more effort, particularly if the user is not an expert with computer code. 

 

Proprietary software 

At the opposite end of open source software is proprietary software. Proprietary software is 

software licensed and sold under legal right of its owner. That 

is even though the owners sell the software, they still have right 

to it. The buyer, or licensee, is given the right to use the 

software under certain conditions, but restricted from other 

uses, such as modification, further distribution, or reverse 

engineering (remember all these can be done with open source 

software).   

Restrictions on proprietary software are enforced by either 

legal or technical means, or both. The most common form of 

technical restriction is by releasing "closed-source" programs that are only computer-readable 

(for example, in binary format), and withholding the human-readable source code. Legal 

means of enforcement include copyright (possibly with a restrictive software license) and 

patents. The source code of such programs is usually regarded as a trade secret by the owner. 

Access to source code by third parties commonly requires the party to sign a special 

agreement known as a non-disclosure agreement (NDA). Use of software is enforced by 

contract law. 

Exclusive legal rights to software by a proprietor are not required for software to be  

Fig. 12.4 proprietary software logo 
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Semi-free software, as defined by the Free Software Foundation, is software that is not free 

software, but comes with permission for individuals to use, copy, distribute, and modify 

either for non-profit purposes only or with the prohibition to redistribute modified copies or 

derived works. Such software is also rejected by the Open Source Initiative and Debian. PGP 

and Angband are examples of semi-free programs. The Free Software Foundation classifies 

semi-free software as non-free software, but draws a distinction between semi-free software 

and proprietary software. 

Free software licenses use the same laws used by proprietary software, but to preserve the 

rights to use, copy and modify the software. This technique is used with copyleft, but with 

other software as well. Free software companies and projects are also joining into patent 

pools like the Patent Commons and the Open Invention Network. See software patents and 

free software. 

Well known examples of proprietary software include Microsoft Windows, Adobe Flash 

Player, PS3 OS, iTunes, Adobe Photoshop, Google Earth, Mac OS X, Skype, WinZip, and 

some versions of Unix. 

 

LAUNCHING APPLICATION SOFTWARE 

 

Alright, so much for the theory stuff. Now let us jump start the real stuff by launching some 

applications. To launch an application is to start or execute it and use it features. But, before 

you can launch a program it must be installed on your computer system. To install a program 

is to go through its setup process in order to fix it and all the files and folders accompanying 

it onto the hard disk. There are many ways of launching a program in Windows XP.  

1. By using the start menu 

2. By using the desktop icons 

3. The fourth method which is not common to all programs is the use of the quick 

launch button on the task bar. 

4. Using the system tray (also not common to all programs) 

 

Let us try and launch the most popular word processor in the world, Microsoft Word using all 

the methods above. 

 

Launching Microsoft Office Word 

 
 

1.  using the star menu 

There are three basic was of launching a program using the start menu. 

i. By using the all programs menu 

ii. By using the frequently used programs menu 

iii. By using the recently used documents  
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i. using the all programs menu 

 Click the (start) button. This displays the start menu. 

 Point on all programs. (shows all the programs installed on the computer) 

 

 

 

 

 

 

 Point on Microsoft Office (the arrow indicates that it is a folder and there are files within) 

 Click on Microsoft Office Word (2003, 2007, 2010 etc. (the program loads and a blank 

document opens). There you are! Congratulations! 

 

 

 

 

 

 

 

 

ii. Using the frequently used programs menu 

Windows automatically put the programs used most in a special folder. To launch Microsoft 

Office through that: 

 Click on the start button. 

 Click on Microsoft Office Word. (The program loads and opens a document blank 

opens). Voila. 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: the program is only added to the frequently used program menu if it is used 

continuously.  
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iii. Using the recent documents  

 

 Click the start button.  

 Click on My Recent Documents. A drop-down menu appears with the programs used 

recently. 

 

 

 

 

 

 

 

 

 

 

 Click on the name you assigned to the Microsoft Word document created when you 

last launched it. (The program loads and opens the document you created under that 

name). 

 

 

2. Using the desktop icons 

When a program is installed, a picture representation of that program (called an icon) is 

automatically placed on the screen (desktop). The icon is known as a shortcut.  

To launch Microsoft Office Word using the desktop icon,  

i. Double-click (click in quick succession) on its icon the desktop.  

Or 

ii. Right-click (click the right mouse button) on the icon. 

iii. Click open. (The program loads and opens a blank document).  

 

 

 

 

 

 

 

 

 
3. Using the quick launch toolbar 

The quick launch buttons are the tiny icons found on the left hand corner of the taskbar next 

to the start button. Let us launch Internet Explorer using the quick launch toolbar. 
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 Locate the Internet Explorer icon on the Quick Launch toolbar at left-hand corner of 

the taskbar and click on it. 

 

 

 
 

4. Using the system tray  

The right-hand side of the taskbar is called a system tray. There are other small icons 

representing some programs which start when Windows starts. To launch any of those 

programs, just double-click that icon  
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TEST YOURSELF 

1. Discuss the various types of software packages. 

2. Briefly describe five known operating systems. 

3. What is application software? 

4. Identify five types of application software. 

5. Discuss the differences between open source and proprietary software. 

6. Describe how you will launch an application using: 

a. The All Programs menu 

b. The frequently used programs menu. 

c. The Recently Used Documents folder. 

d. Desktop shortcut.  
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After completing this chapter, you should be able to: 

 

vi. Type 30 – 35 words per minute. 

vii. Use mouse skills in document creation 

viii. Use the numeric keypad. 

 

 
OBJECTIVES 

 

 

 

 

 

 

 

 

 
 

Chapter
 5 

KEYBOARDING AND MOUSE  

SKILLS REVIEW 

 

 

INTRODUCTION  

 

One of the most interesting and yet for some people, difficult things, especially for beginners 

in computing is the use of the keyboard. The keyboard as we discussed earlier is the most 

important input device, and as such can do some of the tasks of other input devices. The 

primary job of the keyboard is entering text data into the computer. Knowing how to use the 

keyboard to enter text data quickly is a plus to all computer users. While some people can 

type from forty to fifty words per minute, others spend a lot of valuable time trying to figure 

out exactly where the individual keys are located on the keyboard before they hit on it. but 

with constant practice they can improve their typing speed. Let us consider how we can 

improve our typing speed. 
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IMPROVING TYPING SPEED 

 

When typing your fingers rest on the middle row of the keyboard – known as home row. The 

home row is the point from which all the other keys can be reached.  

 

 Place your fingers on the home row. 

 Put your left hand fingers on keys A, S, D, F. (ignore the thumb) 

 Put your right hand fingers on keys J, K, L, ; 

 Now, let the thumb rest on the space bar. 

 Keep your wrists straight and your fingers curled. 

 

 

 

 

 

 

 

 

 

 

 

 Make sure that your fingers are on their home run keys. 

 Move your left index finger from F upwards to T. your hand may move slightly to 

make it easier t reach. 

 Click T and return the finger back to it home run key. 

 

The diagram below shows the various keys that the fingers will reach from their home row 

keys. Try the individual moves on your keyboard.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 12.5 the home row 

Fig. 12.6: keys to reach from the home row 
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There are some programs such as Mavis Beacon, Professor PC Typing Tutor and Typing 

Master which are ready to make a better typist out of any diligent computer user. Let us see 

how these programs can assist in speeding up our typing speed. 

 
 

Professor PC Tying Tutor 

Supposing it is installed on your computer, launch it as we did Microsoft Office Word in the 

previous chapter.  

When you launch it will load and open a page and ask you to register.  

 

1. Type your Student Name and Password and click on “New Student” 

 

 

 

 

 

 

 

 

 

2. Click on FIRST LESSON.  

 

 

 

 

 

 

 

 

 

 

3. Click on Beginning - [a,s,d,f]  

 

 

 

 

 

 

 

 

 

 

4. That takes you to the main lesson area.  

 

5. Click the start Button               and follow the instructions promptly. 
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You can download the free trial version of Professor PC Typing Tutor at typing-tutor.com. 

 
 

USING MOUSE SKILLS IN DOCUMENTS 

 

The next most important input device is the mouse. Most people got their first touch to the 

computer by holding the mouse. Holding and using the mouse correctly will not only help 

you work faster, but will also prevent mouse related strains to your body. To start with, let us 

know the various mouse buttons. 

 

The button at the left-hand side is known as the 

left mouse button. It is the most used and thus, 

the most important button on the mouse. 

To the right-hand side is a button known as the 

right mouse button. 

 

Now let us learn how to handle the mouse. The 

mouse is designed to be small enough to fit into 

the hand. When you hold the mouse: 

 Put the heel of your hand on the table. 

 Hold the mouse between thumb and the ring fingers. 

 Put your index finger on the left mouse button.  

 With the base of the mouse touching the table or mouse 

pad, move the  mouse gently around. What happens? YES, 

the small arrow on the screen moves in the same direction. 

The small arrow is known as mouse pointer. 

Let us try some of the frequent mouse actions. 

 

Clicking 

The act of pressing and releasing the left mouse button is 

term clicking. Sometime it is referred to as single-clicking. 

Fig. 12.7: the mouse buttons 

Fig. 12.8: how to hold the mouse 
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Let us click some of the icons on the desktop. 

 Move the mouse pointer to the My Computer icon on the desktop. 

 Click it (i.e. press the left mouse button). 

 What happens? That is right. The My computer icon is highlighted. That action is 

called selection. 

 Click anywhere on the desktop to deselect the My Computer icon. 

 

Double-clicking 

The act of pressing the left mouse button twice in quick succession is known as double-

clicking. Let us try that. 

 

 Move the mouse pointer to the My Documents icon on the desktop. 

 Double click it (i.e. click it twice quickly). 

 What happens? The My Document folder opens to display it contents. This means that 

we double-click to open folders. 

 Close the My Document folder by clicking on the X sign located at the top right hand 

corner of the window. 

 Back to the desktop, double click on the Internet Explorer icon. 

 It opens, right? Good. That means double-clicking also opens or launches programs. 

 
 

Right-clicking 

Pressing and releasing the right mouse button is referred to as right-clicking. This is different 

from clicking. 

 

Now let us do some right-clicking. 

 

 Right-click anywhere on the desktop. A menu pops out. Click out. 

 Right-click on the My Computer icon. Another menu pops out.  

Right clicking displays further options about a folder or icon. 

 
 

Dragging  

Dragging is the act of holding down the left mouse button and moving the pointer on the 

screen. If the mouse pointer is on top of an object at the time the mouse button is pressed, 

dragging the mouse can also move the object. In other circumstances, dragging the mouse can 

select blocks of text, move icons on a desktop, resize a window, and so on. 

 

Let us drag some items around. 

 

 Click on the Recycle Bin icon on the desktop. 

 With your finger still on the left mouse button, slide it to a different position.  



rkeyk 

 

 

103 

 
Keyboarding and Mouse Skills Review 

 What happens? The Recycle Bin icon moves to a new location. 

 Open the Recycle Bin.  

 Point to the title bar (i.e. the bar at the top of the window which displays the folders 

name).  

 Drag it around. Lovely isn‘t it? 

 
 

USING THE NUMERIC KEYPAD 

 

The numeric keypad is located at the right hand side of the keyboard. It contains only 

numbers, mathematical symbols for addition, subtraction, multiplication, and division, a 

decimal point, and several function keys (e.g. End, Delete, etc.). They are often used to 

facilitate data entry with smaller keyboard-equipped laptops or with smaller keyboards that 

do not have a numeric keypad. A laptop does sometimes have a numeric pad, but not all the 

time. The numeric keypad consists of the following types of 

keys: 

 arithmetic operators such as +, -, *, /  

 numeric digits 0-9  

 cursor arrow keys  

 navigation keys such as Home, End, PgUp, PgDown, etc.  

 Num Lock button, used to enable or disable the numeric pad  

The primary importance of the numeric keypad is, it helps in 

entering numeric data quickly. Knowing how to use the 

keyboard fully including the use of the numeric keypad will save 

you more time. 

 
 

 

Let us go back to Professor PC – Typing Tutor. 

 

This time round after logging in select, and start the tutorials with the 

professor.  

 

 

 

You can still learn typing if you have not downloaded the free-trial version of Professor PC –

Typing Tutor yet, and do not have any typing tutor. Just follow the drills at the latter part of 

the book. It is tedious and not as interesting as computer based tutors, but it better than none. 

 

 

 

Fig. 12.9: numeric keypad 
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After completing this chapter, you should be able to: 

 

i. Identify Word Processing packages. 

ii. State the importance and use of Word Processing 

iii. Create a document using the Word Processor. 

iv. Save a document using the Save command. 

 

 
OBJECTIVES 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chapter
 6 

 

WORD PROCESSING 

 

 

INTRODUCTION  

 

During the bygone era, when computers were not or little head of, people had to go through a 

lot of hard labour to create a simple document. Type writer came to ease up the pressure a 

little, but did not give much room to one indispensable attribute of humans, mistakes. If you 

make an error getting to the end of a lengthy document, you will be left with no option but to 

start all over again. 

The dawn of computers brought with it some kind of panacea for creating voluminous 

documents easily and almost stress-free. The panacea is word processors. Word processors, 

as we discussed under Software, are programs that are used to produce all sorts of documents. 
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WORD PROCESSING PACKAGES 

 

There is countless number of word processing packages or word processors on the market, all 

committed to helping computer users create documents effectively. Not only do word 

processing packages help in document creation, but they also enable the user to add graphics 

to their work and select the type of colours and fonts they want for their works.  

Word processing packages, though, relatively easy to use, yet some require a great deal of 

know how before thy can be used effectively. Let us consider some of the popular word 

processing packages available. 

 
 

Microsoft Word 

Microsoft Word is a word processor designed by Microsoft. It is sold separately and as part 

of Microsoft Office, an integrated software suite. It was first released in 1983 under the name 

Multi-Tool Word for Xenix computer systems. Subsequent versions were later written for 

several other platforms including IBM PCs running DOS (1983), the Apple Macintosh 

(1984), the AT&T Unix PC (1985), Atari ST (1986), SCO UNIX, OS/2, 

and Microsoft Windows (1989).   

 

Microsoft Word is the most popular word processor in the world, and is 

the preferred choice for creating, designing and typing books, memos, 

letters, resumes etc. Microsoft Word has some features of a graphics 

program as well as desktop publishing program, so it can also be used 

for carrying out some graphics and some desktop publishing-related 

jobs such as poster designing, flyers and what have you.  

 

Writer  

OpenOffice.org Writer is the word processor component of the OpenOffice.org software 

package. Writer is a word processor similar to Microsoft Word and Corel's WordPerfect, with 

some of their features. Writer can be used across a variety of platforms, including Mac OS X, 

Microsoft Windows, Linux, FreeBSD, Irix and Solaris. Writer is free software.  

Writer provides a number of features not present in Word out of the box, including a word 

completion mechanism for predictive writing that is not available in Microsoft Word as of 

September, 2009. It has ability to export to the PDF format natively (also available in 

Microsoft Office 2010 and in Microsoft Word 2007 via a free download).   

Grammar checking requires the installation of an extension. Document templates are also 

available as extensions for OpenOffice.org. Writer can do most of the tasks that Microsoft 

Word can do. An added benefit of Writer shows when saving work, the program has the 

ability to save documents in Microsoft Word format.  

 

Fig. 13.0: Microsoft Word logo 
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WordPad 

WordPad is a basic word processor that is included with almost all versions 

of Microsoft Windows from Windows 95 upwards. WordPad can format and 

print text, but lacks intermediate features such as a spell checker, thesaurus, 

and support for tables. As such, it is suitable for writing letters or short 

pieces, but underpowered for work that relies heavily on graphics or longer 

works such as books. It can open Microsoft Word files, although it opens 

newer versions of the .DOC format with incorrect formatting.  

 

Text editor 

Text editor is a type of program used for making changes to plain text files. Text editors 

accompany operating systems or software development packages. Some text editors are small 

and simple, while others offer a broad and complex range of functionality.  

Text editors made for professional computer users place no limit on the size of the file being 

opened; they rather start quickly even when editing large files, and are capable of editing files 

that are too large to fit the computer's main memory. Simpler text editors often just read files 

into an array in RAM. On larger files this is a slow process, and very large files often do not 

fit. 

 

Corel WordPerfect 

One of the founders of word processing software is Corel, and its 

WordPerfect suite contains several features essential for word processing for 

business and home users. WordPerfect's word processor allows users to save 

documents in a Microsoft Word format and to import Word documents.  

 
 

IMPORTANCE OF WORD PROCESSING 

Word processors are some of the most used applications in the world. There are a vast range 

of uses for word processing software. They are chiefly used in businesses to create all sorts of 

documents such as memos, letterheads, legal documents and agreements, reference materials, 

letters, reports writing and pay slips. Word processors are the backbone of  some businesses 

such as  the book and news paper production outfits. 

Schools aim at training their students to fit into the world market, and what is the best way to 

do this, teaching them how to use the software that the businesses use most? For this reason 

schools and colleges use word processor to teach their students. Not only that, word 

processors are also used to produce some academic materials such as books, pamphlets, 

handouts, notices and students reports.   

Fig. 13.1: WordPad icon 

Fig. 13.2: WordPerfect logo 
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The uses of word processors are not limited to schools and businesses but are also used 

extensively at home. People, (i.e. students, teachers or business executive) spend most of 

their time a home. So if they have to produce any document at all, guess where they do start 

it. Yes, home. Many people even sleep with their computers just to be able to produce some 

documents.  

Word processors are most of the time used as substitute for graphics software, and are, 

therefore used to design posters, flyers and packages designs. These products are normally 

pasted or given out in public places such as bus terminals and railway stations.  

 

 

 

 

 

 

CREATING DOCUMENT USING A WORD PROCESSOR 

Now that you know the important of word processor, I know that you really want to get your 

hands to it. We will use Microsoft Word to create some documents, but before that let us get 

to know it better. First follow the steps below to launch Microsoft Word 2007: 

 Click on the start button. 

 Point to all programs. 

 Point to Microsoft Office. 

 Click on Microsoft Office Word 2007. Waite for it to load. 

 

Let us examine the features of Microsoft Office Word 2007. 

 

Features of Microsoft Word 2007 

This is how a blank Microsoft Word 2007 document looks like. The features have been 

labeled to help you know them better. 

 

 

 

GROUP DISCUSSION 

Teacher to guide students to discuss 

and come out with the importance of 

Word processing 
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Office Button menu  

Earlier versions of Word had various menus (such as File, Edit, View, and Format) in the 

menu bar. Word 2007 has only the Office Button menu. This menu contains some of the 

commands that used to appear on the File menu in earlier versions of Word. You can open 

this menu by clicking it or by pressing ALT and then F (ALT, F). 

 
Quick Access Toolbar  

The Quick Access Toolbar is a toolbar that provides quick access to the commands 

represented by the buttons you put on it. When you first start Word, the Quick Access 

Toolbar appears in its small version

 
Title bar  

The title bar shows the document‘s name and the program‘s name. When you‘ve just opened 

Word, and the document‘s name is Document1, this information is not much help. But when 

you‘ve got many documents open, the name helps you distinguish one document from 

Fig. 13.3: Word 2007 Window 
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another or one version of the same document from another. Word uses a separate window for 

each document you open, rather than opening each document as a smaller window within the 

main program window (as some other programs do). 

 
Minimize button, Maximize/Restore Down button, and Close button  

Use these buttons to resize or close the window. These buttons are standard on most 

Windows programs, so you‘re probably used to the way they work: Click the Minimize 

button to reduce the window to a button on the taskbar, click the Maximize/Restore Down 

button to flip between a maximized window and a ―normal‖ (non-maximized) one, and click 

the Close button to close the window. 

 
 

 Status bar This bar across the bottom of the window provides a page readout, spell-check 

status, and other information about the document. Word displays different information on the 

status bar depending on what you‘re doing. 

 
 

View buttons Click a button to change the view—for example, from Print Layout view 

(which shows each page approximately as it will print) to Outline view (which shows the 

document as an outline of different heading levels). You‘ll learn more about views toward the 

end of this chapter.

 
 

Zoom controls The readout at the left end of the zoom controls shows the current zoom 

percentage. You can zoom by dragging the slider or by clicking the – (minus) and + (plus) 

buttons. 

 
Insertion point A slowly blinking thin vertical line, the insertion point marks the point at 

which characters you type will land in the document. 

 
Document area This area is where you create your document. The insertion point indicates 

where text you type will appear in the document. 

 
View buttons These buttons let you change quickly from one of Word‘s five main views to 

another. 

 
Help Button Click this button to display the Help window, in which you can search for help 

on any Word topic. 

NOTE: the features above are quite different from the features of the previous Microsoft 

Word. 

 

Our next step is getting to know the frequently used keys on the keyboard for word 

processors and what they do. 
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Frequently used keys What they do 

ENTER Moves the insertion point to the beginning of the next line 

SPACE BAR Deletes characters before the insertion point 

BACK SPACE Spaces up text by one step 

DELETE Deletes characters after the insertion point 

TAB Moves the insertion point several spaces to the right, for 

creating indent 

CAPS LOCK Turns letters to either upper-case or lower case 

ALPHA-NUMERIC KEYS  Presents the pressed character to the document 

 
 

Let us create our first Microsoft Word document, a letter to your ICT teacher, thanking him 

for helping you know ICT.  

 

Follow the steps below. 

 

i. Press the TAB key seven times to create an indent for your address. Always press 

the ENTER key to move to a new line. The inserting point returns to the 

beginning of every new line. Use the TAB key to create the indent.  

Refer to the example below. 

 

ii. Type your teacher‘s address. (ENTER twice)  

 

iii. Type the salutation (ENTER) 

 

iv. Press TAB to create an indent; press CAPS to capitalize the next characters. 

 

v. Type the title of the letter. in CAPS, please (ENTER) 

 

vi. Type the body of the letter. (ENTER) 

 

vii. Press TAB to create indent for the subscription. WELL DONE! 

   

Your document should look like this: 
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If you document looks like this, bravo; otherwise make the corrections, and save it. 

 
 

SAVING DOCUMENT USING THE “SAVE AS” COMMAND 

 

It is very vital to save every project you do on the computer. This will cause the project to be 

stored on the specified storage device, principally, the hard disk. Saved project can be opened 

and edited in later. 

Follow these steps to save your letter: 

 

 Click on the office button at the top left corner of the 

window. 

 Point on ―Save As‖  

 Select Word Document. 

 

A small window known as the Save AS dialogue box opens. 

(Look below). 

 

Fig. 13.4: your document looks like this one 

Fig. 13.5: Office menu 
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 Under File Name: type a desired name for your document, e.g. LETTER. 

 Under Save in: select the location or directory you want your document to be stored. 

The default directory is ―My Documents‖ folder. 

 When you finish click on Save.  

 
 

 

That takes you back to where your document is. Look at the name on the Title bar. What has 

happened? Yes, the title of your document has changed to the file name you specified, 

LETTER. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ACTIVITY 
 

Students to type a letter using 
name and save in folder. 

Fig. 13.6: the Save As dialogue box 

Fig. 13.7: new document name on the title bar 
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After completing this chapter, you should be able to: 

 

i. Edit and save Word document using editing tools. 

 

 

 

 
OBJECTIVES 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chapter
 7 

EDITING TEXT IN WORD  

PROCESSING DOCUMENT 

 

 

INTRODUCTION  

 

Editing is the act of opening a saved project and making changes to it. The first version of a 

document is referred to as a draft. Drafts do not always produce the desired effect, because 

they are normally produced in haste. Editing a document gives it the finishing that is wanted.  

Microsoft Word, like most software, makes it easy for documents to be retouched and 

resaved. In this chapter, we will edit the document we created in the last chapter, and to do 

that let us open it. 

 

Do you remember the third method of launching software using the start button? You are 

right. Using the My Recently Documents. Since the letter we typed is our recent document, 
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we will the My Recent Documents option. Follow that step to open the document you 

created. 

Another way of opening a saved document is by opening the directory in which you save it, 

and then double clicking on the document file. 

You can also open the document by opening a blank document; clicking on the office button; 

and then selecting the document from the Recent Documents menu. 

 
 

Editing word document using spell check functions 

 

Microsoft Word underlines the words which are either wrongly spelt or are not in it 

dictionary. The feature known as Spell Check can be used to make the necessary corrections. 

If you have opened the document you would see that the word Bamfo has been underlined 

with a red-wavy line. It means the computer does not understand it. We know that the word is 

correct, so to remove the red line, right-click on the word and select ―ignore‖. That settles it, 

the red line is gone. 

Now let us create some spelling mistakes and the correct them. In the document, remove the 

letter a from teacher. What happens? Red-line! The computer does not have techer in its 

dictionary.  

Let us remove the red line.  

 Right-click on techer. 

 The computer gives you some spelling options. 

 Select the correct option, teacher. Word corrected. 

 

There are some other cases where you might have more than one 

spelling mistake in your document. You can either use the above 

method to correct them one by one, or: 

 

 Right click on the word. 

 Click on spelling. A dialogue box opens.  

Here the spelling mistakes are presented to you one after 

the other. Try the various options tabs there to see what they do. 

  

 

 

 

 

 

 

 

 

 

 

Fig. 13.8: spell check drop-down menu 

Fig. 13.9: spelling dialogue box 
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Take another look at the document. The words ―Super New Town‖ has been give a green 

underline. Microsoft Word underlines a word or sentence with green wavy-line if the word is 

wrongly used or the sentence contains a grammatical error. To remove the green line: 

 

 Right-click on the word or sentence. 

 You can choose to ignore it or  

 Click on Grammar. That opens another dialogue box similar to the one above. Choose 

the option you want. 

 

 

Editing word document using copy, cut and paste 

 

To copy or cut a group of texts, they must first be selected. To select a group of texts 

 Click the beginning or ending of the group of texts. 

 Drag to the right or left to highlight them. 

Let us try that on our document. Select the words ―computer mouse‖. 

 

 

 

 

 

 

Now, let us copy the selected words. To do that: 

 

 Right click on the selected words. 

 Right-click on the selected words. 

 Click on Copy.  

 

The copied words are stored in a temporal memory known as clipboard. A clipboard stores a 

copy of the last information that was ―copied‖ or ―cut.‖ A ―paste‖ operation passes data from 

the clipboard to the current program. A clipboard allows information to be transferred from 

one program to another, provided the second program can read data generated by the first. 

Let us paste our copied words to do that  

 Right-click a blank portion of the document. 

 Click on Paste. What happens?  

We can use a similar approach to cut texts or word. 

 Select the words you want to cut, e.g. ―computer mouse‖ form our document. 

 Right-click on it. 

Fig. 14.0: selecting words 
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 Select Cut. Cutting texts, words or graphics moves them to the clipboard. 

 Place the insertion point in front of ―Dear Sir‖ 

 Right-click and select paste. 

Your letter should read like this: 

 

 

 

 

 

 

 

 
 

Editing Word Document using OVR 

 

OVR stands for overtype. This is a feature in Word which makes it possible for an already 

typed word to be replaced by another word. To turn on OVR:  

 

 Click on the office button 

 Click on Word Options 

 Click on Advanced 

 Check Use overtype mode 

 To be able to turn OVR on and off 

with the insert key, check ―Use the 

Insert key to control overtype mode‖. 

 Click OK. 

 

Let us use OVR on our letter. 

 

 Place the insertion point before the word ―start‖   

 Type the word begun.  

You will notice that each key you press replaces one word, so the word ―began‖ replaces 

start.  

 

 

Fig. 14.1: edited letter 

Fig. 14.2: applying OVR 
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Editing Word Document Using Undo and Redo buttons 

 

Two new words to add to your vocabulary if you have not come across them already - undo 

and redo.  

Undo  

To undo an action is to reverse the last action—for example, to undo a deletion, thus restoring 

the text to a document.  

To undo an action just click the undo button          located at the top left corner of the 

window.  

That will undo the last action. To undo multiple actions, click on the small arrow next to the 

undo button. A drop-down menu of all the actions done recently on the document will be 

shown. You can then select the actions you want to undo from the list.  

CAUTION: undoing an action at the base or in the middle of the list will undo all the other 

actions on top of it. 

 

Let us practice Undo on our letter. 

Do you remember our last action on the letter? Yes, we replace started with begun.  

Undo that. (just click on the undo button). 

What happens? The last letter is replace by the previous letter.  

 

Now, let try multiple undo.  

Click on the small arrow next to the undo button to display a list of our recent action.  

Move the mouse printer down to ―Typing b‖ and click on it. 

What difference does it have on your document?  

 

 

 

 

 

 

 
 

Redo  

To redo an action is to repeat the action you just undid. The redo button       is located next to 

the undo button, and only becomes active when an action is undone. The number of actions 

undone determines the number of redo options available. For example, if you undo five 

actions, you can redo up to five actions. 

 

Let us apply redo to our letter. 

 Click the redo button. Notice the changes. 

 Click it till it becomes inactive. What are the changes in the document? 

 

 

Fig. 14.3: undoing some actions 
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Let us save our document.  

 Click on the office button. 

 Select Save. 

Or  

 Click on the save button on the ribbon. You can also save your document by using the 

short-cut keys – Ctrl + S. 

 

 

Find and replace 

Imagine working on a very lengthy document, and when you are about to finish you noticed 

that one name or word which you have been using throughout the document is actually the 

wrong one. You will surely have to scroll from page to page correcting that mistake, sounds 

like a really difficult task, but with the :Find and Replace‖ feature of Microsoft Word, this 

correction could be effected with a few mouse clicks and keyboard taps.  

 

Find feature lets you quickly locate pretty much any part of a document, from a word or 

phrase to a special character (such as a paragraph mark), from direct formatting (such as 

bold) to style formatting, from text in a particular language to an object (such as a picture). 

Find‘s sister feature, Replace, lets you replace text, formatting, or styles, either one instance 

at a time or all instances in a single sweep. 

 
 

Find Text 

What you‘ll probably want to search for first is text—for example, a word that you know 

occurs in the part of the document to which you want to turn your attention. Word lets you 

search for text on its own or text with formatting. 

 

To find text, follow these steps: 

 

 Press CTRL-F or choose Home | Editing | Find. Word displays the Find And 

Replace 

 dialog box with the Find tab foremost. 

 In the Find What text box, type or paste the search text. To paste, right-click and then 

choose Paste from the context menu. 

 

 

 

 

 

 

 
Fig. 14.4: Find and Replace 

dialogue box 
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Click on the Replace tab, and in the replace text box, type the word you to replace the found 

word with. 

Word remembers the details of searches you‘ve performed in this session. To retrieve an 

earlier search, click the drop-down arrow on the Find What text box and choose the search 

from the list. Word lists the searches in reverse order, so the latest search is first. 

You can choose Replace to replace only the highlighted word, or Replace All to replace all 

instances of the found word. 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 14.5: replacing a word 
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After completing this chapter, you should be able to: 

 

i. Format Word document using formatting tools. 

 

 

 
OBJECTIVES 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chapter
 8 

 

FORMATTING WORD 

PROCESSING DOCUMENT 

 

 

INTRODUCTION  

 

One of the fascinating aspects in the use of word processors, especially Microsoft Word is the 

ability to give documents real, desired facelift. Apart from making it much easier to create 

and edit documents than typewriters do, word processors also make it easy to format 

documents—again, unlike typewriters. Word offers a wide variety of formatting that lets you 

make documents look pretty much exactly how you want them to: professional, casual, 

serious, fun, or anywhere in between. In fact, Word offers enough different formatting 

options to be confusing, as the effects of some options overlap with each other.  

 

This means that you can often produce the same look by using formatting in different ways. 

Word starts off most new documents you create in its standard typeface, or font, which is 

called Calibri. Most people find Calibri much more appealing, but you can change the font at 

any time if you don‘t like it or if you want to make your document look different or easier to 
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read. You can also change the font size, font color, the alignment, the line spacing, and many 

more formatting options, most of which you‘ll meet in this chapter. Word 2007 adds several 

new formatting options to those in earlier versions of Word. First, every document has a 

theme, a set of colors, fonts, and graphical objects that are designed to work together. Second, 

Word provides Quick Styles, suites of styles derived automatically from the font and colors 

in the theme. By applying Quick Styles (with a single click), you can give a document a 

consistent look. You can also use Word‘s long-standing regular styles to apply predefined 

sets of formatting to characters, paragraphs, lists, or tables. Styles give you precise control 

over formatting while helping you avoid reinventing the wheel every time you apply or 

change formatting. 

 
 

Formatting a Word document using change font 

 

In this section we are going to work around with fonts. Fonts are a set of characters of the 

same typeface (such as Courier), style (such as italic), stroke weight (such as bold), and size. 

A font is not to be confused with a typeface. Font refers to all the characters available in a 

particular size, style, and weight for a particular design; typeface refers to the design itself. 

There are varieties of fonts already installed on your computer. The default font for as said 

Word, as said earlier, is Calibri. That is the font we used in our document. Let us open our 

last saved document. You know the steps, right? 

First let us change the font style. 

 Select all the text, by dragging the insertion point from top 

to bottom of page or use the short-cut Ctrl + A. 

 On the Tool Bar select Home. 

 On the Font menu, click on the small arrow next to the font. 

A drop-down list of the available fonts is displayed. 

 Scroll down and select ―Times New Roman. What 

happens? 

 

 

 

Let us give some effects to the title of the letter. 

BOLD 

Select the title only. 

 Click on the font size arrow, and select 16. 

 With the title still selected, click on the bold 

button or use the short-cut Ctrl + B. Notice the 

effect. 

Fig. 14.6: a list of available fonts 



rkeyk 

 

 

122 

 
Formatting Word Processing Document 

Underline Let us underline the title of the letter. 

Click on the underline button or use the shortcut Ctrl + U. 

 

Italic To italicize the title of the letter: 

 Click on the Italic button or use the shortcut Ctrl + I 

 

Text colour Let us give the title a colour. To do that: 

 Click on the Font Colour button in the Font menu. 

 Click on the red colour. 

The above formatting styles are found on the Toolbar. 

There are some text formatting features which do not 

appear on the Toolbar; those can be found in the Font 

Dialogue Box. To assess the Font Dialogue Box, click on 

the Font Dialogue Box button or use the short-cut Ctrl + D. 

Try the various font formatting styles there.  

 

 

 

 

 

 
 

Formatting Word document using text alignment  

 

Font formatting changes the look of the characters, but you‘ll often need to change the 

paragraph layout as well from the way that Word sets it automatically. To change the 

paragraph layout, you use paragraph formatting. 

 

Paragraph formatting tools are found on the Paragraph menu of the Toolbar. Like most word 

processors, Word offers left, right, centered, and justified 

alignment; increase and decrease indents. 

 

Left alignment The words line up along the left margin of the 

page. Left is the alignment Word comes set with. You‘ll probably  

want to stick with left alignment for most text. (Shortcut Ctrl + L) 

Right alignment The words line up along the right margin of the page. Right alignment is 

useful for putting text up against the right margin. For example, you might create letterhead 

with the sender‘s address right-aligned. (Shortcut Ctrl + R) 

Centering The words flow left and right from the center of the page. Centering is good 

for display text, such as headings and poetry. Shortcut Ctrl + E) 

Fig. 14.8: Font Colour menu 

Fig. 14.9: Font dialogue box 
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Justified alignment This setting aligns the text with both the left margin and the right 

margin, except for the last line of the paragraph, which is allowed to fall short so that it 

does not require huge spaces between the words.(Shortcut Ctrl + J) 

 

Indent the distance the text move in from the margin. 

 

The Toolbar includes buttons for centering text and adjusting tabs, but most of the tools for 

formatting paragraphs are in the Paragraph dialogue box. To open the Paragraph dialogue 

box, click on the button below the paragraph menu on the Toolbar. 

 

Other paragraph formatting tools include Numbers and Bulleting and 

Line Spacing. 

 
 

Numbers are used to make a list or give figures to lines.  

Bullet are similar to numbers, but unlike numbers, a bullets can be any 

character. The most common bullet in word is the filled in round. 

Numbers and numbers are used when listing items whose content is of 

similar importance. 

 

There are variations of numbers and bullets. 

To see them click the small arrows located 

next to Numbering and Bullets. 

 

Create a document and apply Numbering and 

Bullets 

 

 

 

 

Line spacing 

 

To make a document easy to read, you may have to increase or decrease the line spacing, the 

amount of vertical space between one line and the next. Word starts a typical paragraph with 

single spacing—each line has enough space to accommodate the tallest character, and a little 

more space so that that character doesn‘t touch the line above or the line below. Single 

spacing is based on the font size, so if you increase the font size, or put in a taller character, 

Word increases the line space so that the characters don‘t touch. 

 

Word lets you move the lines of each paragraph farther apart or closer together as much as 

you want. For example, you can move the lines apart to make the text easier to read, to leave 

space for editing on paper, or simply to make a short document look longer. 

 

Let us practice line spacing. 

Fig. 15.0: Bullets and Numbers Libraries 
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 Select all text in your letter 

 Click on the small arrow on the Line spacing button. That opens 

the line spacing options. 

 Select 2.0; that doubles the line spacing of your document.  

For further line spacing options, click on the Line Spacing Options. That 

opens a dialogue box with additional line spacing features  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Change case 

If you want text to appear in all capital letters, you can press CAPS LOCK and type the 

letters as capitals. But often it‘s easier to apply all-caps formatting to existing text. You can 

also apply small-caps formatting to make text appear as small capital letters. Any letters that 

were capitals remain full-size capitals. 

 

To change the case of existing text: 

Drag-select the text 

Click on the home menu 

On the Font tab click on Change case.  

A drop-down menu appears; select the case you want to change to. 

 

 

 

 

 

 

 

Fig. 15.1: Line Spacing options 

Fig. 15.2: Paragraph dialogue box 

Fig. 15.3: Change case dialogue 

box 
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Inserting Table and Symbols in Word Processing Document 

 
After completing this chapter, you should be able to: 

 

i. Insert tables in Word Processing document. 

ii. Insert symbols and pictures in Word Processing documents 

 

 

 

 
OBJECTIVES 

 

 

 

 

 

 

 

 

 

 

 

 

Chapter
 9 

INSERTING TABLE AND SYMBOLS 

IN WORD PROCESSING DOCUMENT 

 

 

 

 

 

 

 

 

INTRODUCTION  

 

Word processing documents do not just allow the user to work with text only, but combines 

some of the features and capabilities of both spreadsheet and graphics applications. With this 

users can add, edit and even format tables, pictures and other graphics.  

 

In this chapter we will consider how to insert tables, symbols and pictures in Microsoft Word 

document. 

 
 

INSERTING TABLES IN WORD DOCUMENT 

In you can create both simple and complex tables as needed: a table can consist of a single 

cell, but normally has multiple cells and columns. Word provides various predefined table 

styles for common items such as calendars, tabular lists, and tables that have subheads. 
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Microsoft Word allows you to create a table in four main ways: 

 

 Creating a new table from scratch 

 Converting existing text to a table 

 Inserting one of Word‘s predefined Quick Tables 

 Drawing a table manually by placing the lines where you need them. 

 

 

Create a new table from scratch 

To create a new standard table:  

 

 On the Insert menu, on the Table tab, select Table. 

 Choose the number of rows and columns from the Table panel. The 

readout at the top of the Table panel displays the number of rows 

and columns you‘ve chosen. 

 

Word inserts the table, adds the Table Tools section to the Ribbon, and 

displays the Design tab on that section,  

 

 

 

 

 

 

 

 

 

If you need to insert a table that has more columns or rows (or both) than appear on the Table 

panel, or if you want to choose further options for your table, follow these steps: 

 

 Place the insertion point where you want the table to appear. 

 Choose Insert | Tables | Table | Insert Table. Word displays the 

Insert Table dialog box. 

 In the Number Of Columns text box, type in the number of 

columns. 

 In the Number Of Rows text box, type in the number of rows. 

In the AutoFit Behavior area, decide whether to use a fixed 

column width or have Word automatically fit the table to its 

contents or the Word window: 

 

Fig. 15.5: choosing rows 

and columns 

Fig. 15.6: the inserted table 

Fig. 15.7: Insert table dialogue box 
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Fixed Column Width This option gives each column a fixed width. In the text box, choose 

Auto if you want Word to share out the available space equally among the columns. 

Alternatively, specify the standard width you want to use for each column. 

 

AutoFit To Contents This option give adjusts the column width automatically to suit the 

amount of text each column contains. This behavior can be helpful, but it may mean that 

Word constantly adjusts column width while you’re creating the first few rows in the table. 

 

AutoFit To Window this option gives adjusts the column width to fit the width of the window. 

This option can be handy for making sure that the full width of the table is visible. 

 Select the Remember Dimensions For New Tables check box if you want Word to use 

the configuration you‘ve just set as the default for new tables. 

 Click the OK button. Word closes the Insert Table dialog box and inserts the table in 

the document. Word also adds the Table Tools section to the Ribbon and displays the 

Design tab on that section. 

 
 

Converting Existing Text to a Table 

 

Some times there would be a need to turn existing text into a table. For example, you may 

start laying out tabular data using tabs, and then realize that a table would be better. 

 

To convert existing text to a table, follow these steps: 

 

If the text is divided into columns using tabs, commas, or another character, make sure that 

each paragraph contains the same number of columns.  

To see tab characters, select Home | Paragraph | Show/ Hide ¶. Or use the shortcut Ctrl + * 

 

 Select the text you want to turn into the table. Include the 

paragraph mark at the end of the last paragraph. 

 Click on Insert | Tables | Table | Convert Text To Table. 

The convert to text dialogue box is displayed 

 In the Table Size area, make sure that the Number Of 

Columns text box is showing the number of columns you 

expect.  

 

Paragraphs This option button turns each paragraph into a 

cell in the table. You may need to adjust the Number Of 

Columns setting manually, as Word normally sets it to 1.  

 

Commas This option button turns each section that’s separated with commas into a cell in 

the table. Normally, you’ll use this setting when dealing with a Comma Separated Values  

(CSV) file; for example, when you have exported spreadsheet or database data in CSV 

format. 

 

Fig. 15.8: Convert Text to Table 
dialogue box 
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Tabs This option button divides the text at each tab. This setting is very useful. 

 

Other Select this option button to divide the text at another character and type the character 

in the text box. For example, you might need to divide the text at a character such as a brace 

({) or an exclamation point (!). You can use only one character. 

 

 In the AutoFit Behavior area, choose the automatic-fitting option you want.  

 Click the OK button. The Convert Text to Table dialogue box closes and the table is 

applied to the selected text. Word also adds the Table Tools section is added to the 

Ribbon and the Design tab is displayed on that section. 

 Make sure that Word has divided your text as needed. If there‘s a problem, click the 

Undo button to remove the table. Fix the problem with the divisor character (for 

example, add a missing tab, or delete a surplus tab), and then convert the text to a 

table again. 

 
 

Inserting one of Word’s predefined Quick Tables 

 

To create a new table based on one of Word‘s Quick Table designs: 

 

 Place the insertion point where you want the table to be. 

 Select Insert | Tables | Table | Quick Tables. 

 Choose the design from the Quick Tables panel. The table is 

inserted and the Table Tools is added to the Ribbon and the 

Design tab is displayed on that section.  

 Change the sample data in the Quick Table to the data you 

want the table to have. 

 
 

Drawing a table manually by placing the lines where you need them 

 

If you are not satisfied with any of the tables above, you might have to create one yourself. 

To do that: 

 Select Insert | Tables | Table | Draw Table. The mouse pointer changes to a pen. If the 

window is in Draft view, Word switches it to Print Layout view. 

 Click in the document where you want one corner of the table to appear, and then 

drag diagonally to the opposite corner. You can drag diagonally in any direction. 

 After creating the first part of the table, the Table Tools section is added to the Ribbon 

and displays the Design tab. 

 
 

ITEM NEEDED 
Books 1 
Magazines 3 
Notebooks 1 
Paper pads 1 
Pens 3 
Pencils 2 
Highlighter 2 colors 
Scissors 1 pair 

Fig. 15.9: A predefined table 

Fig. 16.0:  drag diagonally to create a table Fig. 16.1: draw needed lines 
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 Click and drag to draw other lines as needed to create the table layout you need. 

 

To change the line style:  

 Select Design | Draw Borders |Line Style. 

 Select the style from the Line Style panel.  

To change the line weight:  

 Select Design |Draw Borders | Line Weight 

 Select the weight from the Line Weight panel. 

To change the pen color: 

 Select Design | Draw Borders | Pen Color. 

 Select the pen color from the Pen Color panel. 

To erase an existing line: 

 Select Design | Draw Borders | Eraser 

 Click each line you want to erase with the eraser mouse pointer.  

 To cancel the eraser, press ESC or choose Design | Draw Borders | Eraser again. 

 

 

INSERTING SYMBOLS AND PICTURES IN WORD DOCUMENT 

 

To give your documents more visual impact, or simply to make them more understandable, 

you‘ll often need to add pictures, shapes, diagrams, or other graphical objects. In this 

Section, we will learn about the wide variety of features that Word offers for adding graphical 

objects to your documents. 

 
 

Inserting symbols  

Symbols are characters that do not appear on the keyboard. There are two main ways of 

inserting symbols in your document – the Symbol Panel and the Symbol dialogue box. 

 

Using the Symbol Panel 

The Symbol Panel contains 20 symbol most used or recently used symbol. To 

insert a symbol with the Symbol Panel: 

 

 Position the insertion point to where you want the symbol to appear. 

 Select Insert | Symbols | Symbol. Word displays the Symbol panel. 

 Click on the symbol you want. Word inserts it to where the insertion 

point is.  

 

 

Fig. 16.2: The Symbols Panel 
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Using the Symbol dialogue box 

 

The Symbol dialog box lets you browse through the available symbols. It also allows you to 

create or use keyboard shortcuts for symbols you use most. To insert a symbol using the 

Symbol dialogue box: 

 

 Position the insertion point at where you want the symbol to be. 

 Select Insert | Symbols | Symbol. Word displays the Symbol panel. 

 Click on More Symbols. Word displays the Symbol dialogue box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Click on the symbol you want. You can use the Font drop-down to choose the font 

style of the symbol you want. If the symbol you want does not appear, try the Special 

Characters tab. 

 Double-click on the symbol or click the Insert button to insert it in your document, the 

close the dialogue box. 

 

 The Recently Used Symbols box at the bottom of the Symbols tab gives you quick access to 

the last 16 symbols you have used. 

 
 

Inserting pictures to documents 

To enhance your documents, you will often need to insert a picture, such as a custom 

illustration, photograph, or screen capture 

 

To insert a picture: 

 

 Position the insertion point at the beginning of the paragraph where you want the 

upper-left corner of the picture to appear. It‘s best to use an empty paragraph. You 

can move the picture later if you need to. 

 Select Insert | Illustrations | Picture. The Insert Picture dialog box is displayed. 

Fig. 16.3: Symbols dialogue box 
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 Navigate to the picture you want to add, and then select it. 

 Click the Insert button. The Insert Picture dialog box closes and the selected picture is 

inserted in the document. 

 

 

 

 

 

 

 

 

 

 

 

 

The picture can be cropped or resized to suit the document. 

To crop a picture: 

 Double-click on the picture.  

 On the Ribbon, select Crop.  

 Hold the crop handle and crop the picture the way you want. You can crop a picture 

from left to right, top to bottom and vise versa.  

 

 
 

Inserting Clip Art 

Microsoft Office‘s Clip Art feature lets you easily access a wide selection of 

graphics, photographs, movie clips, and sounds that you can use freely in 

your documents, and insert them easily. 

 

To insert a Clip Art in your document: 

 

 Position the insertion point at the beginning of the paragraph where 

you want to position the upper-left corner of the item. It‘s best to use 

an empty paragraph. You can move the item later as needed. 

 Select Insert | Illustrations | Clip Art. Word displays the Clip Art task 

pane. 

 Type the keyword of the item you are looking for in the Search For 

box or in the Search In drop-down list choose Everywhere. 

 In the Results Should Be drop-down list, choose the media types 

Fig. 16.4: Insert Picture dialogue box 

Fig. 16.5: selecting the Crop tool 

Fig. 16.6: Clip Art gallery 
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you‘re interested in: All Media File Types, Clip Art, Photographs, Movies, or Sounds. 

 Click the Go button. Word searches for matching media types and displays them in the 

pane. 

 If you find the clip you want click on it to be inserted in your document. 

 
 

Inserting Word Art in your document 

 

Another fascinating element you can add to documents is a 

WordArt object. WordArt is a Microsoft Office applet for 

creating text-based designs, such as logos, decorations or 

other designs. Though very appealing, Word Art should be 

used when necessary and in moderation since it can make 

your document quite difficult to read. 

 

To insert a WordArt object in a document: 

 

 Position the insertion point at the beginning of the paragraph where you want the 

WordArt item to appear.  

 Select Insert | Text | Word Art. The Word Art Gallery is displayed. 

 Click the style of WordArt item you want. Word displays the Edit WordArt Text dialog 

box.  

 

The “Your Text Here” text is sample text that Word 

provides so that you can see the current font in use. 

 

 Type the text you want the Word Art to have over 

the sample text. 

 Choose the font you want to use in the Font drop-

down list, 

 Choose the font size for the WordArt in the Size 

drop-down list, 

 If you want, click the Bold button to apply boldface or the Italic button to apply italics. 

 Click the OK button. Word closes the Edit WordArt Text dialog box, and inserts the 

WordArt item in your document and the WordArt Tools on the Ribbon. 

 

 

 

 

 

 

 

Fig. 16.7: selecting Word Art style 

Fig. 16.8: Edit Word Art Text dialogue box 

Fig. 16.9: Inserted Word art item 
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After completing this chapter, you should be able to: 

 

i. Print documents using various print options. 

 

 

 

 

 
OBJECTIVES 
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PRINTING 

 

 

INTRODUCTION  

 

For about a decade and a half, futurists have been predicting that computers will eliminate 

paper documents from the world.—but that‘s still nearly as far from happening as it‘s ever 

been. Almost every home with a computer has a printer, and most offices have many printers, 

all busy churning out many pages a minute and many documents an hour. 

So you‘ll probably need to print some—perhaps many—of your Word documents.  

This chapter shows you how to do so. The best place to start is by making sure that you have 

suitable printing options set. You‘ll then be ready to preview a document, print a document 

the conventional way, print directly from the Desktop or from a Windows Explorer window.  

 

Printing Word Document with Various Print Options 

 

Before you print at all, it‘s a good idea to verify that Word‘s printing options are set to print 

the document elements you need to print correctly. The default settings work well for many 

people, but you may need to change some of them to suit your need. 
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To set printing options: 

 Click the Office Button, and then click Word Options. Word displays the Word 

Options dialogue box. 

 In the left pane, click the Display category. Word shows the Display items. 

 In the Printing Options area, choose options for all the documents you print. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Print Drawings Created In Word This option allows text boxes, graphics and shapes created 

in Word be included in the in the printout. You will normally want to include them. This 

option is selected by default. 

 

Print Background Colours And Images This option allows background colours and images 

to be included in the printout. Printing these items lets you see the full document on paper, 

but it both consumes more ink and can make documents harder to read. 

 

Print Document Properties This option allows document‘s property information such as 

subject, title and author to be printed on a separate sheet of paper. 

 

Print Hidden Text This option allows hidden text in the document to be printed with the rest 

of the document.  

 

Update Fields Before Printing This option allows Word to update all the fields in a 

document automatically when you issue a Print command.  

 

Update Linked Data Before Printing This option allows Word to any linked information 

from other documents before printing. Such updating ensures that your document is up-to-

date and is a good idea unless the linked documents may not be available to your computer 

Fig. 17.0: Word Options dialogue box 
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when you print. (For example, if you take a document home from the office, any linked 

documents on the office network may not be available.) 

 

 Click the OK button. Word closes the Word Options dialog box and applies your 

choices. 

 

Use Print Preview 

Use Print Preview before you print to make sure that the document looks the way you want it 

to and (if appropriate) that it fits on the paper size you‘ve chosen. 

 

Open Print Preview 

To display the active document in Print Preview: 

 Click the Office Button. 

 Highlight the Print item or click the arrow next to it to display the Preview And Print 

The Document submenu. 

 Click Print Preview. Word displays only the Print Preview tab of the Ribbon, 

suppressing all the other tabs.  

 
 

 

You can also use the keyboard shortcut Ctrl + Alt + I to display the print preview. 

 
 

Preview the Document 

 Click the Next Page button or the Previous Page button to navigate to the previews 

next page or previous page. (These buttons have no effect if there is no next page or 

previous page.) You can also scroll or press PAGE DOWN or PAGE UP. 

 Use the controls in the Zoom group and the Preview group of the Print Preview tab of 

the Ribbon to preview your document. 

 Select the Show Ruler check box in the Preview group to display the ruler. (You can 

also click the Show Ruler button at the top of the vertical scroll bar.) 

 
 

Change the Page Setup 

If your document doesn‘t look the way you planned, use the controls in the Page Setup group 

on the Print Preview tab: 

 

Margins Click this button, and then choose a preset margin from the panel. Alternatively, 

choose Custom Margins from the panel to display the Margins tab of the Page Setup dialog 

box. 

Fig. 17.1: Print Preview 
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Orientation Click this button, and then choose Portrait or Landscape, as needed. 

 

Size Click this button, and then choose a preset size from the panel. For more choices or a 

custom size, click the More Paper Sizes item, and then work on the Paper tab of the Page 

Setup dialog box. 

 
 

Printing a Document 

 

When you are done with all the necessary corrections and adjustments on the page and the 

document is ready to print, you can print it with the Print dialogue box.  

To do that: 

 Click the Office Button. 

 Click on Print. The Print dialogue box is displayed. 

You can also display the Print dialogue box by using the keyboard shortcut Ctrl + P. 

 Or, from Print Preview  

 Choosing Print Preview | Print | Print. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Choose Which Printer to Use 

The Name drop-down list shows the printer that Word will use unless you change the printer. 

To choose a different printer, open the drop-down list, and then click the printer. 

 
 

Specify Which Pages to Print 

In the Print Range group box, choose which pages to print: 

 

All Choose this option button to print all the pages in the document. This is often convenient, 

and Word selects this option button by default. 

 

Fig. 17.2: Print dialogue box 



rkeyk 

 

 

137 

 
Printing 

Current Page Choose this option button to print the page on which the insertion point is 

currently positioned. 

 

Selection Choose this option button to print the selection you made in the document before 

you displayed the Print dialog box. If you didn‘t make a selection in the document, this 

option button is unavailable. 

 

Use the Print dialogue box to choose what to print, which printer to use, and whether to print 

multiple copies. 

 

Pages Select this option button to print the range of pages you specify in the text box. 

Range of Pages Type the starting and ending page numbers, separated by a hyphen, for 

example, 1 - 9. 

Individual Pages Type each page number separated by a comma, for example, 1, 5, 7, 12. 

Individual Pages and Ranges Type the page numbers and ranges separated by commas, for 

example, 2, 3, 7-10, 16. 

Sections Use s and the number to represent each section. For example, s1, s4 means prints 

Section 1 and Section 4; s1, s5-s8, s11 prints Section 1, Sections 5 through 8, and Section 11, 

respectively. 

Pages Within Sections Use p and the number to represent the page within the section, and s 

and the number to represent each section. For example, p2s5-p4s7 prints from Page 2 in 

Section 5 to Page 4 in Section 7. 

Select Odd Pages or Even Pages in the Print drop-down list, if you need to print just the odd 

pages of the page range you‘ve specified, or just the even pages. 

 
 

Choose Which Items to Print 

In the Print What drop-down list, select which item or items you want to print: 

Document Select this item to print the document itself. This is the item you‘ll want most 

often. Word selects Document by default unless the document contains markup, in which 

case Word selects Document Showing Markup. 

Document Properties Select this item to print a list of the document‘s properties, such as the 

title, subject, and author name. 

Document Showing Markup Select this item to print the document showing all tracked 

changes, comments, and other markup. Word selects this item by default if the document 

contains markup. Word prints the markup using the formatting you‘ve selected in the Track 

Changes Options dialog box. 

List Of Markup Select this item to print only the markup from the document—tracked 

changes, comments, and other markup. (This is essentially a printout of the Reviewing pane.) 

Styles Select this item to print a list of the styles used in the document. 

Building Blocks Entries Select this item to print a list of the building blocks in the 

document‘s template. 

Key Assignments Select this item to print a list of the custom key assignments in the 

document.  
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Choose the Number of Copies and How to Collate Them 

Set the number of copies to print in the Number Of Copies box. The default is one copy. 

If you print multiple copies, select the Collate check box to print the full set of each copy at  

once (followed by the next copy), or clear the Collate check box to print all of the copies of 

each page together (followed by all of the copies of the next page). 

 

 

Print Multiple Pages on the Same Sheet of Paper 

When creating some kinds of documents, you may need to print multiple pages of the 

document on the same physical sheet of paper. To do so, choose the number in the Pages Per 

Sheet drop-down list: 1 Page, 2 Pages, 4 Pages, 6 Pages, 8 Pages, or 16 Pages. 

 
 

Print a Document on a Different Paper Size 

To print the document on a different paper size than that used in its page setup, choose the 

paper size in the Scale To Paper Size drop-down list. This list offers a wide range of choices, 

from Post Card up to Legal. To print a document normally, make sure the No Scaling item is 

selected. (Word selects No Scaling by default.) 

 
 

Print to a File 

Sometimes, you may need to print a document to a print file rather than print it to paper. The 

print file is a file that describes how the printout should look—a file that contains a printed 

version of the Word document. You can then send or take the print file to another computer 

for printing. For example, you might use a specialist print shop for high-quality printouts. 

To print to a file, select the Print To File check box. When you click the OK button in the 

Print dialog box, Word displays the Print To File dialog box. Type or paste the path and 

filename for the print file in the File Name text box, and then click the OK button. 

 
 

Choose Further Options in the Printer Properties Dialog Box 

You can choose further options by clicking the Properties button in the Print dialog box and 

working in the Properties dialog box for the printer. The contents of the Properties dialog box 

vary greatly depending on the printer (Figure 8-3 shows an example), but you‘ll often find 

options such as these: 

Printing in back-to-front order instead of the default front-to-back order. (Back-to-front order 

is sometimes useful for photocopying tasks.) 

Printing multiple pages on the same sheet of paper. 

Using different paper trays. For example, you might need to print invoices on letterhead 

loaded into a different paper tray than plain paper. 

 

Using different print quality—for example, 300 dpi (dots per inch) instead of 600 dpi. 

After choosing options, click the OK button. Word closes the Properties dialog box. 
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You can also display the Properties dialog box for the printer by clicking the Options 

button on any of the tabs in the Page Setup dialog box. 

 
 

Print on the Back and Front of Paper 

If you need to produce documents printed on both sides, but you don‘t have a printer capable 

of duplexing (printing on both sides), you can use Word‘s Manual Duplex option. Follow 

these steps: 

 In the Print dialog box, select the Manual Duplex check box. 

 Check that you have suitable duplex options set: 

 Click the Options button. Word displays the Word Options dialog box. 

 Click the Advanced category. Word displays the Advanced options. 

 

 In the Print area, select the Print On Front Of The Sheet For Duplex Printing check 

box. Make sure the Print On Back Of The Sheet For Duplex Printing check box is 

cleared. 

 Click the Print button. Word prints the odd-numbered pages in reverse order and then 

displays the dialog box shown here. 

 Take the printout from the printer, and then put the sheets in the printer‘s paper tray 

so that the side that wasn‘t printed will be printed this time. Most printers have an 

icon near the paper tray indicating which side of the paper the printer prints on—for 

example, an arrow pointing up or pointing down. 

 Click the OK button. Word prints the even-numbered pages of the printout on the 

backs of the pages you reinserted. 

 
 

Print Directly from the Desktop or a Windows Explorer Window 

 

But if you need to quickly print a completed document, you can do so directly from your 

Desktop or Windows Explorer if the document is either stored in your Desktop or any other 

directory To print a document to your default printer: 

 

 Right-click the document file on your Desktop or in the Windows Explorer window. 

 Select Print from the context menu. Windows opens the document in Word, prints it, 

and then closes it automatically. 

You can use a similar technique to print to different printers by creating Desktop shortcuts to 

the printers you want to use. To create Desktop shortcuts to printers: 

 

 Open the Printers And Faxes window  

 Select Start | Printers And Faxes.  

 If no Printers And Faxes item appears on the Start menu 

 Select Start | Control Panel 

 Click the Switch To Classic View item in the Control Panel task pane if Control Panel 

is in Category view. 
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 Then double-click the Printers And Faxes item. 

 Right-click the desired printer, and then choose Create Shortcut from the context 

menu. 

 Windows XP tells you it cannot create a shortcut in the Printers And Faxes folder and 

asks if you want to create it on the Desktop instead.  

 Click the Yes button. 

 Repeat step 2 for each printer for which you need a shortcut. 

 Click the Close button (the × button). Windows closes the Printers window or the 

Printers And Faxes window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can now print by dragging a document from a Windows Explorer window (or the 

Desktop) to the printer shortcut on the Desktop. If you prefer not to create printer shortcuts 

on your Desktop, you can simply open the Printers And Faxes window and then drag 

documents to the printer entries in that window to print. 

 

 

 

 

 

 

 

 

 

 

 

Fig. 17.3: creating printer shortcuts 
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After completing this chapter, you should be able to: 

 

i. Explain the basic concepts, requirements and terminologies of internet. 

ii. Identify the features of browser window. 

iii. Browse the internet with the help of some features of the Browser window. 

iv. Apply the rules and regulations in the use of the internet. 
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Chapter

 11 

THE INTERNET 

 

 

INTRODUCTION  

The birth of the Internet has broadened and in some respect, given a whole new meaning to 

the term, global village. The use of the internet has grown and keeps growing even faster than 

anticipated. In this section, we are going to consider the internet and everything connected 

with it. First let us have a look at the history of the internet. 

 
 

CONCEPT, REQUIREMENTS AND TERMINOLOGIES OF THE INTERNET 

 

The Internet is a computer-based global information system. The Internet is composed of 

many interconnected computer networks. It is thus referred to as the network of networks. 
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Each network may link tens, hundreds, or even thousands of computers, enabling them to 

share information and processing power. The Internet has made it possible for people all over 

the world to communicate with one another effectively and inexpensively. Unlike traditional 

broadcasting media, such as radio and television, the Internet does not have a centralized 

distribution system. Instead, an individual who has Internet access can communicate directly 

with anyone else on the Internet, post information for general consumption, retrieve 

information, use distant applications and services, or buy and sell products.  

The internet is not owned by any person, organization or country and with this the Internet 

technology allows interconnection of any kind of computer network. No network is too large 

or too small, too fast or too slow to be interconnected. Thus, the Internet includes inexpensive 

networks that can only connect a few computers within a single room as well as expensive 

networks that can span a continent and connect thousands of computers. 

INTERNET REQUIREMENTS 

For a computer or computer network to be connected to the internet, it must get internet 

access and an internet browser.  

1. Internet Access 

The term internet access refers to the communication between a residence or a business and 

an Internet Service Provider that connects to the Internet. An internet Service Provider or ISP 

is a company that sells access to the internet to individuals and organisations.  

Internet access falls into three broad categories:  

 Dedicated Access  

 Dial-up Access 

 Wireless Access 

 

Dedicated Access 

With dedicated access, a subscriber‘s computer remains directly connected to the Internet at 

all times through a permanent, physical connection. Most large businesses have high-capacity 

dedicated connections; small businesses or individuals that desire dedicated access choose 

technologies such as digital subscriber line (DSL) or cable modems, which both use existing 

wiring to lower cost. A DSL sends data across the same wires that telephone service uses, and 

cable modems use the same wiring that cable television uses. In each case, the electronic 

devices that are used to send data over the wires employ separate frequencies or channels that 

do not interfere with other signals on the wires. Thus, a DSL internet connection can send 

data over a pair of wires at the same time the wires are being used for a telephone call, and 

cable modems can send data over a cable at the same time the cable is being used to receive 

television signals.  
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Dial-up Access 

Dial-up is the least expensive access technology, but it is also the least convenient. To use 

dial-up access, a subscriber must have a telephone modem, a device that connects a computer 

to the telephone system and is capable of converting data into sounds and sounds back into 

data. The user‘s ISP provides software that controls the modem. To access the Internet, the 

user opens the software application, which causes the dial-up modem to place a telephone 

call to the ISP. A modem at the ISP answers the call, and the two modems use audible tones 

to send data in both directions. When one of the modems is given data to send, the modem 

converts the data from the digital values used by computers—numbers stored as a sequence 

of 1s and 0s—into tones. The receiving side converts the tones back into digital values. 

Unlike dedicated access technologies, a dial-up modem does not use separate frequencies, so 

the telephone line cannot be used for regular telephone calls at the same time a dial-up 

modem is sending data. 

 
 

Wireless Access 

Another internet access, though less-popular option, is the wireless or satellite internet access. 

In this internet access option a computer grabs an internet signal from orbiting satellites via 

an outdoor satellite dish. The user usually pays a fixed monthly fee for a dedicated 

connection. In exchange, the company providing the connection agrees to relay data between 

the user‘s computer and the internet. 

 
 

2.  Browser 

A browser is a program that enables a computer to locate, download, and display documents 

containing text, sound, video, graphics, animation, and photographs located on computer 

networks. The act of viewing and moving about between documents on computer networks is 

called browsing.  

Browsers allow users to access Web information by locating documents on remote computers 

that function as Web servers. A browser downloads information over phone lines to a user‘s 

computer through the user‘s modem and then displays the information on 

the computer. Most browsers can display a variety of text and graphics that 

may be integrated into such a document, including animation, audio and 

video. Examples of browsers are Internet Explorer, Mozilla Firefox, Google 

Chrome, Safari, Netscape and Mosaic, Most of these browsers are available 

for free or for a small charge and can be downloaded from the Internet 

 

INTERNET TERMINOLOGIES 

The internet is like a country with its own language. Though most of the terms used is 

English, they barely make any sense to the outsider. To be able to use the internet effectively, 

it is advisable to know the basic terminologies accompanying it. Some of the popular internet 

terminologies include: 
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World Wide Web (WWW) 

World Wide Web (WWW) is a computer-based network of information resources that 

combines text and multimedia. The information on the World Wide Web can be accessed and 

searched through the Internet. The World Wide Web is often referred to simply as ―the Web. 

The World Wide Web is mostly confused with the internet, but in actual sense the World 

Wide Web is just a section of the internet and depends on the extensively on the internet. 

The World-Wide Web was developed to be a pool of human knowledge, and human culture, 

which would allow users in remote sites to share their ideas and all aspects of a common 

project. It offers a place where companies, universities and other institutions, and individuals 

can display information about their products, services, facilities, or research, or their private 

lives. The majority of Web pages are available to anyone who can access a computer that 

connects to the internet. Only a small percentage of information on the Web is restricted to 

subscribers or other authorized users. The Web has become a marketplace for many 

companies selling products or services, and a forum for people to exchange opinions and 

information. 

 

Brief history of the World Wide Web 

The World Wide Web was developed by British physicist and computer scientist Timothy 

Berners-Lee as a project within the European Organization for Nuclear Research (CERN) in 

Geneva, Switzerland. Berners-Lee combined several existing ideas 

into a single system to make it easier for physicists to use data on the 

internet. Most important, he added multimedia—the ability to 

include graphics—to the hyperlink concept found in a previous 

internet service known as gopher. Berners-Lee had begun working 

with hypertext in the early 1980s. An early prototype 

implementation of the Web became operational at CERN in 1989, 

and the idea quickly spread to universities in the rest of the world.  

 

Groups at the National Center for Supercomputing Applications at 

the University of Illinois at Urbana-Champaign researched and 

extended Web technology. They developed the first browser that was used at many sites, 

named Mosaic, in 1993. To allow the Web to be accessed from a wide variety of computer 

systems, researchers built multiple versions of Mosaic. Each version was designed to be used 

with a specific operating system, the software that controls the computer. Within a year, 

computer programmer Marc Andreessen had formed a commercial company, Netscape 

Communications Corporation, to build and sell Web technologies. 

 
 

Hypertext Markup Language (HTML) 

Hypertext Markup Language or HTML is the standard text-formatting language for 

documents on the World Wide Web. HTML documents are text files that contain two parts: 

content that is meant to be rendered on a computer screen; and markup or tags, encoded 

Fig. 17.4: Tim Berners-Lee 
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information that directs the text format on the screen and is generally hidden from the user. 

HTML is a subset of a broader language called Standard Generalized Markup Language 

(SGML), which is a system for encoding and formatting documents, whether for output to a 

computer screen or to paper. 

 

Some tags in an HTML document determine the way certain text, such as titles, will be 

formatted. Other tags cue the computer to respond to the user's actions on the keyboard or 

mouse. For instance, the user might click on an icon and that action might call another piece 

of software to display a graphic, play a recording, or run a short movie. Another important 

tag is a link, which may contain the Uniform Resource Locator (URL) of another document. 

The URL can be compared to an address where a particular document resides (more on URL 

later). The document may be stored on the same computer as the parent document or on any 

computer connected to the World Wide Web. The user can navigate from document to 

document simply by clicking on these links. HTML also includes markups for forms, that let 

the user fill out information and electronically send, or e-mail, the data to the document 

author, initiate sophisticated searches of information on the Internet, or order goods and 

services. 

To be able to navigate the World Wide Web one must use a browser, which interprets the 

HTML tag in a document and format the content for screen display. Since HTML is an 

accepted standard, anyone can build a browser without concerning themselves with what 

form various documents will assume, unlike documents produced by typical word processors, 

which must be translated into a different format if another word processing application is 

used. Most sites on the World Wide Web adhere to HTML standards and, because HTML is 

easy to use, the World Wide Web has grown rapidly. HTML continues to evolve, however, 

so browsers must be upgraded regularly to meet the revised standards. 

 
 

File Transfer Protocol (FTP) 

File Transfer Protocol or FTP is a method of transferring files from one computer to another. 

The protocol is a set of rules that ensures a file is transmitted properly to the receiving 

computer. A computer that stores files that can be retrieved using FTP is called an FTP site or 

FTP server. FTP is part of the Transmission Control Protocol/Internet Protocol (TCP/IP), the 

system that enables different types of computers and networks on the Internet to 

communicate. 

 
 

Transmission Transfer Protocol 

TCP/IP or Transmission Control Protocol/Internet Protocol is a set of rules that enables 

different types of computers and networks on the Internet to communicate with one another. 

TCP/IP was originally developed by the United States Department of Defense for computers 

using the UNIX operating system, but it is now used by every computer, regardless of 

operating system, on the Internet. TCP defines how data are transferred across the Internet to 

their destination. IP defines how data are divided into chunks, called packets, for 
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transmission; it also determines the path each packet takes between computers. 

 
 

Uniform Resource Locator (URL) 

Uniform Resource Locator (URL) is an address that points to a particular document or other 

resource on the Internet, used most frequently on the World Wide Web (WWW). A computer 

user can visit an Internet document by typing its URL into a Web browser or similar 

application used to access the Internet. 

For example, the URL for the main page of someone‘s private Web site is 

http://www.myself.net. The first part of the URL, the part before the colon, represents the 

scheme, or protocol, used to retrieve the document. In this case, http indicates that the 

document is a Web page viewable by a Web browser. Other schemes include ftp (for File 

Transfer Protocol), a way of moving individual files between Internet computers; news (for 

Usenet newsgroup), a forum where users can discuss topics by posting messages; and telnet 

(for Telnet), a means of logging on to an Internet computer and using it remotely.  

The next part of the URL, in this case www.myself.net, is called the domain name. It 

represents the overarching Internet address used by a particular organization or individual. 

Each domain name includes an extension, in this case .net, which identifies the type of 

organization using the address. For example, a domain name with an extension .gov, 

indicates that the user is a government organization. Other common extensions include .com 

(for commercial) and .edu (for education—usually a school, college or university).  

The domain name may be followed by the path, a list of additional names that identify 

subdirectories within that domain. On its own, the domain name www.myself.net identifies 

the main page of the person‘s Web site, but other pages on the site reside in various 

subdirectories branching off the domain. For example, a page describing the food the person 

likes best can be found at http://www.myself,net/favouritefood/, where favouritefood is a 

subdirectory. 

The path may be followed by a specific document name. The URL 

http://www.myself.net/favouritefood/ identifies the first page within the favouritefood 

subdirectory, but there are other pages within that subdirectory. For example, a page 

describing the method of preparing that food resides at 

http://www.myself.net/favouritefood/preparation.html, where preparation.html is the 

document name.  

URLs are case-sensitive, which means that uppercase and lowercase letters are considered 

different letters, so a user has to enter a URL with all letters in the correct case. URLs on the 

WWW are accessed with browsers, or computer programs that can connect to the Internet 

and display Web pages.  
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IP Address 

Internet Address is the identifying number that enables any computer on the Internet to find 

any other computer on the network. It consists of four sets of numbers separated by periods—

for example, 123.456.78.90. The Internet address, also called the IP address, is translated into 

a word-based address. 

 
 

Email 

E-Mail is an abbreviation of the term electronic mail which is a method of transmitting data, 

text files, digital photos, or audio and video files from one computer to 

another over an intranet or the Internet. E-mail enables computer users to send 

messages and data quickly through a local area network or beyond through the 

Internet. E-mail came into widespread use in the 1990s and has become a 

major development in business and personal communications. 

 
 

Search engines 

Search Engine is a software program that helps users find information stored on a personal 

computer, or a network of computers, such as the Internet. A user enters search terms, 

typically by typing a keyword or phrase, and the search engine retrieves a list of World Wide 

Web (WWW) sites, personal computer files, or documents, either by scanning the content 

stored on the computers or computer networks being searched or by parsing (analyzing) an 

index of their stored data. 

Search engines are most often used to find pages, files, news, images, and other data on the 

Web. Some of the most popular Web search engines include Google Inc., Microsoft Network 

(MSN) Search, Yahoo! Inc and America Online (AOL). Each can be accessed from any Web 

browser, and each can be used for free.  
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These engines operate by building—and regularly updating—an enormous index of Web 

pages and files. This is done with the help of a Web crawler, or spider, a kind of automated 

browser that continuously trolls the Web, retrieving each page it finds. Pages are then 

indexed according to the words they contain, with special treatment given to words in titles 

and other headers. When a user inputs a query, the search engine then scans the index and 

retrieves a list of pages that seem to best fit what the user is looking for. Search engines often 

return results in fractions of a second. 

Generally, when an engine displays a list of results, pages are ranked according to how many 

other sites link to those pages. The assumption is that the more useful a site is, the more often 

other sites will send users to it. But this is not the only way of ranking results. Dozens of 

other criteria are used, and these will vary from engine to engine. 

Many times, search results will also include what are called sponsored links, links that are 

ranked high in the search results or are prominently displayed because third-party companies 

pay a fee to the search engine. More often than not, sponsored links are labeled as such, but 

inexperienced internet users often have trouble distinguishing between sponsored pages and 

unsponsored results. Sponsored links provide search engines with their primary source of 

revenue. 

 

Blogs 

Blogging is the frequent and chronological publication on the Web of personal thoughts and 

opinions for other internet users to read. The name, coined in the late 1990s, derives from 

―Web logging.‖ The product of blogging is known as a ―blog.‖ There are millions of blogs on 

the Internet. In addition to thoughts and opinions, many bloggers also use their 

blogs to recommend books, music, and links to other sites on the World Wide 

Web.   

Blogging predates the late 1990s. People kept blogs long before the term was 

coined, but the trend has gained momentum with the introduction of 

automated publishing services. Tens of thousands of people use these services 

to publish their blogs. Among the notable publishing services are Radio and Blogger and 

MSN Spaces.  

The form of a blog is very much dependent on the individual who keeps it. Most blogs are a 

mix of what is happening in a person's life and what they feel about things they see on the 

Web. In this respect, they are a kind of hybrid diary and guide, although there are as many 

unique types of blogs as there are people who keep them. The popularity of blogging has 

given rise to a number of tools that can remind you about blogs you read or that generate 

more views of your blog. 

For instance, Blogarithm is a service that lets users subscribe to blogs and be notified by e-

mail when they have new content. Despite being open to public scrutiny, blogs are not really 

intended for mass consumption. The role of the blog is probably best expressed by Stefan 
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Glanzer, one of the founders of blogging system 20six: 'If you want to reach millions you 

book an ad on TV and if you want to reach one person you use e-mail or the telephone. But if 

you want to reach between 5 and 500 people a blog is the ideal tool to communicate.' 

However, some specialized search engines look principally at blogs, and as a result blogs are 

available to anyone on the Internet with access to a good search engine. 

Many critics of the mainstream media use blogs to present information reported by 

international news or to critique what they see as the shortcomings or biases of the major 

media outlets. Many journalists also maintain blogs as a form of reporting or commentary. 

Academic experts have also adopted blogs to comment on developments in their fields or to 

offer their analysis of domestic and international news.  

Although primarily for personal expression, there is a trend to use blogs in business as an 

informal discussion medium. Some companies have used blogs to provide a forum for 

discussion of new ideas and products. 

 

Chats 

Chats are text communication between two or more people via computer which are 

simultaneous. That is one person types a message on their keyboard, and the person or people 

with whom they are communicating see the message appear on their monitors and can 

respond. Unlike E-mail messages which may not be delivered, read and responded to until 

some time elapses, chats responses are immediate, and that decisions 

on something could be reached that very moment 

Chat requires each user to have a computer connected to an electronic 

network. The network might be a local area network within a 

business, or it might be the Internet. Users also need a chat system, 

software that controls the connection between the computers of the 

people who are chatting. Many chat systems are free, though some of 

them a done over secure links. 

Chat is most commonly used for social interaction. For example, people might use chat to 

discuss topics of shared interest or to meet other people with similar interests. Businesses and 

educational institutions are increasingly using chat as well. Some companies hold large 

online chat meetings to tell employees about new business developments. Such meetings are 

particularly useful for companies whose employees are spread out. Small workgroups within 

a company may use chat to coordinate their work. In education, teachers may use chat to help 

students practice language skills and to provide mentoring to students. 

 
 

Discussion board 

A discussion board also known as forum is an online discussion site where people can hold 

conversations in the form of posted messages. Unlike chats, the messages are not shown in 

the actual time they were posted, and to see new messages the forum page must be reloaded. 

Also, depending on the access level of a user and/or the forum set-up, a posted message 
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might need to be approved by a moderator before it becomes visible. Messages must conform 

to specific standards; otherwise the moderator will reject it.  

Forums have their own language; e.g. A single conversation is called a 'thread'. A forum is 

hierarchical or tree-like in structure: forum - subforum - topic - thread - reply. 

Depending on the forum set-up, users can be anonymous or have to register with the forum 

and then subsequently login in order to post messages. Usually you do not have to login to 

read existing messages. A discussion board can look like the one below. 

 

 
 

Synchronous communication 

When devices exchange data, there is a flow or stream of information between the two. In 

any data transmission, the sender and receiver must have a way to extract individual 

characters or blocks (frames) of information. Imagine standing at the end of a data pipe. 

Characters arrive in a continuous stream of bits, so you need a way to separate one block of 

bits from another. In asynchronous communications, each character is separated by the 

equivalent of a flag so you know exactly where characters are located. In synchronous 

communications, both the sender and receiver are synchronized (made to work at the same 

time) with a clock or a signal encoded into the data stream. In synchronous communications, 

the sender and receiver must synchronize with one another before data is sent.  

 

/wiki/Login
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Asynchronous communication 

Asynchronous communication is a form of communication which does not require all parties 

involved in the communication to be present and available at the same time. In asynchronous 

communication, some amount of time may pass before a person responds to a message. In a 

discussion forum, which is a form of asynchronous communication, a message sits in a 

message queue for other people to read and respond to at any time, or until the message falls 

out of the queue. In the case of discussion forums and e-mail, delayed communication gives 

respondents time to think about their response and gather information from other sources 

before responding. Another form of asynchronous communication is text messaging over 

mobile phones. 

 

Listserv 

Listserv is a type of software that automatically manages computer mailing lists on the 

Internet. It consists of a set of email addresses for a group in which the sender can send one 

email and it will reach a variety of people These lists, sometimes called discussion groups, 

focus on specific topics and membership usually is open to anyone who requests it. Listserv 

replaces manual management and can add and remove members and distribute new messages 

posted to the list to all members through e-mail. 

 
 

Electronic discussion  

Electronic discussion occurs whenever a group of users come together to discuss a particular 

topic. This can happen in chat rooms, instant messaging, and listserv discussion lists. 

Although there are several methods of electronic discussion, the purpose of each method is to 

bring together persons of like interests to share ideas, opinions, problems and solutions. 

Generally they get started because someone decides to offer discussion on a particular topic. 

Then they find a networked computer that can "host" the discussion and put out an 

announcement that the discussion group exists. Interested network users can then "subscribe" 

to the discussion. From then on, any message sent to the discussion is automatically 

distributed as e-mail to all subscribers. When a person initially requests to subscribe to a 

listserv list, they will be sent an e-mail message that contains instructions on how to subscribe 

and unsubscribe, suspend (such as when a person is on vacation and doesn't wish to have 

their e-mail box clogged with messages in their absence), and other useful information. For 

every list to which you subscribe, these instructions should be printed and retained in a handy 

place for future reference. 

Listserv lists can be "moderated" or "unmoderated." The distinction denotes whether 

messages are automatically forwarded to all subscribers (unmoderated) or whether messages 

are first screened and may be combined with other similar messages by a human being before 

being sent to subscribers (moderated). All other things being equal, moderated lists are by far 

more useful than unmoderated ones. When messages are automatically forwarded it is 

possible for subscribers to receive a lot of spurious messages (for example, replies mistakenly 

directed at the list rather than an individual, botched subscription or unsubscription messages, 

or "junk mail" from groups selling products you don't want.). 

http://en.wikipedia.org/wiki/Email
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Electronic discussions can be extremely useful and professionally rewarding, but they can 

also be useless. They are guaranteed to be time consuming and can consume all of your time 

if you let them. Whether they are useful or useless depends upon a number of variables, only 

some of which are under your control.  

Electronic discussions can also be "open" or "closed." Anyone can subscribe to an open 

discussion, whereas a closed discussion is constrained to a particular group of persons. 

Voice Over Internet Protocol (VOIP) 

Voice Over Internet Protocol (VOIP) is a method for making telephone calls over the Internet 

by sending voice data in separate packets, just as e-mail is sent. Each packet is assigned a 

code for its destination, and the packets are then reassembled in the correct order at the 

receiving end. Recent technological improvements have made VOIP almost as seamless and 

smooth as a regular telephone call. 

 
 

Bandwidth  

Bandwidth is the transmission capacity of the lines that carry the internet's electronic traffic. 

The greater the bandwidth, the more data that can be moved at one time. Lack of bandwidth 

can impose severe limitations on the ability of the internet to quickly deliver information.

 
 

DNS 

Domain Name System (DNS) is a method of translating Internet addresses so that computers 

connected in the Internet can find each other. A DNS server translates a numerical address 

assigned to a computer (such as 123.46.228.91) into a sequence of words, and vice versa. A 

DNS name, written in lowercase letters with words separated by periods, takes the form of 

username@computer.zonename (for example: king@home.com). Username is the name or 

account number used to log on. The hostname (home in the example above) is the name of 

the computer or Internet provider; it may consist of several parts. Zonename indicates the 

type of organization. Common zone names include com (commercial organization), edu 

(educational), gov (government), and net (networking organization).  

 
 

FEATURES AND USE OF BROWSER WINDOW  

 

The growth of the internet and consequently websites has resulted in the creation of more and 

more web browsers. Some popular web browsers such are Mozilla Firefox, Safari and Opera 

are very common on computer systems world wide, but one web browser which is almost 

ubiquitous is Internet Explorer. Internet Explorer is the most popular web browser in the 

world because it accompanies the most popular Operating System in the world – Windows; 

and whenever a person installs any Windows operating system, they automatically install 

Internet Explorer. For this reason we are going to consider the features of Internet Explorer. 
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A typical Internet Explorer window is made up of a: 

 Title bar 

 Menu bar 

 Address bar 

 Standard bar 

 Main window 

 Status bar 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Title Bar 

The title bar displays the logo of Internet Explorer, the name of the current web page, the 

name of the browser (Internet Explorer) the close, minimize and maximize buttons. The title 

bar takes the theme colour. 

 
 

Menu Bar 

Next to the title bar is the menu bar which contains a list of options from which the user can 

select in order to perform a desired action, such as choosing a command or applying a 

particular format to part of the browser.  

Title Bar Address Bar 

Status Bar 

Standard Toolbar 

Main Window 

Menu Bar 
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Address Bar 

The address bar contains the address that points to a particular document or other resource on 

web. A user can visit any website by typing its address into the address bar. 

 
 

Standard Bar 

The standard bar contains tools which are shortcuts to some common commands such as 

history, which automatically store web pages visited recently; favorites which contains 

bookmarks or pages stored by the user, back and previous which navigate to web page view 

before and after the current one etc. 

 
 

Main Window 

The main information of the web page is displayed in the main window. The main window 

normally contains tabs with names for navigating to various categories of the website. It may 

also contain scroll bars for scrolling to the parts of the page which extends the window. 

 
 

Status Bar 

This bar which is located at the bottom of the page displays the progress of file transfer from 

the internet to the computer. It also shows the current website and the various files as they are 

downloaded. 

 
 

BROWSING THE INTERNET 

 

One of the most interesting things to do when sitting behind your computer is flipping from 

one web page to another; this is referred to as browsing or surfing the internet. To be able to 

browse the internet with ease, you must be familiar with the features discussed above and 

how they work. 

 
 

Using the address 

 

It is easier to visit a web page if you know the web address. To use the address: 

 Launch your web browser (such as Internet Explorer) 

 In the Address Bar, type the web address. For example, http://www.yahoo.com, or 

you can choose to omit the http:// and straight away type yahoo.com. some web 

address will require you to at least type the www. 

 

 

 

http://www.yahoo.com/


rkeyk 

 

 

155 

 
The Internet 

 Press Enter. The web page loads and the various files (such as text, graphics and 

multimedia) are downloaded into the webpage. 

 

 

Using the Standard Toolbar  

The Standard Toolbar contains shortcuts to some web pages. To visit a page using the 

Standard Toolbar, just click on the appropriate shortcut. 
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After completing this chapter, you should be able to: 

 

i. Send and access e-mail messages with attachments. 

ii. Use internet to chat. 

 

 

 

 

 
OBJECTIVES 
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USING THE INTERNET TO  

COMMUNICATE 

 

 

INTRODUCTION  

 

One of the fascinating parts of the internet is the communication tools attached to it, namely, 

e-mail, chats, discussion board, videoconferencing and a host of others. Indeed, the internet 

has really made communication much easier and effective.  

It is more efficient, economical and reliable to send some vital information through e-mail 

than to do that through the post; and when a person receives a e-mail he or she will not be 

under any compulsion to answer the e-mail there and then, but is given the time to think over 

his exact words. For a much faster communication, on e could employ chats, where the flow 

of information from one person to another is relatively quick. Finally, what could be better 
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than seeing the person you are talking to face to face, even if you are oceans apart? That is 

made possible by another method of communication using the internet known as 

videoconferencing.  

In this section we are going to consider how to use various methods of communication with 

the internet. 

 
 

SENDING, ACCESSING E-MAILS MESSAGES  

 

E-mails are the most common method of internet communication; and most people gain their 

acquaintance with communication over the internet with e-mails. Before we learn how to use 

e-mails, let us start off with knowing how it is created. 

 
 

How to create an e-mail account 

When we talk of e-mails, two names come to mind – Google and Yahoo. Let us consider how 

to create a e-mail account with the. Follow these steps to create a Google e-mail (googlemail 

or gmail) account: 

 

 Launch the internet browser. 

 In the address bar, type http://www.gmail.com. That opens the Google mail website. 

(see below) 

 

 

 

http://www.gmail.com/
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Click on Create an account. A questionnaire window appears.  

 

 

Fill it out. Once done, a confirmation page appears with the information you provided which 

is your sign in information. Print or copy that information and keep it safe and secure. 

 

When you sign in for the first time, you will see some messages from the Gmail Team. 
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You have created a new e-mail account. If you are not a fun of Google and prefer another e-

mail host instead, the method is very similar to the one above. Just enter the URL – for 

example, http://www.yahoomail.com. The Yahoo Mail website opens as below. Follow the 

next step to create a Yahoo mail account. 

 
 

Once your e-mail account is created you can send and receive e-mail messages. Let us 

consider how to send an e-mail. 

 

Sending E-mail Messages 

 If you are using Gmail or Yahoo, after you have successfully signed in, you 

will see the Compose Mail link click on it. this opens the Compose Mail 

window like the one below. 

 In the To text box, type in the email address of the recipient. If you want to 

send the mail to more than one recipient, click Cc, and type in the e-mail 

addresses of the other recipients.  

 In the Subject text box, type in a keyword or phrase as an insight to the 

message you are about to send. 

 In the main window, type your message. If you want to add attachments 

such as graphics, audio, video etc, click Attach File. This opens the Insert File 

dialogue box. search for the item you want to attach and then click Attach or OK. 

 When you are done, click Send. 
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Accessing E-mail messages 

To read an e-mail sent to you:  

Click Inbox. All the messages you have received are presented by subjects. Click 

on one to read the full message. If the e-mail contains an attachment, you will see 

the attachment sign          Click on it to download or open the attached file.  
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Accessing Information from the Internet  

 

 

After completing this chapter, you should be able to: 

 

i. Use the uniform Resource Locator (URL) and search engines to access 

 information. 

ii. Download information from the internet. 

iii. Access, copy and paste information form the internet to different application. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chapter
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ACCESSING INFORMATION FROM  

THE INTERNET 

 

 

 

INTRODUCTION 

The internet presents a vast array of information to the public. No matter what the subject 

criteria of the user is, they are apt to get something on it. Accessible information on the 

internet could be text, video, audio, pictures and other graphics. While some information are 

free and easily accessible, other can only be accessed after payment of a fee. Some other 

information, though free, needs to be subscribed for before they can be access.  

 

OBJECTIVES 
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Some websites, especially news groups, continuously update available information, while 

others allow the information to become worn-out. Some information are based on facts while 

others are the opinions of some persons which could be slanderous.  

The internet is very broad and there are a lot of ways of retrieving information from it. some 

of the ways of accessing information from the internet are by: 

 Using Uniform Resource locator (URL). 

 Using search engines. 

 Subscribing to a mail list 

 

Using Uniform Resource Locator (URL) 

Every website has got its own unique address also known as Uniform Resource Locator 

(URL). If you know the exact URL of the website, you can easily type it in the address bar 

and the website will open for you. Users must bear in mind that the URL no matter the 

number of separate words it contains is typed as a single word with no spacing or punctuation 

marks. You should also remember that any spelling mistake will either open a different 

website or generate an error message from the browser.  

 

Using Search Engines 

If you do not know the actual URL of the website you want you can type a word or phrase in 

the URL. The search engine gives you a wide array of websites which have information about 

the searched item. When researching for information on the Web, it is advisable to use the 

search engine since it presents a lot of sites with a lot of information concerning the searched 

item. You should also know that not all the information displayed after a search is needs. It is 

very necessary to read through the search result thoroughly in order to find the right 

information which matches you searched item.  

 

 

 

 

 

 

 

 

 

 

 

Downloading information from the internet 

 

Some items on the Web such as software, music etc. are free to download; others can be 

downloaded after meeting a particular requirement such as paying a fee. Some software, 

though not free, can be downloaded and tried for a few days or weeks. When downloading 

information from the internet, you must be sure that the information is coming from a 
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trustworthy source. Some diabolical people intentionally camouflage viruses, worms and 

other software-related threat as credible software and upload them on the internet. you 

already know what software-related threats do, don‘t you? 

 

Copying and pasting information from the internet to a different application 

 

Most of the information on the internet, especially text, can be copied and pasted into a third-

party software, such as Microsoft Word. You can use he same method we used in copying or 

cutting and pasting information in Word –  

 Drag-select the information, if it is text. 

 Right-click on it and then select Copy from the pop-up menu or use the keyboard 

shortcut, CTRL +C to copy the information to the clipboard.  

 Open the application in which you want to paste the information, e.g. Word. 

 Right click the document area and select Paste from the pop-u menu or use the 

keyboard shortcut CTRL +V to paste the information. 

 

If the information is a picture, clipart or any other graphic. 

 Right-click it and select Copy from the pop-up menu.  

 Open the third-party software and then select Paste to paste it there. 
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After completing this chapter, you should be able to: 

 

i. Identify Spreadsheet Packages. 

ii. Explain related concepts and terminologies. 

iii. Identify features in spreadsheet window. 

iv. Identify types of data and state their uses. 

v. Launch and edit spreadsheet applications. 

vi. Create and save Workbook. 

vii. Construct and insert simple formula. 

 
OBJECTIVES 

 

 

 

 

 

 

 

 

 

Chapter
 14 

SPREADSHEET APPLICATION 

 

INTRODUCTION 

Entering financial details and transactions in a ledger book is  an arduous activity which most 

accountant would rather not do; and it is even more painful if a single mistake is committed. 

Software developers, in trying to find a remedy to this tiring process came out with a 

programme known as a spreadsheet.  

A Spreadsheet is a program that looks like a paper, accounting worksheet, commonly used 

for budgets, forecasting, and other finance-related tasks.  In a spreadsheet program, data and 

formulas to calculate those data are entered into ledger-like forms. Spreadsheet programs use 

rows and columns of cells; each cell can hold text or numeric data or a formula that uses 

values in other cells to calculate a desired result. To ease computation, these programs 

http://en.wikipedia.org/wiki/Worksheet
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include built-in functions that perform standard calculations. Spreadsheets are frequently 

used for financial information because of their ability to re-calculate the entire sheet 

automatically after a change to a single cell is made. 

Depending on the program, a single spreadsheet can contain anywhere from thousands to 

millions of cells. Some spreadsheet programs can also link one spreadsheet to another that 

contains related information, and can update data in linked spreadsheets automatically. 

 
 

SPREADSHEET PACKAGES 

 

Spreadsheet applications have flooded the market, all with the aim of making the work of 

accountants easier. Some of the common spreadsheet packages have been discussed below. 

 
 

Microsoft Excel 

Microsoft Office Excel is a spreadsheet application written and distributed by Microsoft for 

Microsoft Windows and Mac OS X. It features calculation, graphing tools, pivot tables and a 

macro programming language called VBA (Visual Basic for Applications). It has been a very 

widely applied spreadsheet for these platforms. Excel forms part of Microsoft Office.  

Microsoft Excel has the basic features of all spreadsheets, using a grid of 

cells arranged in numbered rows and letter-named columns to organize 

data manipulations like arithmetic operations. It has a battery of supplied 

functions to answer statistical, engineering and financial needs. In 

addition, it can display data as line graphs, histograms and charts, and 

with a very limited three-dimensional graphical display. It allows 

sectioning of data to view its dependencies on various factors from 

different perspectives (using pivot tables and the scenario manager). And it has a 

programming aspect, Visual Basic for Applications, allowing the user to employ a wide 

variety of numerical methods, for example, for solving differential equations of mathematical 

physics, and then reporting the results back to the spreadsheet. Finally, it has a variety of 

interactive features allowing user interfaces that can completely hide the spreadsheet from the 

user, so the spreadsheet presents itself as a so-called application, or decision support system 

(DSS), via a custom-designed user interface, for example, a stock analyzer, or in general, as a 

design tool that asks the user questions and provides answers and reports. In a more elaborate 

realization, an Excel application automatically can poll external databases and measuring 

instruments using an update schedule, analyze the results, make a Word report or Power Point 

slide show, and e-mail these presentations on a regular basis to a list of participants. 

 
 

Lotus 1-2-3 

Lotus 1-2-3 is a spreadsheet program which has three main capabilities, hence the name 1-2-

3. Apart from being a spreadsheet program, it also does some database as well as word 

processing operations. Data features included sorting data in any defined rectangle, by order 

http://en.wikipedia.org/wiki/Financial
http://en.wikipedia.org/wiki/Spreadsheet
http://en.wikipedia.org/wiki/Microsoft
http://en.wikipedia.org/wiki/Microsoft_Windows
http://en.wikipedia.org/wiki/Mac_OS_X
http://en.wikipedia.org/wiki/Pivot_table
http://en.wikipedia.org/wiki/Visual_Basic_for_Applications
http://en.wikipedia.org/wiki/Microsoft_Office
http://en.wikipedia.org/wiki/Pivot_table
http://en.wikipedia.org/wiki/Microsoft_Word
http://en.wikipedia.org/wiki/Microsoft_PowerPoint
http://en.wikipedia.org/wiki/Spreadsheet
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of information in one or two columns in the rectangular area. The word processing 

capabilities come from its ability to justify text in a range into paragraphs.  

 
 

VisiCalc 

VisiCalc was the first spreadsheet that combined all essential features of modern spreadsheet 

applications, such as WYSIWYG interactive user interface, automatic recalculation, status 

and formula lines, range copying with relative and absolute references, 

formula building by selecting referenced cells. VisiCalc is the first 

application that turned the personal computer from a hobby for computer 

enthusiasts into a business tool. Though challenged, it is usually 

considered the first electronic spreadsheet. It was the leading spreadsheet 

when DOS was the dominant operating system. 

 
 

Apple Numbers 

Numbers is Apple Inc.'s spreadsheet software, part of iWork. It focuses on usability and the 

elegance of chart presentation. Numbers completed Apple's productivity suite, making it a 

viable competitor to Microsoft Office. It lacks features such as pivot table providing Table 

Categories as a simpler alternative. 

 

OpenOffice.org Calc 

OpenOffice.org Calc is a freely available, open-source program modelled after Microsoft 

Excel. Calc can both open and save in the Excel (XLS) file format.  Calc can be acquired as 

both an installation file and a portable program, capable of being run from a device such as a 

USB memory drive. It can be downloaded from the OpenOffice.org website. 

 

Gnumeric 

Gnumeric is a free spreadsheet program that is part of the GNOME Free Software Desktop 

Project and has Windows installers available. It is intended to be a free replacement for 

proprietary spreadsheet programs such as Microsoft Excel, which it broadly and openly 

copies. Gnumeric has the ability to import and export data in several file formats. 

 
 

Web based spreadsheets 

With the advent of advanced web technologies such as Ajax circa 2005, a new generation of 

online spreadsheets has emerged. Equipped with a rich Internet application user experience, 

the best web based online spreadsheets have many of the features seen in desktop spreadsheet 

applications. Some of them have strong multi-user collaboration features. Some of them offer 

real time updates from remote sources such as stock prices and currency exchange rates. 

 

http://en.wikipedia.org/wiki/WYSIWYG
http://en.wikipedia.org/wiki/VisiCalc
http://en.wikipedia.org/wiki/Application_software
http://en.wikipedia.org/wiki/Personal_computer
http://en.wikipedia.org/wiki/DOS
http://en.wikipedia.org/wiki/Numbers_(software)
http://en.wikipedia.org/wiki/Apple_Inc.
http://en.wikipedia.org/wiki/IWork
http://en.wikipedia.org/wiki/Microsoft_Office
http://en.wikipedia.org/wiki/Pivot_table
http://en.wikipedia.org/wiki/OpenOffice.org_Calc
http://en.wikipedia.org/wiki/Microsoft_Excel
http://en.wikipedia.org/wiki/Microsoft_Excel
http://en.wikipedia.org/wiki/Microsoft_Excel
http://en.wikipedia.org/wiki/Gnumeric
http://en.wikipedia.org/wiki/Free_software
http://en.wikipedia.org/wiki/GNOME
http://en.wikipedia.org/wiki/Proprietary_software
http://en.wikipedia.org/wiki/Microsoft_Excel
http://en.wikipedia.org/wiki/World_Wide_Web
http://en.wikipedia.org/wiki/Ajax_(programming)
http://en.wikipedia.org/wiki/List_of_online_spreadsheets
http://en.wikipedia.org/wiki/Rich_Internet_application
http://en.wikipedia.org/wiki/Real_time_business_intelligence
http://en.wikipedia.org/wiki/Stock_price
http://en.wikipedia.org/wiki/Exchange_rate
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RELATED CONCEPTS AND TERMINOLOGIES 

All spreadsheet applications are characterized by some features such as:  

 Rows  

 Columns  

 Cells 

 Work sheet 

 Workbook  

Rows  

The horizontal space that runs across the spreadsheet window is referred to as a 

row. Rows are numbered from 1 to 1,048,576; with each row being assigned with a 

unique number. If you want to go to the last row at the bottom, hold down the Ctrl 

key and tap the down arrow key. 

 

 

Columns  

Columns are the vertical spaces tat run through a spreadsheet window. Each column has an 

assigned letter or letters. For example the first column is labeled A, while the 78
th

 

column is labeled CZ. If you want to go to the last column on the right, hold down the 

Ctrl key and tap the right arrow key. 

 

 

 

 

 

 

 

 



rkeyk 

 

 

168 

 
Spreadsheet Application  

Cells 

Cells are the intersection of rows and columns. Each row and column in a spreadsheet is 

unique, so each cell can be uniquely identified. For example, cell B11, at the intersection of 

column B and row 11. Each cell is displayed as a rectangular space that can hold text, a 

value, or a formula. Similarly, although less familiarly, a cell is an addressable (named or 

numbered) storage unit for information. A binary cell, for example, is a storage unit that can 

hold 1 bit of information—that is, it can be either on or off. 

 

Worksheet  

An array of cells is called a "sheet" or "worksheet". In most implementations, many 

worksheets may be located within a single spreadsheet. A worksheet is simply a subset of the 

spreadsheet divided for the sake of clarity. Functionally, the spreadsheet operates as a whole 

and all cells operate as global variables within the spreadsheet ('read' access only except its 

own containing cell). 

 
 

Workbook 

Microsoft Excel allows a use to work in more than one worksheet. A collection of worksheets 

is known as a workbook. Excel starts with a workbook of three worksheets. The user can add 

more sheets to the workbook by clicking on the ―Insert Worksheet‖ button located below the 

main window. 

 

FEATURES OF A SPREADSHEET WINDOW 

 

As we have learnt from the previous topics, to understand spreadsheet fully, we must get a 

grip on the various features of a spreadsheet window and how they work. The spreadsheet 

application we are going to consider is Microsoft Office Excel 2007. To begin with, launch 

the application; after it has loaded you will see a window similar to the one below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://en.wikipedia.org/wiki/Global_variable
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The Office Button 

Office Button menu in Excel 2007 have replaced the various menus (such as File, Edit, 

View, and Format) in the Menu Bar just as in Word 2007. This menu contains some of 

the commands that used to appear on the File menu in earlier versions of Word. You can 

open this menu by clicking it. 

 
Quick Access Panel 

In the upper left corner – to the right of the Microsoft Office Button - you will see an area 

called the Quick Access Toolbar.  This area is quite handy as it currently contains several of 

the most used buttons in Office applications – Save, Undo, Redo, Print and Print Preview. 

You can customize this toolbar by adding and removing as many Quick Access button 

choices as you desire.   

 

 

 

Worksheet 

Minimize 
Maximize 

& Close 
Buttons 

Tab  

Worksheet Bar Zoom Controls View Buttons 

Office 
Button 

Quick Access 
Toolbar 

Ribbon Title Bar Groups 
Help 

Button 
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Ribbons 

This is the new term you hear a lot about in 2007 Office.  Ribbons stretch across the top of 

your application screen with features to assist you as you click the Ribbon Tabs. The Ribbon 

replaces all the remaining menus and toolbars that previous versions of Word used. Each tab 

of the Ribbon contains a different set of controls that are linked thematically. Only one tab‘s 

contents can be displayed at a time. To switch tabs, you click the text label at the top 

 

Tabs 

Below the Microsoft Office Button and Quick Access Toolbar we see a series of 

Tabs/Ribbons. Tabs are similar to the Drop Down Menu choices in previous versions of 

Office.  The Tabs are, logically. 

 
Groups 

In the image below, the arrows point to a new topic – Groups. 

 

 

                                                                  

Clipboard Group  

Like Word, the groups in Excel begins with Clipboard. The Clipboard is the temporal storage 

for copied or cut data. To view data on the Clipboard, click the open button located at the 

lower right corner of the Clipboard Group. Refer to the image 

below.  

When you click the open button notice that the Clipboard 

appears on the left side of your screen and shows any text or 

images you have copied or cut.  To close this group, click the 

―X‖ in the upper right corner of the Group. The clipboard allows 

up to 24 items. 

 

 

 

Font  

Notice, in the Font Group area (above), you have the most used Font features.  However, if 

you desire all of the font features, just click the Open Group arrow to the right of Font. 

 

Clipboard Font Alignment Styles Number Cells Editing 

Open 

Grou

p 

Close

Grou

p 
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Alignment 

Excel replaces the Paragraph Group with the Alignment group, which 

is similar to the Paragraph Group in Word.  Notice in the Alignment 

Group area you again have the most used Alignment features.  

However, if you desire all of the alignment features, just click the 

Open Group arrow to the right of Alignment. 

 

Numbers, Styles, Cell and Editing 

Hang on!  The last three groups in Excel are Numbers, Styles, Cells and Editing. We will get 

to know them as we go along, but in the mean time click opening each of them to see how 

they look and function. 

 
 Formulae Bar 

 

The formulae bar, as it name implies, enable formulae to be entered into the Worksheet. The 

Formula Bar comes in handy when one needs to use a special formula. We will have a need 

for it shortly. 

 

Worksheet Bar 

The bar just above the Status Bar is the Worksheet Bar, which displays the various 

Worksheet Tabs. Worksheet tabs represent the number of Worksheets available in the 

Workbook. 

 

 

Help facilities 

Having any difficulty with any of the features in Excel - look no further? Just click the 

Help button.  The Help facilities assist a user to get around the Excel environment. To 

access the Help facilities click the Help button located at the extreme right-hand side of the 

Ribbon or press the Help facilities shortcut, F1. This opens the Excel Help.  You can use the 

Table of contents or type a word or phrase to look for and then click Search. 

Worksheet Tab 
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TYPES OF DATA AND THEIR USES 

Data in spreadsheet could be: 

 Number 

 Date 

 Text 

 Currency 

 Fraction  

 

Number 

Use these options to change the format of numbers that are used on the value axis (i.e. The 

chart axis that displays scaled numerical values.) or in the data labels (i.e. The label that 

provides additional information about a data marker, which represents a single data point or 

value that originates from a datasheet cell.) of your chart. Numbers can be used in the 

following ways: 

Category  Click an option in the Category box, and then select the format that you want to 

apply. 

Decimal places  Specify up to 30 decimal places. This box is available only for the Number, 

Currency, Accounting, Percentage, and Scientific categories. 

javascript:AppendPopup(this,'xlvalueaxis_1')
javascript:AppendPopup(this,'xlvalueaxis_1')
javascript:AppendPopup(this,'grdefDataLabel_2')
javascript:AppendPopup(this,'grdefDataLabel_2')
javascript:AppendPopup(this,'grdefDataLabel_2')
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Use 1000 Separator (,)  Select this check box to insert a thousand separator. This check box 

is available only for the Number category. 

Negative numbers  Specify the format in which you want negative numbers to be displayed. 

This option is available only for the Number and Currency categories. 

Symbol  Select the currency symbol that you want to use. This box is available only for the 

Currency and Accounting categories. 

Type  Select the display type that you want to use for a number. This list box is available 

only for the Date, Time, Fraction, Special, and Custom categories. 

Locale (location)  Select a different language that you want to use for the display type of a 

number. This option is available only for the Date, Time, and Special categories. 

Format Code  Allows you to create a custom number format. In the Format Code box, 

make the changes that you want to the currently selected number format, or select this 

number format, and then type your own custom number format. Click Add to apply the 

custom number format to the chart. 

Add  Allows you to apply a custom number format to the chart.  

Delete  Allows you to delete a custom number format. This option is available only after you 

create a custom number format. 

Linked To Source  Select this check box if you want to reference corresponding numbers on 

the worksheet. 

 

Date  

A date is made up of year, month and day. 

Year   The year argument can be one to four digits. Microsoft Excel interprets the year 

argument according to the date system you are using. By default, Excel uses the 1900 date 

system. 

For the 1900 date system 

 If year is between 0 (zero) and 1899 (inclusive), Excel adds that value to 1900 to 

calculate the year. For example, DATE(108,1,2) returns January 2, 2008 (1900+108). 

 If year is between 1900 and 9999 (inclusive), Excel uses that value as the year. For 

example, DATE(2008,1,2) returns January 2, 2008. 

 If year is less than 0 or is 10000 or greater, Excel returns the #NUM! error value. 

For the 1904 date system 

javascript:ToggleDiv('divExpCollAsst_IDA0REJC')
javascript:ToggleDiv('divExpCollAsst_IDAVSEJC')
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 If year is between 4 and 1899 (inclusive), Excel adds that value to 1900 to calculate 

the year. For example, DATE(108,1,2) returns January 2, 2008 (1900+108). 

 If year is between 1904 and 9999 (inclusive), Excel uses that value as the year. For 

example, DATE(2008,1,2) returns January 2, 2008. 

 If year is less than 4 or is 10000 or greater or if year is between 1900 and 1903 

(inclusive), Excel returns the #NUM! error value. 

Month   is a positive or negative integer representing the month of the year from 1 to 12 

(January to December).  

 If month is greater than 12, month adds that number of months to the first month in 

the year specified. For example, DATE(2008,14,2) returns the serial number 

representing February 2, 2009.  

 If month is less than 1, month subtracts that number of months plus 1 from the first 

month in the year specified. For example, DATE(2008,-3,2) returns the serial number 

representing September 2, 2007. 

Day   is a positive or negative integer representing the day of the month from 1 to 31.  

 If day is greater than the number of days in the month specified, day adds that number 

of days to the first day in the month. For example, DATE(2008,1,35) returns the serial 

number representing February 4, 2008.  

 If day is less than 1, day subtracts that number of days plus one from the first day in 

the month. For example, DATE(2008,1,-15) returns the serial number representing 

December 16, 2007. 

Remarks 

 Excel stores dates as sequential serial numbers so they can be used in calculations. By 

default, January 1, 1900 is serial number 1, and January 1, 2008 is serial number 

39448 because it is 39,448 days after January 1, 1900.  

 The DATE function is most useful in formulas where year, month, and day are 

formulas, not constants.  

Inserting a date or time 

 Current date   Select a cell and press CTRL+;  

 Current time   Select a cell and press CTRL+SHIFT+; 

 Current date and time   Select a cell and press CTRL+; then SPACE then 

CTRL+SHIFT+; 
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Text  

There are two ways to import data from a text file by using Microsoft Office Excel: You can 

open the text file in Excel, or you can import the text file as an external data range (external 

data range: A range of data that is brought into a worksheet but that originates outside of 

Excel, such as in a database or text file. In Excel, you can format the data or use it in 

calculations as you would any other data.). To export data from Excel to a text file, use the 

Save As command. 

There are two commonly used text file formats: 

 Delimited text files (.txt), in which the TAB character usually separates each field of 

text.  

 Comma separated values text files (.csv), in which the comma character (,) usually 

separates each field of text. 

You can change the separator character that is used in both delimited and .csv text files. This 

may be necessary to make sure that the import or export operation works the way that you 

want it to.  

 You can import or export up to 1,048,576 rows and 16,384 columns.  

Import a text file by opening it 

You can convert a text file that you created in another program to an Excel workbook by 

using the Open command. 

1. Click the Microsoft Office Button , and then click Open.  

The Open dialog box appears. 

2. In the Files of type box, select Text Files.  

3. In the Look in list, locate and double-click the text file that you want to open:  

 If the file is a text file (.txt), Excel starts the Import Text Wizard.  

Follow the instructions in the Text Import Wizard. Click Help for more 

information about using the Text Import Wizard or see Text Import Wizard. 

When you are done with the Wizard, click Finish. 

 If the file is a .csv file, Excel automatically converts the text file and opens it.  

 NOTE    When Excel opens a .csv file, it uses the current default data format 

settings to interpret how to import each column of data. You may want more 

flexibility in converting columns to different data formats by using the Import 

Text Wizard. For example, the data format of a data column in the .csv file may 
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be MDY, but Excel's default data format is YMD, or you want to convert a 

column of numbers with leading zeros to text so you can preserve the leading 

zeros. To use the Import Text Wizard, you can change the file type to .txt before 

you open it, or Import a text file by connecting to it. 

Importing a text file by connecting to it 

You can import data from a text file as an external data range (external data range: A range of 

data that is brought into a worksheet but that originates outside of Excel, such as in a database 

or text file. In Excel, you can format the data or use it in calculations as you would any other 

data.). 

1. Click the cell where you want to put the data from the text file.  

2. On the Data tab, in the Get External Data group, click From Text.  

3. In the Look in list, locate and double-click the text file that you want to import.  

Follow the instructions in the Text Import Wizard. Click Help for more 

information about using the Text Import Wizard, or see Text Import Wizard. When 

you are done with the Wizard, click Finish. 

4. In the Import Data dialog box, do the following:  

 Optionally, click Properties to set refresh, formatting, and layout options for the 

imported data.  

 Under Where do you want to put the data?, do one of the following:  

 To return the data to the location that you selected, click Existing 

worksheet.  

 To return the data to the upper-left corner of a new worksheet, click New 

worksheet. 

5. Click OK.  

Excel puts the external data range in the location that you specify. 

If Excel does not convert a column to the format that you want, you can convert the data after 

you import it. For more information, see the following Help topics: 

 Convert numbers stored as text to numbers  

 Convert dates stored as text to dates  

 TEXT  

 VALUE 
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Exporting data to a text file by saving it 

You can convert an Excel worksheet to a text file by using the Save As command. 

1. Click the Microsoft Office Button , and then click Save As. The Save As dialog 

box appears.  

2. In the Save as type box, choose the text file format for the worksheet.  

 NOTE    The different formats support different feature sets. For more information 

about the feature sets that are supported by the different text file formats, see Excel 

formatting and features that are not transferred to other file formats. 

3. In the Save in list, browse to the location where you want to save the new text file.  

4. In the File name box, review the name that Excel proposes for the new text file, and 

change it if necessary.  

5. Click Save.  

6. A dialog box appears, reminding you that only the current worksheet will be saved to 

the new file. If you are certain that the current worksheet is the one that you want to 

save as a text file, click OK. You may save other worksheets as separate text files by 

repeating this procedure for each worksheet.  

7. A second dialog box appears, reminding you that your worksheet may contain 

features that are not supported by text file formats. If you are only interested in saving 

the worksheet data into the new text file, click Yes. If you are unsure and would like 

to know more about which Excel features are not supported by text file formats, click 

Help for more information. 

For more information about saving files in other formats, see Save a workbook in another file 

format. 

Changing the delimiter that is used in a text file 

For a delimited text file, you can change the delimiter from a TAB character to another 

character in step 2 of the Text Import Wizard. In step 2, you can also change the way that 

consecutive delimiters, such as consecutive quotes, are handled. For more information about 

using the Text Import Wizard, see Text Import Wizard. 

Changing the separator in all .csv text files 

1. Click the Windows Start menu.  

2. Click Control Panel.  

ms-help://MS.EXCEL.12.1033/EXCEL/content/HP10014105.htm
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3. Open the Regional and Language Options dialog box.  

4. Click the Regional Options tab.  

5. Click Customize.  

6. Type a new separator in the List separator box.  

7. Click OK twice. 

 NOTE    After you change the list separator character for your machine, all programs use the 

new character. You can change the character back to the default character by following the 

same procedure. 

 

Fraction  

Use the Fraction format to display or type numbers as actual fractions, rather than decimals. 

1. Select the cells that you want to format.  

2. On the Home tab, click the Dialog Box Launcher next to Number.  

 

3. In the Category list, click Fraction in the Category list.  

4. In the Type list, click the fraction format type that you want to use.  

Available fraction formats 

Fraction format  This format displays 123.456 as 

Single-digit fraction 123 1/2, rounding to the nearest single-digit fraction value 

Double-digit fraction 123 26/57, rounding to the nearest double-digit fraction value 

Triple-digit fraction 123 57/125, rounding to the nearest triple-digit fraction value 

Fraction as halves 123 1/2  

Fraction as quarters 123 2/4  

Fraction as eighths 123 4/8  

javascript:ToggleDiv('divExpCollAsst_IDALCSUB')
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Fraction as sixteenths 123 7/16 

Fraction as tenths 123 5/10  

Fraction as hundredths 123 46/100  

TIP  The number in the active cell of the selection on the worksheet appears in the Sample 

box, so that you can preview the number formatting options that you select. 

 NOTES   

 After you apply a fraction format to a cell, decimal numbers as well as actual 

fractions that you type in that cell will be displayed as a fraction. For example, typing 

.5 or 1/2 results in 1/2 when the cell has been formatted with a fraction type of Up to 

one digit.  

 If no fraction format is applied to a cell, and you type a fraction such as 1/2, it will be 

formatted as a date. To display it as a fraction, apply a Fraction format, and then 

retype the fraction.  

 If you don't need to perform calculations on fractions, you can format a cell as text 

before you type a fraction into it by clicking Text in the Category list. This way, the 

fractions that you type will not be reduced or converted to decimals. However, you 

cannot perform mathematical calculations on fractions that are displayed as text.  

 To reset the number format, click General in the Category box (Format Cells dialog 

box) or in the Number Format box (Home tab, Number group). Cells that are 

formatted with the General format do not have a specific number format. 

 

Currency  

1. Select the cells that contain the numbers that you want to display with a currency 

symbol.  

2. On the Home tab, click the Dialog Box Launcher next to Number.  

 

3. In the Category box, click Currency or Accounting.  
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4. In the Symbol box, click the currency symbol that you want.  

 NOTE    If you want to display a monetary value without a currency symbol, you 

can click None. 

5. In the Decimal places box, enter the number of decimal places that you want to 

display.  

6. In the Negative numbers box, select the display style for negative numbers.  

 NOTE    The Negative numbers box is not available for the Accounting number 

format. 

Tips 

 The number in the active cell of the selection on the worksheet appears in the Sample 

box, so that you can preview the number formatting options that you select.  

 To quickly display a number with the default currency symbol, select the cell or range 

of cells, and then click Accounting Number Format in the Number group on the 

Home tab. To use another currency, click the arrow next to Accounting Number 

Format, and then click the currency that you want.  

 To change the default currency symbol for Microsoft Office Excel and other 

Microsoft Office programs, you can change the default regional currency settings in 

Control Panel. Note that although the Accounting Number Format button image 

does not change, the currency symbol that you choose will be applied when you click 

this button.  

 To reset the number format, click General in the Category box (Format Cells dialog 

box) or in the Number Format box (Home tab, Number group). Cells that are 

formatted with the General format do not have a specific number format. 

 

Launching and exiting spreadsheet application 

To launch Microsoft Office Excel: 

 Click the Start button ; this opens the start menu. 

 Point on ―All Programs to display the All programs menu. 

 Point on Microsoft Office folder to display it contents. 
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 Click on Microsoft Office Excel 2007. Excel loads and opens. 

 

 

 

 

 

 

 

When you are done with what you are doing, you will have to close Microsoft Excel. To exit 

Microsoft Excel: 

  Click the Microsoft Office Button in the upper left corner of your Excel window,  

 Click Exit Excel.  If you have not saved your spreadsheet, a reminder box will appear 

asking you to do so. 

 

 

 

 

Alternative, you can use the close button, located at the top-right corner of the window to exit 

the Excel application. Again you will be notified to save any changes to your spreadsheet, if 

you have not done so. 

CREATING AND SAVING WORKBOOK 

Microsoft Excel opens with a new, blank workbook with three worksheets of which more can 

be added. But if you want to create your own workbook you can ignore that and follow the 

steps below. 

 Click the Office button 

 Click New 

The New Worksheet dialogue box appears with different pre-installed designs known as 

templates; and templates available online, with Blank Workbook selected. Since we want to 

create a whole new worksheet,  

 Click Create to create a new worksheet 
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Saving workbook for the first time 

 To save a workbook for the first time: 

 Click the Office button 

 Point on Save As. 

 Click excel workbook A Save As dialogue box appears.  

 In the Save In box, select the directory you want your 

workbook to be saved in. the default directory is My 

Document. 

 Type the appropriate name for your workbook in the File 

name box. 

 Click save - notice that the name of the workbook changes to 

the name you specified. 

Once you have given your workbook a file name you can save any subsequent changes made 

to it by just clicking on the save button located on the Quick Launch bar, or clicking the 

Office button and then clicking on save. you can also use the keyboard shortcut Ctrl + S 

 

CONSTRUCTING AND INSERTING SIMPLE FORMULA  

A formula is a sequence of values (2,5,6,19), arithmetic operators (+, -, *, /), rational 

operators (>, =, <) cell references (e.g. A15), functions (percentage, sum, average) that 

produce a new value from existing values. A formula identifies the calculation needed to 

place the result in the cell it is contained within. A cell containing a formula therefore has two 

display components; the formula itself and the resulting value. The formula is normally only 

shown when the cell is selected by "clicking" the mouse over a particular cell; otherwise it 

contains the result of the calculation. 

In Excel a formula starts with an equal sign (=). This tells the spreadsheet that a calculation 

needs to be done.  

Let us do some simple calculations with formula. The diagram below an invoice from a 

stationary store showing items sold, the unit price and the quantity. 

http://en.wikipedia.org/wiki/Calculation
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Let us calculate the total cost of each item sold. 

Pencil 

Unit price = 0.20 in cell B4 

Quantity sold = 15 in cell C4 

Therefore the total cost of the pencil = unit price * quantity. 

You can use the values or the cells to calculate the total cost. Remember that a formula starts 

with an equal sign (=). 

Hence, the total cost for the;  

 

Pencil 

 =B4*C4 

 

Pen  

 =B5*C5 

 

Book 

=B6*C6  

 

 

 

 

 

 

To find the Grand Total add cells D4, D5 ad D6. 

=D4+D5+D6 

Alternatively, you can use the function SUM. That is  

=SUM(D4,D5,D6) (i.e. add cells D4, D5 and D6) 

Or  

=SUM(D4:D6) (i.e. add cells in the range D4 to D6) more on SUM later. 
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After completing this chapter, you should be able to: 

 

i. Use functions common to arithmetic applications e.g. percentages, 

averages, count, maximum and minimum for simple calculation. 

 
OBJECTIVES 

 

 

 

 

 

 

 
 

 

Chapter
 15 

APPLICATION OF SELECTED 

FORMULA AND FUNCTIONS  

 
INTRODUCTION 

As we observed earlier in the previous chapter, formulas and functions are used in Excel to 

perform calculations, no matter how simple or complex they may be. In this chapter, we are 

going to consider how to use formulae functions in various spreadsheet calculations. 

 

USING FUNCTIONS COMMON TO ARITHMETIC APPLICATIONS 

 

We have already used one function – the Sum function. Sum is often required that it has its 

own button on the Ribbon. However, Microsoft Excel has hundreds of other useful functions. 

We are going to use six of these functions. They are: 
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 Sum  

 Averages 

 Percentages 

 Count 

 Maximum  

 Minimum   

 

Sum 

Another way of using the Sum function is the AutoSum. If you wish to find the total of a 

column or row of figures, select the cell at the bottom of the column or left of the row and 

click on the AutoSum icon. The formula will be written for you. You must make sure that the 

range of cells you require have been selected. An of this is displayed below. 

 

 

 

 

 

 

 

 

 

 

 

Average  

Average is used to find the relations of one group to the other, for example, in the 

examination data above, we can calculate each student‘s average by dividing their total mark 

by the number of subjects. To access the Average function,  

Click on the cell  

Click Insert function. The insert Function dialogue box opens. 

Click on Average and then OK. The Function Argument dialogue box opens.  



rkeyk 

 

 

186 

 
 Application of Selected Formula and Functions 

Type in the function (e.g. B4:E4) in Number text box, then click OK. 

 

Alternatively, you can use the Average function by typing it directly into the function bar - 

for example, =AVERAGE(B6:E6). 

 

Percentage  

We can find the percentage mark of each subject above by dividing it by the total mark. For 

example, the percentage of Joseph‘s Mathematics  score can be calculated as follows: 

=(B4/E4). That will give you 0.259928.  

Right-click on the answer 

Select Format Cells. The Format Cells dialogue 

box opens. 

Click on Percentage and then OK. The Percentage 

function is applied. 
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Count  

The count function can be used to find the range of cells containing values. The Count 

function could be used in the following way: 

=COUNT(B5:E5) 

 

 
 It may seem unnecessary since you can easily count the number of columns containing 

values; but when you are faced with a huge chunk of data to deal with;  

(e.g. =COUNT(A1:PQ1) the Count function becomes very necessary. 

 

Maximum  

The maximum function is used to find the largest value in a range of cells. For example to 

find maximum mark obtained in Mathematics, you can type in the formula bar 

=MAX(B4:B6)   

 

 

 

 

 

 

 

 

 

Minimum 

While Max is used to find the maximum value in a range, the Minimum 

function is used to find the smallest value in a range. Use the formula 

=MIN(D4:D6) to find the minimum of ICT  
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After completing this chapter, you should be able to: 

 

i.  Format worksheet using formatting tools. 

 
OBJECTIVES 

 

 

 

 

 

 

 

 

 

Chapter
 16 

 

FORMATTING WORKSHEET  

 

INTRODUCTION 

In chapter eight, we learnt how to format a Microsoft Word document using various 

formatting tools. Like Word, Excel has a lot of formatting tools which can be used to make a 

worksheet have the desired appearance. Some of the formatting tools and methods we are 

going to use to format Microsoft Excel worksheet are similar to those we used to format 

Microsoft Word document.  

 

FORMATTING WORKSHEET USING 

Some of the formatting tools we are going to use are change column width and row height, 

insert columns, rows and cells; delete columns rows and cells; merge and centre cells; text 

wrap and cell alignment. 

 

Changing column width 

When the text you enter into a cell is longer than the width of the 

column, the text with spill into the next column. To deal with this 
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problem you will have to increase the width of the column. To increase the width of a 

column: 

 Position the mouse pointer on the column label (the gray area) and move it to the edge 

of that column, as shown below. The mouse pointer will change to plus sign with 

arrows at either side. 

 Drag to the right to widen the width or to the left to decrease 

the width of the column. 

 

This is one way to change the width of a column.  Here is another way.   

 Point to the label of the column.  

 Right click on it. a menu pops up. 

 Select Column Width. The Column Width dialogue box open. 

 Type in the width you want. The default width is 8.43; you can 

increase or decrease it. The column width must not exceed 255. 

 Click OK. Notice the difference. 

 

 

 

Changing row height 

If it is required that you change the height of a row: 

 Position the mouse pointer on the row label and move it to the edge of that ro. The 

mouse pointer will change to plus sign with arrows at either side. 

 Drag to the top to increase the height or down to decrease the height of the row. 

 

Another method is to:  

 Right click on that row. 

 Select Row Height. 

 Type the desired figure in the text box. 

 

 

 

 

Inserting Rows 

While you are busily working on your spreadsheet project you realize that you have left a 

row-of-text out. What do you do? Well, you can delete all you have done and start afresh, 

which is not convenient, especially if you have covered much, so I would not recommend 

that. Now, let consider the ideal method. 

 Right-click on the label of the row above which you want the 

other row to be. 
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 Select Insert from the drop-down menu. A new row is inserted into the worksheet. 

 

 

 

 

 

Inserting columns 

We can in similar way insert a new column into a worksheet. To do that: 

 Right-click the label of the column. 

 Select Insert form the drop-down menu. A new column is inserted to the left of the 

selected column. 

 

 

 

 

 

 

 

Inserting cells 

There are times when you might mistakenly leave out a cell. To recover that you, you will 

have to insert a new cell. To insert a new cell: 

 Right-click on where that cell should be. 

 Select Insert from the drop-down menu. 

 The insert menu dialogue box opens. You can 

choose choose to shift the cells downwards or 

rightwards. 

 

 

 

 

 

Deleting rows 

Everything that can be made can be destroyed. There are cases where you 

may type a range of value in a wrong row, or some data may not be required 

anymore. In this case you will have to delete the entire row. To do that: 

 Right-click on the label of that row. 

 Select Delete from the drop-down menu. That row is deleted. 

 

Deleting columns 

To delete a column: 

 Right-click on the label of that column 

 Select delete, and off it goes.  
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Deleting cells 

To delete a cell: 

 Right-click on that cell 

 Select delete from the drop-down menu. The Delete 

dialogue box opens. Here, you can choose to shift the cells 

left or up. 

 

Merge and centre cells 

Merging cells means fusing individual cells into one. To merge cells: 

 Select the cells you want to merge 

 In the Alignment tab, click on the Merge & Centre button. 

 A dialogue box pops up with a caution that merging the cells 

will cause most of the data to vanish.    

 Click OK if you want to merge the cells, otherwise, click Cancel. You can click on 

Show Help for additional information on this option.  

 

 

 

 

 

 

For the effect of Merge and Centre, see below. 

 

 

 

 

 

 

Cell alignment  

You will see that all the values you enter are aligned to the right of the cells. You can keep 

them in the middle or to the right of each cell. To do that: 

 Select the cells. 

 On the Alignment tab, click on the Centre or Align to Left to align text to centre or 

right of the cells. 

 
 

Text aligned to the right  Text aligned to the left  Text centered 

 

An alternate method of aligning text is to: 
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Select the open button          on the Alignment tab. The format Cells dialogue box opens. Try 

out the various Text alignment options there. Change the angle of the text to 45
o
 and see the 

result. 
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After completing this chapter, you should be able to: 

 

i.  Demonstrate skills in editing and printing worksheet. 

ii. Demonstrate skills in previewing and printing worksheet. 

 
OBJECTIVES 

 

 

 

 

 

Chapter
 17 

EDITING AND PRINTING 

WORKSHEET  

 
INTRODUCTION 

 

When you are stuffed with a great deal of data to enter into your workbook and there are a lot 

of formulas to do, you might ignore some basic things such as spelling, page setup etc. The 

joy in using Microsoft Excel, like most spreadsheet applications, is that you can always go 

back and make the necessary changes. In this chapter, we are going to use various editing 

tools to edit our workbook. 

 

EDITING AND PRINTING WORKSHEET 

Before you finally print your workbook, there are a lot of thing you should check and be 

satisfied with. In this section we are going to: 

 Check spelling  

 Preview the layout  

 Review page breaks 

 Change page setup and sheet settings 

 Set printing option 
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Spell check 

Unlike Word, Excel does not underline wrong spellings. It is, therefore, very essential to run 

spell check to correct all spelling mistakes. You can either check the spelling of a cell or the 

entire workbook. To check the spelling of a cell: 

 Select the cell 

 Click the Review tab on the Ribbon 

 Click Spelling in the Proofing group. Excel presents 

spelling options, select the one you want. 

 

To check the spelling of the entire worksheet: 

 Click the select all button to select all cells. 

 Click on Spelling. 

 You can also click on any cell which does not contain any data, and then click on 

Spelling. Excel asks you whether you want to continue checking at the beginning.  

 Click Yes. 

 

 

 

 

 

 

 

Preview layout 

Preview your workbook will show you how the print out will look like. To preview your 

workbook: 

 Click the Office button 

 Point on Print 

 Click on Print Preview. Make the necessary 

adjustments and corrections to the layout and 

margins of the worksheet. 

 

 

 

 

 

 

Review page breaks 

If a worksheet exceeds the paper size specified, Excel automatically inserts a page break. A 

user can also insert page breaks to suit his needs. To insert a page break: 
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 Click on the View tab. 

 On the View Workbooks group, click on Page Book Review. Excel inserts a new page 

break. You can increase or decrease the size of the page break by dragging them to 

new positions. 

 

Change page setup and sheet settings 

The setup of the page will determine it print out. It is very important to review the page setup 

to make sure that it really fit your worksheet. To adjust page setup: 

 Click on the Page Layout tab 

 In the Page Setup group, click on the open button to open the page setup dialogue 

box. 

 Make all necessary changes to the page, margin, etc. make sure to select the right 

paper size and page orientation. 

 
 

To change the setting of each worksheet in the workbook: 

Click on the Sheet tab in the Page Setup dialogue box. Make the changes you desire and click 

OK. 
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PREVIEWING AND CHANGING PRINT OPTIONS 

Do you remember the print options we set for Microsoft Word documents? We can in similar way 

set print options in Excel. The most important thing with printing is to tell the printer what to 

print and how to print it. Unlike a word processor, you may need to highlight what you want 

to print.   

It's usually a good idea to see what our printout will look like – before you print it.  First, 

we‘ll use a Print Preview to ―see‖ what our spreadsheet looks like. You know the drill – 

click the Microsoft Office Button, point on Print, click Print Preview. 

At the top of the Print Preview screen you will see the 

Print Preview Tab.  We‘ll these buttons to assist us with 

our printing.   

Notice that the Next and Previous buttons are not 

highlighted – they are just gray.  This means that the 

buttons are not “active.”  This indicates that we are OK 

with our spreadsheet – it is all on one page.  If we saw that the Next button was active, this 

would mean that there are other pages to our spreadsheet.  If you‘ll look at the lower left 

corner of the Print Preview screen you‘ll see:  Preview: Page 1 of 1.  This confirms that 

our spreadsheet is on one page.   

Once you are satisfied with how your 

spreadsheet would look 

in print, you can go ahead 

and click Print. This opens 

the Print dialogue box. 
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The options here, if you remember are the same as those in Microsoft Word and any other 

program. (Refer to the print options in Word). 

Click OK to print your worksheet when you are done. 
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After completing this chapter, you should be able to: 

 

i. State the importance of Presentation application. 

ii. Explain the principles for designing presentations. 

iii. Explain the terminologies in Presentation application. 

 
OBJECTIVES 
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INTRODUCTION TO PRESENTATION 

APPLICATION 

INTRODUCTION 

Presentation is the practice of showing and explaining the content of a topic to an audience or 

learner. A presentation program, such as Microsoft PowerPoint, is often used to generate the 

presentation content. A presentation program is a computer software package used to display 

information, normally in the form of a slide show. It typically includes three major functions: 

an editor that allows text to be inserted and formatted, a method for inserting and 

manipulating graphic images and a slide-show system to display the content. In this chapter 

we will consider presentation programs, their importance and the popular terminologies used 

in association with presentation. 

 

http://en.wikipedia.org/wiki/Learner
http://en.wikipedia.org/wiki/Presentation_program
http://en.wikipedia.org/wiki/Microsoft_PowerPoint
http://en.wikipedia.org/wiki/Computer_software
http://en.wikipedia.org/wiki/Slide_show
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IMPORTANCE OF PRESENTATION APPLICATION 

There are many different types of presentations including professional (work-related), 

education, entertainment, and for general communication. These presentations are facilitated 

with the aid of presentation applications. Some specific importance of presentation 

applications are:  

1. Presentation application help the speaker to access his/her ideas easily. 

 

2.  They help the participants to grasp the ideas of the speaker with visual information 

which complements the talk.  

 

3. Presentation application supplement or replace the use of older visual aid technology, 

such as Pamphlets, handouts, chalkboards, flip charts, posters, slides and overhead 

transparencies. 

 

4. With quick slide transitions, presentation applications help the speaker to overcome 

limited time to present his/her information. 

5. Zooming presentation applications which have zoom user interface (ZUI) that are 

based on one infinite canvas on which all content is presented enables the presentation 

of richer detail of content, and gives a better overview and understanding of complex 

visual messages and relations. 

 

6. Many presentation programs come with pre-designed images (clip art) and/or have the 

ability to import graphic images. Custom graphics can also be created in other 

programs such as Adobe Photoshop or Adobe Illustrator and then exported.  

 

7. With the growth of digital photography and video, many programs that handle these 

types of media also include presentation functions for displaying them in a similar 

"slide show" format. For example, Apple's iPhoto allows groups of digital photos to 

be displayed in a slide show with options such as selecting transitions, choosing 

whether or not the show stops at the end or continues to loop, and including music to 

accompany the photos. 

 

8. Similar to programming extensions for an operating system or web browser, "add-

ons" or plug-in for presentation programs can be used to enhance their capabilities. 

For example, it would be useful to export a PowerPoint presentation as a Flash 

animation or PDF document. This would make delivery through removable media or 

sharing over the Internet easier. Since PDF files are designed to be shared regardless 

of platform and most web browsers already have the plug-in to view Flash files, these 

formats would allow presentations to be more widely accessible. 

 

9. Certain presentation programs also offer an interactive integrated hardware element 

designed to engage an audience (e.g. audience response systems) or facilitate 

presentations across different geographical locations (e.g. web conferencing). Other 

http://en.wikipedia.org/wiki/Pamphlet
http://en.wikipedia.org/wiki/Clip_art
http://en.wikipedia.org/wiki/Adobe_Photoshop
http://en.wikipedia.org/wiki/Adobe_Illustrator
http://en.wikipedia.org/wiki/Digital_photography
http://en.wikipedia.org/wiki/Digital_video
http://en.wikipedia.org/wiki/Iphoto
http://en.wikipedia.org/wiki/Extension_(computing)
http://en.wikipedia.org/wiki/Operating_system
http://en.wikipedia.org/wiki/Web_browser
http://en.wikipedia.org/wiki/Plugin
http://en.wikipedia.org/wiki/SWF
http://en.wikipedia.org/wiki/Portable_Document_Format
http://en.wikipedia.org/wiki/Platform_(computing)
http://en.wikipedia.org/wiki/Audience_response
http://en.wikipedia.org/wiki/Web_conferencing
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integrated hardware devices ease the job of a live presenter such as laser pointers and 

interactive whiteboards. 

PRINCIPLES FOR DESIGNING PRESENTATIONS 

A good presentation is the one that is well designed to suit the talk. There are some basic 

principles that have to be taken care of when planning and designing presentations. The 

principles are: 

 For a clear and understandable presentation, plan the content of the presentation 

thoroughly. Get hold of all the material you will need. 

 

 Know your audience. Many a presentation ends up being a mere fiasco because of the 

inability of the speaker to know his/her audience. Such presentations are often flooded 

with technical term and abbreviations which most of the audience have no idea of. 

 

 Keep the content interesting and to the point – overloading your presentation with 

information may bore the audience. 

 

 Use more pictures and graphics and ease down on the number of text used; besides, 

pictures are worth more than words. 

 

 Avoid using capital letters throughout. Capital letters are more difficult to read, 

therefore combine upper and lower case letters. Also use large and legible fonts which 

can be read at a distance an in a glance. 

 

 Use proper words and run spelling check to correct all spelling mistakes and 

grammatical errors. The intellectual capabilities of a speaker are often read from 

his/her choice of words. 

 

 Be careful with the colours you use, since too many colours or colours which do not 

contrast well will make your slide difficult to view and read. 

 

 If you are going to use preset timing for the transition of slides, make sure that it fits 

the pace – not too slow or too quick. 

 TERMINOLOGIES IN PRESENTATION APPLICATION  

1. Slide - Slide Show 

Each page of a presentation is called a slide. The default orientation of the slide is in 

landscape layout, which means that the slide is on a horizontal position with precise 

dimensions of 11" wide by 8 1/2" tall. Text, graphics and/or pictures are added to the slide to 

enhance its appeal.  Slide shows can be comprised of text and graphic objects or be 

completely covered by a single picture, as in a photo album.  

 

http://en.wikipedia.org/wiki/Laser_pointer
http://en.wikipedia.org/wiki/Interactive_whiteboard
http://presentationsoft.about.com/od/s/g/slide.htm
http://presentationsoft.about.com/od/s/g/slide_show.htm
http://presentationsoft.about.com/od/powerpoint101/ss/photo_album.htm
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2.  Bullet or Bulleted List Slide 

Bullets are small dots, squares, dashes or graphic objects that begin a short descriptive 

phrase.  The Bulleted List slide is used to enter key points or statements about your topic. 

When creating the list, hitting the Enter key on the keyboard adds a new bullet for the next 

point you want to add.  

 

3. Design Template 

Think of design templates as a coordinated packaged deal. When you decorate a room, you 

use colors and patterns that all work together. A design template acts in much the same way. 

It is created so that even though different slide types can have different layouts and graphics, 

the whole presentation goes together as an attractive package.  

 

4. Slide Layouts - Slide Types 

The terms slide type or slide layout can be used interchangeably. There are several different 

types of slides / slide layouts in presentation applications such as PowerPoint. Depending on 

the type of presentation you are creating you may use several different slide layouts or just 

keep repeating the same few.  

Slide types or layouts include -  

 title slides  

 bulleted list slides  

 content slides (for adding a chart, picture or table for example)  

 

5. Slide Views 

 Normal View - is also commonly known as Slide View. It is the main working window in 

the presentation. The slide is shown full size on the screen. 

 Outline View - shows all the text of all slides, in a list on the left of the PowerPoint screen. 

No graphics are shown in this view. Outline View is useful for editing purposes and can be 

exported out as a Word document to use as a summary handout. 

 Slide Sorter View - is a window in PowerPoint that displays thumbnail versions of all 

your slides, arranged in horizontal rows. This view is useful to make global changes to 

several slides at one time. Rearranging or deleting slides is easy to do in Slide Sorter view. 

 Notes View - shows a smaller version of a slide with an area underneath for notes. Each 

slide is created on its own notes page. The speaker can print these pages out to use as a 

reference while making his presentation. The notes do not show on the screen during the 

presentation. 

 

6. Task Pane 

The Task Pane changes to show options that are available for the current task that you are 

working on. For example, when choosing a new slide, the Slide Layout task pane appears; 

when choosing a design template, the Slide Design task pane appears, and so on.  

 

7. Transition 

Slide transitions are the visual movements as one slide changes to another.  

http://presentationsoft.about.com/od/b/g/bullet.htm
http://presentationsoft.about.com/od/powerpoint101/ss/slide_types_4.htm
http://presentationsoft.about.com/od/d/g/design_template.htm
http://presentationsoft.about.com/od/powerpoint101/ss/slide_types.htm
http://presentationsoft.about.com/od/no/g/normal_view.htm
http://presentationsoft.about.com/od/powerpoint101/ss/slide_views_3.htm
http://presentationsoft.about.com/od/s/g/slide_sorter.htm
http://presentationsoft.about.com/od/t/g/thumbnail.htm
http://presentationsoft.about.com/od/powerpoint101/ss/slide_views_5.htm
http://presentationsoft.about.com/od/t/g/task_pane.htm
http://presentationsoft.about.com/od/d/g/design_template.htm
http://presentationsoft.about.com/od/t/g/transition.htm
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8. Animations and Animation Schemes 

In Presentation applications, animations are visual effects applied to individual items on the 

slide such as graphics, titles or bullet points, rather than to the slide itself.  

Preset visual effects can be applied to paragraphs, bulleted items and titles from a variety of 

animation groupings, namely Subtle, Moderate and Exciting. Using an animation scheme 

keeps your project consistent in the look, and is a quick way to enhance your presentation.  

 

9. PowerPoint Viewer 

The PowerPoint Viewer is a small add-in program from Microsoft. It allows for a PowerPoint 

presentation to be played on any computer, even those that do not have PowerPoint installed. 

It can run as a separate program on your computer and can be added to the list of files when 

you choose to package your presentation to a CD.  

 

 

10. Slide Master 

Slide master is part of a template  that stores information, including placements of text and 

objects on a slide, text and object placeholder  sizes, text styles, backgrounds, color themes, 

effects, and animation. 

 

 

11.  Contextual Menus and Tabs 

Contextual menus and tabs appear when an object is selected. These contextual menus / tabs 

contain information or options pertinent to that object only. For example; if you are working 

with photos, the contextual menus show all the options available just for working with 

photos.  

In PowerPoint 2007, these contextual tabs are very much in view, unlike earlier versions, 

where these commands could be difficult to locate. This feature is an updated version of the 

"shortcut menus" used in earlier versions.  

These contextual tabs do not appear unless they are relevant to the selected object.  

 

 

 

 

 

 

 

 

http://presentationsoft.about.com/od/a/g/animation.htm
http://presentationsoft.about.com/od/b/g/bullet.htm
http://presentationsoft.about.com/od/s/g/slide.htm
http://presentationsoft.about.com/od/a/g/animation.htm
http://presentationsoft.about.com/od/a/g/anim_scheme.htm
http://presentationsoft.about.com/od/pq/g/ppt_viewer.htm
http://presentationsoft.about.com/od/addins/
http://presentationsoft.about.com/od/powerpointadvanced/ss/pack_and_go.htm
javascript:AppendPopup(this,'ofTemplate_1')
javascript:AppendPopup(this,'OfPlaceholders_2')
http://presentationsoft.about.com/od/powerpoint101/ig/PowerPoint-2007-Ribbon/06insert_contextual_picture_e.htm
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After completing this chapter, you should be able to: 

 

iv. Identify the commonly used features of a Presentation application in 

development of presentation. 

v. Demonstrate the use of the Help facility in Presentation application. 

 
OBJECTIVES 
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PRESENTATION APPLICATION 

WINDOW 

 
INTRODUCTION 

 

Every application or program is built with features that makes it unique from any other 

program, and able to do what it is made for.  

 

IDENTIFICATION OF COMMONLY USED FEATURES OF 

PRESENTATIONAPPLICATION WINDOW 

 

Presentation applications, like all other applications have some basic features which 

distinguish them from other programs. In this section we ae going to base our discussion on 

the most popular presentation application – Microsoft PowerPoint (2007).  
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When you launch your PowerPoint 2007 aplication you will find the window below with the 

various features. 

 

 

 

 

Microsoft Office Button 

The Microsoft Office Button, as you might have known by now, is prevalent in most of the 

Microsoft Office applications. Clicking on it will display the same menu as the Microsoft 

Office Button in Word and Excel.  

 

Quick Access Toolbar 

Like the Microsoft Office Button, I am sure you now familiar with the Quick Access Button. 

 

Tabs 

The tabs in PowerPoint are quite different from the tabs in two Microsoft applications we 

have considered already. Whiles in Word you will meet the |Home| |Insert| |Page Layout| 

|References| |Mailings| |Review| and |View| tabs, in PowerPoint instead of |Page Layout| 

|References| and |Mailings| tabs you will find the |Design| | Animation| and Slide Show| tabs. 

 

 

Tabs Ribbons Groups Microsoft Office Button Quick Access Toolbar 

Normal, slide sorter, Slide show 

Normal 

Slide/Outline 



rkeyk 

 

 

205 

Presentation Application Window 

Slide and Outline 

On the left side of the PowerPoint screen you‘ll see an area that indicates and Slides Outline 

at the top.  The Slide and Outline tabs displays thumbnails or small versions of each slide as 

you create it. When you first open PowerPoint 2007 you‘ll notice that the Slides tab is white.  

Normal, Slide Sorter and Slide Show 

The area running down the left side of the screen, which contained ―little‖ views of your 

slides, is called Normal View.  This is the ―default‖ view for PowerPoint. 

 

Normal view, Slide Sorter View Slide Show 

In the lower right corner of the screen you will see some ―buttons‖ that look like the image on 

the right. 

This is the PowerPoint View Toolbar. 

The Normal View gives you a view 

of the entire slide as well as the 

―mini-previews‖ of each slide in the 

area on the left.  This is the one we 

have been using so far.   

 

In Slide Sorter View you can see small images of each slide.  In this view you can click on a 

slide and drag your slide to any position in your show that you desire.  This view assists you 

in arranging your slides in the order that you desire for your presentation.   

 

The last button is Slide Show.  Anytime you want to view your presentation, click-on this 

button.  If you click on it now, you will see how the slide, on which you are working, will 

look.  When you are finished looking at your slide, tap the Esc button/key in the top-left part 

of your Keyboard.  This will take you back to the View in which you were working. 

 

To the right of the buttons, you will see a Zoom area that will allow you to Zoom in or out to 

enlarge or decrease the size of your slides. You should know that already, by now. 

 

 

THE USE OF THE HELP FACILITY IN PRESENTATION APPLICATION  

Does this symbol look familiar? Of course -  we saw it in Word, Excel and now 

PowerPoint. It is the shortcut to the help facility in all Microsoft Office 

applications. Like in Word and Excel, the help PowerPoint presents additional 

support for users on how to use the program.  

If you need any assistance with any feature in the application, the Help facility should be 

your first stop. It is an inbuilt teacher.  

When you click on the Microsoft Office PowerPoint Help button, the PowerPoint Help 

window opens. You can browse PowerPoint or click on any topic in the table of Contents to 

display the needed information. You can also type in specific question or keyword to find 

with the Search button. 

Slide Sorter View 

Normal View Slide Show 

Zoom 
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After completing this chapter, you should be able to: 

 

i. Insert objects, images and pictures into a presentation. 

ii. Edit, insert objects, images and pictures in presentation. 

 
OBJECTIVES 
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WORKING WITH OBJECTS, IMAGES  

AND PICTURES IN PRESENTATION 

 
INTRODUCTION 

 

A picture speaks a thousand words, so they say – and a good picture is worth more than a 

thousand words. There is an old Chines proverb which says that once seeing is about a 

thousand times talked about. 

Being able to use pictures in your presentation will not only make it beautiful, but will make 

your idea so alive in the eyes, minds and ears of your audience. Nevertheless, care must be 

taken so as to not engulf your presentaton with inappropriate pictres and images. The 

graphics you use in your presentaion must only emphasize what you want your audience to 

know – unfrtunately, that is not the case in many presentation designs. In this chapter, we are 

going to consider how to insert graphics into our presentations and how to edit those graphics 

to mke them much more effective.  
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INSERTING OBJECTS, IMAGES AND PICTURES INTO A PRESENTATION 

Microsoft PowerPoint Presentation allows you to add all kinds of graphics, charts, clip arts, 

pictures and animations into your presentation. Not only that, you can also change the colour 

scheme and the design template of the presentation window. 

 

Adding text to your presentation 

 

Click in the Click To Add Title text box and type ―MY FIRST 

PRESENTATION‖. 

Click in the Click to Add Subtitle text box and type ―I HOPE YOU LIKE 

MY PRESENTATION‖.  

On the Home tab, in the Slide group, select Layout. The Office Layout drops 

down. Your presentation should look like this: 
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. 

 

 

 

 

 

Inserting clip arts into a presentation 

To insert a clip art: 

In the Click to Add Text box click on Clip Art. The clip art gallery opens. 

In the Search In text box, select Everywhere, in Result Should Be text box select All media 

File Type. 

Click Go to open Clip Art. Click one to place it in the presentation.  

 

 

 

 

 

 

 

 

 

 

EDITING INSERTED OBJECTS, IMAGES AND PICTURES IN A PRESENTATION 

Graphics inserted in a presentation can be edited to fit into place in the presentation. Our clip 

art above looks too small - let us edit it. 

Hold the Resizing handles at the corners and drag the clip art into proportion. 
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Adding theme to your presentation 

 Themes are predesigned scheme of colours, mostly with background and layout, that you can 

employ in your presentation. To add a theme to your presentation: 

 Click the Design tab 

 In the theme group, click the theme you like. You can click the scroll arrows to see 

more themes. The selected theme is automatically added to your presentation.  

 

 

 

 

 

 

 

 

 

Inserting a new slide 

To insert a new slide into your presentation: 

On the Home tab, in the Slides group click on New Slide. That will insert a new 

slide with the theme you selected above. To insert a new slide with a different layout 

click the arrow under the New Slide button and select a different layout. 
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Inserting pictures into your presentation 

You can insert picture, mostly those about the talk, to your presentation. To do that: 

 Click the Insert tab in the Illustration group. 

 Click Picture – the Insert Picture dialogue box opens. Navigate to the directory 

containing the picture and then click Open. The picture is inserted in your 

presentation. 

 

  

 

 

 

 

 

 

 

 

Inserting charts into a presentation 

To insert a chart into your presentation: 

In the new slide window, click Insert Chart. The Insert Chart dialogue box opens, select 

your preferred chart and then click OK.  
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Running a Slide Show 

 
After completing this chapter, you should be able to: 

 

i. Run slide show. 

 
OBJECTIVES 

 

 

 
Chapter
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RUNNING A SLIDE SHOW 

 
INTRODUCTION 

 

We now come to the interesting, part if the previous sections have not fascinated you yet – 

running slide show. What is a slide show? A slide show is a series of graphics and text that is 

mormally projected on a screen to educate or entertain people.  

Six slides are the magic number for short presentations, and here is why: you want to stay on 

time, deliver a clear message, and keep other students and teachers interested. Limiting a 

show to six slides (plus a title slide) helps you to focus your message. That does not mean 
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that you cannot do more. In the previous chapter we created three slides, add three more to 

get the magic number and let us get started on running a slide show. 

RUNNING A SLIDE SHOW 

In this section we are going to view different presentations in different view modes. The view 

modes we are talking about here are: 

 Slides 

 Outline 

 Slide sorter 

 Note page 

 Slide show 

Slides  

When you open PowerPoint Presentation, the Slides is always located to the left 

of the window in Normal view. The slide, as you might know already, contains 

small versions of every slide that is created. Any changes made to any slide are 

reflected on the small versions in the Slide pane. You can click on the various 

slides in the Slide pane to navigate through you presentation. 

 

 

 

Outline  

Next to the Slide is the Outline – unlike the Slide which shows 

small graphical versions of the slides, the Outline shows only 

the text in the individual slides. You can edit and make 

corrections to text in the slide in the Outline. 

 

Slide Sorter 

The Slide Sorter also list small graphical versions of the slides just like 

the Slides; but the Slide Sorter view switches from the Normal view 

which shows the Slide/Outline pane and the main slides in the window 

and instead presents all the individual sides in the entire presentation. 
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Note Page 

You will notice a Click to add notes section at the bottom of the Normal View screen. This 

section is known as Note Page.  In this area you can type ―speaker notes‖ for each slide in the 

lower portion of the screen. When we cover printing, you will see that there is a print 

selection to print your speaker notes for each slide.  Then, during your presentation, you can 

refer to your printed notes.  

 

 

 

Slide Show 

The last button in the PowerPoint view Toolbar is known as the Slide Show. Clicking the 

Slide Show will start the presentation – that is the individual slides will be maximized to fill 

the window and be presented one after the other. You can either pre-time the slides so that the 

will change at the specified time or you can change the slides with a click of the mouse. 

When you are done with the presentation you can click the Esc key on the keyboard to return 

to the Normal View. Try running your presentation now. 
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The Master Slides 

 
After completing this chapter, you should be able to: 

 

i. Identify types of master slides. 

 
OBJECTIVES 
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THE MASTER SLIDES 

 
INTRODUCTION 

 

The Master Slide is the design template or design theme used for the slides within a 

presentation. Many colorful, preset design templates are included with PowerPoint to make 

your presentations more interesting. To make changes to your entire slides, edit the master 

slide rather than each individual slide. For example, if you are not interested in the choice of 

colour of the selected design template, you can make one quick change of colour in the slide 

master and that will affect all the slides available. The term master slide is often used 

incorrectly when referring to the slide master, which is only one of the master slides. 

 

http://presentationsoft.about.com/od/d/g/design_template.htm
http://presentationsoft.about.com/od/d/g/designtheme.htm
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There are three different master slides: 

 Slide master 

 Handout master 

 Notes master 

SLIDE MASTER 

The default design template when starting a PowerPoint presentation, is a plain, white slide. 

This plain, white slide is the Slide Master. Slide master is part of a template  that stores 

information, including placements of text and objects on a slide, text and object placeholder  

sizes, text styles, backgrounds, color themes, effects, and animation. All slides in a 

presentation are created using the fonts, colors and graphics in the Slide Master. Each new 

slide that you create takes on these aspects. 

When you save one or more slide masters as a single template file (.potx), it creates a 

template that you can use to create new presentations. Each slide master contains one or more 

standard or custom sets of layouts. 

The following picture shows a single slide master that contains three layouts. 

 

 

 

 

 

 

 

 

 

 

Adding a slide master to your presentation   

 On the View tab, in the Presentation Views group, click 

Slide Master. Slide Master is automatically inserted. If it is 

not:  

 On the Slide Master tab, in the Edit Master group, click Insert Slide Master.  

 Do one or both of the following: 

http://presentationsoft.about.com/od/d/g/default_templat.htm
http://presentationsoft.about.com/od/s/g/slide_master.htm
javascript:AppendPopup(this,'ofTemplate_1')
javascript:AppendPopup(this,'OfPlaceholders_2')
ms-help://MS.POWERPNT.12.1033/POWERPNT/content/HA10079907.htm
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If you want to remove an unwanted, default placeholder (boxes with 

dotted or hatch-marked borders that are part of most slide layouts. 

These boxes hold title and body text or objects such as charts, 

tables, and pictures.), click the border of the placeholder, and then 

press DELETE.  

If you want to add a placeholder, do the following:  

Click a thumbnail slide layout below the slide master that you 

added.  

On the Slide Master tab, in the Master Layout group, click 

the arrow next to Insert Placeholder, and then click a 

placeholder.  

1. Click a location on the slide 

master, and then drag to draw the placeholder.  

TIP  To resize a placeholder, drag one of its corner borders. 

 Click the Microsoft Office Button , click Save As.  

 In the File name box, type a file name, or do nothing to accept the suggested file 

name.  

 In the Save as type list, click PowerPoint Templates, and then click Save. 

Renaming a slide master 

1. On the View tab, in the Presentation Views group, click Slide 

Master.  

2. In the slide thumbnails on the left, click the slide master that you 

want to rename.  

3. On the Slide Master tab, in the Edit Master group, click 

Rename.  

4. In the Rename Master dialog box, in the Master name box, 

type a new name, and then click Rename. 

 

HANDOUT MASTER 

Changes that you can make to a handout include moving, resizing, and 

formatting the header and footer. You can also set the page orientation, 

and specify the number of slides to print per page. 

Slide 
master 

Other layouts 
in the Slide 
master 

javascript:AppendPopup(this,'ppdefPlaceholders_3')
javascript:AppendPopup(this,'ppdefPlaceholders_3')
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1. On the View tab, in the Presentation Views group, click Handout Master.  

2. Make the changes that you want.  

3. On the Handout Master tab, in the Close group, click Close Master 

View. 

 NOTE    The changes that you make to a handout master also appear in your 

printed outline. 

You can print your presentation in the form of handouts — with one, two, 

three, four, six, or nine slides on a page — that your audience can use to 

follow along as you give your presentation or keep for future reference. 

 

NOTES MASTER 

The Notes Master, not to be confused with the Handout Master, allows you to add and edit 

the notes in the Slide Master.  To open Notes Master: 

1.  On the View tab, in the Presentation Views group, click 

Notes Master.  

To edit Note Master: 

Double -click the placeholder containing the note you want to 

edit.  

You can use the Overtype mode or delete the existing notes and 

type your new notes in the place. 

4. When you are done, on the Slide Master tab, in the Close 

group, click Close Master View. 
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Customising Presentation 

 
After completing this chapter, you should be able to: 

 

i. Format text input in master slides. 

ii. Insert and edit pictures, images, drawn objects from a slide master. 

iii. Remove pictures, images, drawn objects from a master slide. 

iv. Apply preset text, image animation effect to slides. 

v. Apply transition effect between slides. 

vi. Apply animation effect to slide in normal view. 

vii. Apply animation in the slide sorter. 

 
OBJECTIVES 
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CUSTOMISING PRESENTATION 

 
INTRODUCTION 

 

To make your presentation interesting and suit the occasion or your audience, you can 

customise it. Customising a presentation means making change to it so that it will appear 

exactly the way you want it to.  

In this chapter we will format text input in master slides; insert, edit and remove pictures in a 

master slide; apply transition and animation effects to slides etc. - so climb aboard and let us 

get started.  
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FORMATTING TEXT INPUT IN MASTER SLIDES 

All the three types of master slides – Slide Master, Handout Master and Notes Master - give 

you the opportunity to make changes to the text input in them. Let us apply 

text formatting in each of the master slides. 

Formatting text input in Slide Master 

 On the View tab, in the Presentation Views group, click Slide Master. 

The slide master with the other layouts opens at the left , in the 

Slides/Outline pane. You will see thumbnail images of the slide master 

and all the different slide layouts that are contained within the slide 

master. 

 Select the first layout, which is the Slide Master layout. It contents are 

displayed in the main window. 

 In the Slide Master tab, in the Edit Theme group, click Fonts - a menu 

appears. You can select any of the theme fonts, but let us do something 

else. 

 Click Create New Theme Fonts. The Create New Fonts dialogue box 

appears. 

 In the Heading Fonts textbox, scroll to and select 

Castellar, and in the Body Font, select Ariel. The 

fonts you select are previewed at the textbox on the right 

of the dialogue box. 

 In the Name box, type a name for your new theme font. 

 Click Save. Notice the difference to the Slide Master. 

Click on each of the layouts under the Master Slide. 

What has happened? Yes, they have all taken the font them you specified. 

 

 

 

 

 

 

 

 

 

 

 

http://presentationsoft.about.com/od/t/g/thumbnail.htm
http://presentationsoft.about.com/od/s/g/slide_layout.htm
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Formatting text input in Note Master 

You can format text input in Note Master. To do that: 

 On the View tab, in the Presentation Views group, click Notes Master. 

 Double-click the Slide Master, and make all the necessary changes to the text. 

 

Inserting and editing with pictures, images, drawn objects from a 

master slide 

To insert a picture into Slide Master: 

On the View tab, in the Presentation Views group, click Slide 

Master. 

On the Insert tab, in the Illustration group, click Picture. The 

Insert Picture dialogue box opens. Select the picture you want 

and then click Insert.  

NOTE: If you insert the picture in Slide Master, the same picture will run throughout the 

available slides. But, if you want different picture in different slides, just select the individual 

slides and then insert the particular pictures.  

 

 

 

 

 

 

 

 

You can use the same process to insert pictures, charts, clip art etc. in Slide Master and the 

other two types of Master Slides. 

EDITING PICTURES IN A MASTER SLIDE 

When you click on the inserted picture the resize handlers appear. You can use them to resize 

he picture. If you inserted the picture in Slide Master, you will only be able to resize the 

picture in Slide Master.  

You can also crop the inserted picture – to do that: 
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On the Format tab, in the Size group, select Crop. The crop handlers appear on the picture, 

use them to crop the picture to the size you want. 

You can try your hands on al the picture formatting tools in the Format tab. 

Removing Pictures, Images Etc from a Master Slide 

If you insert a wrong picture in a slide or you are no more interested in the picture you 

inserted, you can delete it. To do that, select the picture and then press the Delete key. 

Applying Animation Effects to a Master Slide 

To make your presentation more interesting you can build it. Building is a term indicating 

how each line of the text (on a slide) will enter the screen.  The lines, words, letters, pictures 

and charts can move in or appear from almost any direction.  To Build the text on each slide, 

follow these directions.  

1. On the View tab, in the Presentation Views group, select Master Slide. 

2. On the Animations tab, in the Animations group, select Custom Animation. Thee 

Custom animation pane opens at the left of the screen. 

3. Click the Master Slide, and then click the placeholder of the item you wan to animate. 

4. In the Custom Animation pane, click Add Effect. A small menu rolls down. 

5. Point on Entrance and then click on any of the effects. For more effects, click More 

Effects. This opens the Add Entrance Effect dialogue box.  

 

6. Select the effect you want and click OK. 

7. To see how your effect plays, in the Custom Effect pane, click Play. If 

you are not interested in an animation effect you can either change or 

remove it  

You can add animation effects to all the placeholders and in the presentation. 
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Applying animation Effects to Slides in Normal View. 

1. In the Normal View, on the Animations tab, in the animations group, select Custom 

Animation. 

2. Click on each of the placeholders and add an Animation Effect to it following the 

steps above. 

Try your hands on other animation effects such as Emphasis, Exit, and I am 

sure you will love to work with Motions Paths. 
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Delivering a Presentation 

 
After completing this chapter, you should be able to: 

 

i. Explain the things to consider when delivering a presentation. 

ii. Edit presentation before delivering. 

iii. Add presenter’s notes to slides and deleting unwanted slides. 

iv. Apply transition effects on screen slide presentations 

v. Acquire show slides in a presentation 

 
OBJECTIVES 
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DELIVERING A PRESENTATION 

 
INTRODUCTION 

 

After considering all that we have discussed above about presentations, we now come to the 

real thing – delivering our well planned and prepared presentation. But since nothing is really 
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perfect, a so called well planned presentation could be flooded with chunks of errors. In view 

of this before we stand up, chest high, and make our presentation, there are some basic things 

that we must be aware of. 

THINGS TO CONSIDER BEFORE DELIVERING A PRESENTATION 

i. Understand how audience size, room size, room lighting impacts on planning of a 

presentation: such as need for a microphone, need for a projector, need for adjust 

contrast between background and data for legibility.   

ii. Understand how audience demography, knowledge of subject a 

presentation such as: need to present message differently based on 

age, educational background. 

iii. Understand how choice of font colours, number of colours used may 

bring out different responses from members of an audience such as 

varying emotional responses, possible distraction from key points by 

excess use of colour. 

iv. Be aware of colour blindness problems 

v. Understand some important planning and design concepts with delivering a 

presentation, such as: 

 Ensuring slides follow a logical sequence 

 Tailor contents to time available 

 Consider likely attention span of audience. 

 Consider an appropriate time interval for each slide in a presentation.   

 

EDITING PRESENTATION BEFORE DELIVERING 

As we did edit the Word documents and Excel workbooks we created in the previous 

chapters, we can in the same or similar way edit our presentations before we make them 

known to the public. We are going to consider how to spell-check a presentation and make 

changes. 

Do you remember how we used the spell-check function in Word? Let us open our previous 

presentation and mess around with the spelling. Try switching 

some of the letters in a word – for example, instead of MY 

FIRST PRESENTATION, make it mY FRIST PRSENATON . 

what happened? Good, the red-wavy underlines again. You 

know what to do, don‘t you?  

Right-click the problem word and select the correct word from 

the suggested options. That will remove the red-wavy underline 
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from the selected word, but to correct all spelling mistakes you may have in the presentation : 

On the Review tab, in the Proofing group, click Spelling. A dialogue box, like the one below 

opens with some spelling suggestions of the problem words. When you accept or ignore a 

suggestion, another suggestion on the next word with a spelling mistake is presented. 

 

 

 

 

 

When you finish correcting all spelling mistakes, a message box appears and tells you that 

there is no more spelling mistakes in your presentation. 

 

 

 

 

 

ADDING PRESENTER’S NOTE TO SLIDES AND DELETING 

UNWANTED SLIDES 

The presenter‘s notes are printed notes pages that accompany slides. Presenter‘s notes are 

further elaborations on the  concepts in the main slides. These notes can be given to the 

audience to guide them through he presentation.   

 

Create the notes pages 

Use the notes pane in Normal view to write notes about your slides. Notes pane is the pane in 

normal view in which you type notes that you want to accompany a slide. You print these 

notes as notes pages or have them display when you save a presentation as a Web page. 
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You can type and format your notes as you work in Normal view, but to see how your notes 

pages will be printed and to see the full effect of any text formatting, such as font colors, 

switch to Notes Page view. You can also check and change the headers and footers of your 

notes in Notes Page view. 

Each notes page shows an image of a slide, along with the notes that go with that slide. In 

Notes Page view, you can embellish your notes with charts, tables, or other illustrations. 

 

 

 

 

 

 Notes pages include your notes and each slide in the presentation. 

 Each slide is printed on its own notes page. 

 Your notes accompany the slide. 

 Data such as charts or pictures can be added to your notes pages. 

A picture or that you add in Notes Page view will appear on your printed notes page, but not 

on your screen in Normal view. If you save your presentation as a Web page, the picture or 

object does not appear when you display your presentation in the Web browser, although 

your notes do. 

The changes, additions, and deletions that you make on a notes page apply only to that notes 

page and to the note text in Normal view. 

If you want to enlarge, reposition, or format the slide image area or notes area, go to Notes 

Page view and make the changes. 

You can't draw or place pictures in the notes pane in Normal view. Switch to Notes Page 

view and draw or add the picture there. 

Applying content and formatting to all notes pages 

To apply content or formatting to all notes pages in a presentation, change the Notes Master. 

For example, to put a company logo or other piece of art on all of your notes pages, add the 

art to the Notes Master. Or, if you want to change the font style that is used for all notes, 

javascript:AppendPopup(this,'ppdefMaster_5')
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change the style on the Notes Master. You can change the look and position of the slide area, 

notes area, headers, footers, page numbers, and date. 

Displaying the notes pages on a Web page 

If you save your presentation as a Web page, your notes are automatically displayed unless 

you choose to hide them. The slide titles become a table of contents in the presentation, and 

your slide notes appear beneath each slide. Your notes can fill the role of the speaker, giving 

your audience the background and details that a speaker would provide during a live 

presentation. 

If you don't want your notes to be displayed on the Web page, you can turn them off before 

you save the file as a Web page. For more information about displaying notes pages on a 

Web page, see Display notes pages on a Web page. 

Deleting unwanted slides 

After designing your presentation you may find tat some information is not needed anymore 

or appear one too many. The slides containing such information can be deleted. You can 

delete a slide in either the Normal View or the Slide Sorter View.  

To delete a slide in Normal View, click on the thumbnail of that particular slide in the 

Slide/Outline pane, then press the Delete key. 

Or, right-click the thumbnail and select Delete Slide from the roll-down 

menu. 

To delete a slide in the Slide Sorter View, click the unwanted slide and then 

press the Delete key 

Or, right-click the slide and select Delete Slide from the roll-down menu. 

 

 

APPLYING TRANSITION EFFECT ON SCREEN SLIDE PRESENTATION 

Slide transitions are the animation-like effects that occur in Slide Show view when you move 

from one slide to the next. You can control the speed of each slide transition effect, and you 

can also add sound.  

Microsoft Office PowerPoint 2007 includes many different types of slide transitions, 

including (but not limited to) the following:  

ms-help://MS.POWERPNT.12.1033/POWERPNT/content/HA10065253.htm
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No transition 

Blinds Horizontal 

Blinds Vertical 

Box In 

Box Out 

Checkerboard Across 

Checkerboard Down 

Comb Horizontal 

Comb Vertical 

To see more transition effects, in the Quick Styles list, click the More button , as shown in 

the diagram above. 

Add the same slide transition to all of the slides in your 

presentation 

1. In the pane that contains the Outline and Slides tabs, click the Slides tab.  

2. On the Home tab, click a slide thumbnail.  

3. On the Animations tab, in the Transition To This Slide group, click a slide 

transition effect.  

To see more transition effects, in the Quick Styles list, click the More button . 

4. To set the slide transition speed, in the Transition To This Slide group, 

click the arrow next to Transition Speed, and then select the speed that 

you want.  

5. In the Transition To This Slide group, click Apply to All. 
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Adding different slide transitions to the slides in your presentation 

1. In the pane that contains the Outline and Slides tabs, click the Slides tab.  

2. On the Home tab, click a slide thumbnail.  

3. On the Animations tab, in the Transition To This Slide group, click the slide 

transition effect that you want for that slide.  

4. To set the slide transition speed, in the Transition To This Slide group, click the 

arrow next to Transition Speed, and then select the speed that you want.  

5. To add a different slide transition to another slide in your presentation, repeat steps 2 

through 4. 

Setting time interval between slides 

 You can control the time interval at which each slide is presented. To set the time 

interval: 

1. In the Normal or Slide Sorter View, click on the thumbnail of the slide. 

2. In the Animations tab, on the Transition to This Slide group, check 

the box next to Automatically After and select the time interval 

you want. You can set the same or different time intervals for each 

slide. 

3. You can also choose to control the transitions on mouse click. To do that, uncheck 

Automatically After and check On Mouse Click.  

 Add sound to slide transitions 

1. In the pane that contains the Outline and Slides tabs, click the Slides tab.  

2. On the Home tab, click a slide thumbnail.  

3. On the Animations tab, in the Transition To This Slide group, click the arrow next 

to Transition Sound, and then do one of the following:  

 To add a sound from the list, select the sound that you want.  

 To add a sound not found on the list, select Other Sound, locate the sound file 

that you want to add, and then click OK. 

4. To add sound to a different slide transition, repeat steps 2 and 3. 
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After completing this chapter, you should be able to: 

 

i. Change slide setup. 

ii. Select pint option for printing. 

 
OBJECTIVES 
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PRINTING PRESENTATION 

 
INTRODUCTION 

 

Presentations are made to be displayed on a screen, mostly with the aid of a projector, but it is 

most of the time ideal, if not always, to keep a hard copy of your presentations. The hard 

copy version of the presentation  serves as a backup in case power goes out. The paper 

version could also help you kno your way around in case you miss your way throught the on-

scren version. The presenter‘s notes provides in depth view of what is projected on the screen 

and could can the presenter talk further on  specific point. Given the audience a copy of the 

presenter‘s notes helps them follow the ideas and concepts displayed on the screen. 

 

In this chapter, we are going to consider how to print your presentations. 
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CHANGING SLIDE ORIENTATION  

 

Slide orientation is mostly landscape, but when printing ou may want  the printout to assume 

a portrait orientation, since since landscape printouts are mostly difficult to read. To 

chage the orientation of the slides in a presentation: 

 On the Design tab, in the Page Setup group, click the more arrow below 

Slide Orientaion. This unfolds the two availbe orientations – Portrait and 

Landscape, with Landscape already selected. 

 Click Portrait, to change th orientation to portrait. 

If you are not interested in portrait orientation and prefer landcsape instead, you can 

reverse the process and this time around click Landscape. 

  

CHANGING PAPER SIZE 

The printout will be on paper, and since the type of paper you use will determine the outcome 

of the printout, it will be convenient to set the size of the paper before you commence 

printing. To set paper size: 

 On the Design tab, in the Page Setup group, clcik page Setup. The Page Setup 

dialogue box opens.  

 In the Slides size For box, select A4 paper, which is the commonest paper size 

available, or you can specify the paper size you want form the Width and Height 

boxes, if it is not available in th Slides Size For box. 

 When you are satisfied with the changes you have made, click OK. 
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SELECTION OF PRINT OPTION 

 

In Excel and Word, if you remember, we tried a couple of print options. We are going to use 

similar options in this section. As one commands the computer with its software to perform a 

task, choosing the print option is the user‘s command to the printer to do what the user wants 

and how he/she wants it.  

 

Selection of print options for the entire presentation 

 To print the whole presentation: 

 Open the presentation you want to print. 

 Click the Microsoft Office Button . 

 Point on or click the arrow next to Print and click 

Print from the Preview and Print the Document 

menu. This opens the Print dialogue box. 

 

 

 

 

 

 

 

 

 

 

 

 In the Print range, leave it on All, since we are printing the entire presentation. 

 In the Print What text box, select Slides. 

 Click OK to print the entire presentation. 

 

Selection of print option for printing specific slides 

 To print the whole presentation: 

 Open the presentation you want to print. 

 Click the Microsoft Office Button . 

 Point on Print and click Print from the Preview and Print the Document menu. 

This opens the Print dialogue box. 
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 If you want to print the active slide select Current Slide in the Print range, but if 

you want to print some other slides, click on Slides and then type the slide range 

separated by comma, for example, 2,3,5,7,8.  

 Click OK to print the selected slide range. 

 

Selection of printing option for printing handouts 

 To print the whole presentation: 

 Open the presentation you want to print. 

 Click the Microsoft Office Button . 

 Point on or click the arrow next to Print and click Print from the Preview and Print 

the Document menu. This opens the Print dialogue box. 

 In the Print What text box, select Handouts. 

 Click OK to print the entire handout. 

 

Selection of printing option for printing handouts 

 To print the whole presentation: 

 Open the presentation you want to print. 

 Click the Microsoft Office Button . 

 Point on or click the arrow next to Print and click Print from the Preview and Print 

the Document menu. This opens the Print dialogue box. 

 In the Print What text box, select Notes Pages. 

 Click OK to print the notes pages. 

 

Selection of printing option for printing outline view of slides  

 To print the whole presentation: 

 Open the presentation you want to print. 

 Click the Microsoft Office Button . 

 Point on or click the arrow next to Print and click Print from the Preview and Print 

the Document menu. This opens the Print dialogue box. 

 In the Print What text box, select Outline View. 

 Click OK to print. 

NOTE: 

  If you want your printout to be in color, in the Colour/grayscale, select Colour. 
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 In Copies, type in the number of copies you want to print. You can set other print 

options to meet your needs. 
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Developing Organisation Chart Using Presentation Application 

 
After completing this chapter, you should be able to: 

 

i. Develop organization chart with labeled hierarchy using a presentation 

application. 

ii. Change the hierarchical structure of an organization chart. 

 
OBJECTIVES 
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DEVELOPING ORGANISATION CHART 

USING A PRESENTATION APPLICATION 

 
INTRODUCTION 

 

An organization chart graphically represents the management structure of an organization, 

such as a school where you may have a head teacher, assistant head teacher, teachers school 

prefects etc. and also in a company - a department managers and non-management employees 

in that hierarchical order. Microsoft Office has Smart Art graphic which makes it possible for 

one to create organisation charts in Word, Excel, Outlook and PowerPoint.  These 

organisation charts can be included in your worksheet, presentation, or document. To create 

an organization chart quickly and easily, you can type or paste text in your organization chart 

and then have the text automatically positioned and arranged for you. 
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When you add an assistant shape to an organization chart layout, such as Organization 

Chart, a bullet with a line attached indicates the assistant shape in the Text pane. 

 

 

 

 

 

 

Although you can use other hierarchy layouts to create an organization chart, the assistant 

shape and the hanging layouts are available only with organization chart layouts. 

To quickly add a designer-quality look and polish to your SmartArt graphic, you can change 

the colors or apply a SmartArt Style to your organization chart. You can also add effects, 

such as glows, soft edges, or 3-D effects. In Office PowerPoint 2007 presentations, you can 

animate your organization chart. 

Creating an organization chart 

1. On the Insert tab, in the Illustrations group, click SmartArt.  

 

 

 

  

2. In the Choose a SmartArt Graphic gallery. 

3. Click Hierarchy from the left pane. 

4. Click an organization chart layout (such as Organization Chart). 

5. Click OK.  
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6. To enter your text, do one of the following:  

 Click in a shape in the SmartArt graphic, and then type your text.  

NOTE    For best results, use this option after you add all of the shapes that you want. 

 Click [Text] in the Text pane, and then type your text.  

 Copy text from another location or program, click [Text] in the Text pane, and 

then paste your text.  

If the Text pane is not visible 

1. Click the SmartArt graphic.  

2. Under SmartArt Tools, on the Design tab, in the Create Graphic group, 

click Text Pane. 

Adding shapes to your organization chart 

1. Click the SmartArt graphic that you want to add a shape to.  

2. Click the existing shape that is located closest to where you want to add the new 

shape.  

3. Under SmartArt Tools, on the Design tab, in the Create Graphic group, click the 

arrow under Add Shape, and then do one of the following:  

   

 To insert a shape at the same level as the selected shape but following it, click 

Add Shape After.  

 To insert a shape at the same level as the selected shape but before it, click Add 

Shape Before.  

 To insert a shape one level above the selected shape, click Add Shape Above.  

The new shape takes the position of the selected shape, and the selected shape 

and all of the shapes directly below it are each demoted one level. 

 To insert a shape one level below the selected shape, click Add Shape Below.  

javascript:ToggleDiv('divExpCollAsst_IDA4JGWC')
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The new shape is added after the other shapes at the same level. 

 To add an assistant shape, click Add Assistant.  

The assistant shape is added above the other shapes at the same level in the 

SmartArt graphic, but it is displayed in the Text pane after the other shapes at the 

same level. 

Add Assistant is available only for organization chart layouts. It is not available 

for hierarchy layouts, such as Hierarchy. 

 NOTES   

 Although you cannot automatically connect two top-level shapes with a line in the 

organization chart layouts, such as Organization Chart, you can imitate this look by 

adding a shape to your SmartArt graphic and then drawing a line to connect the 

shapes.  

 To show a dotted-line reporting relationship between two shapes, right-click the line, 

and then click Format Shape on the shortcut menu. Click Line Style, and then click 

the Dash type that you want.  

 To add a shape from the Text pane, place your cursor at the beginning of the text 

where you want to add a shape. Type the text that you want in your new shape, press 

ENTER, and then to indent the new shape, press TAB, or to negative indent, press 

SHIFT+TAB.  

To add an assistant shape, press ENTER while an assistant shape is selected in the 

Text pane. 

Change the hanging layout of your organization chart 

A hanging layout affects the layout of all shapes below the selected shape. 

1. Click the shape in the organization chart that you want to apply a hanging layout to.  

2. Under SmartArt Tools, on the Design tab, in the Create Graphic group, click 

Layout, and then do one of the following:  

 

 To center all of the shapes below the selected shape, click Standard.  

ms-help://MS.POWERPNT.12.1033/POWERPNT/content/HA10075853.htm#3
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 To center the selected shape above the shapes below it and arrange the shapes 

below it horizontally with two shapes in each row, click Both.  

 

 

 To arrange the selected shape to the right of the shapes below it and left-align the 

shapes below it vertically, click Left Hanging.  

 

 To arrange the selected shape to the left of the shapes below it and right-align the 

shapes below it vertically, click Right Hanging.  
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Change the colors of your organization chart 

You can apply color combinations that are derived from the theme colors (theme colors: A 

set of colors that is used in a file. Theme colors, theme fonts, and theme effects compose a 

theme.) to the shapes in your SmartArt graphic. 

1. Click the SmartArt graphic whose color you want to change.  

2. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, click 

Change Colors.  

 

3. Click the color combination that you want. 

TIP  When you place your pointer over a thumbnail, you can see how the colors affect your 

SmartArt graphic. 

Apply a SmartArt Style to your organization chart 

A SmartArt Style is a combination of various effects, such as line style, bevel, or 3-D, that 

you can apply to the shapes in your SmartArt graphic to create a unique and professionally 

designed look. 

1. Click the SmartArt graphic whose SmartArt Style you want to change.  

2. Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, click the 

SmartArt Style that you want.  

To see more SmartArt Styles, click the More button . 

javascript:AppendPopup(this,'ofcolortheme_1')
javascript:AppendPopup(this,'ofcolortheme_1')
javascript:AppendPopup(this,'ofcolortheme_1')
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 NOTES   

 When you place your pointer over a thumbnail, you can see how the SmartArt Style 

affects your SmartArt graphic.  

 You can also customize your SmartArt graphic by moving shapes, resizing shapes, 

and adding a fill or effect. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ms-help://MS.POWERPNT.12.1033/POWERPNT/content/HA01205871.htm
ms-help://MS.POWERPNT.12.1033/POWERPNT/content/HA01205872.htm
ms-help://MS.POWERPNT.12.1033/POWERPNT/content/HA10077361.htm
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KEYBOARDING PRACTICE 
 
DRILL #1: HOME ROW 

1. aaa ;;; sss lll ddd kkk fff jjj 
2. aa ss dd ff aa ss dd ff 
3. ;; ll kk jj ;; ll kk jj 
4. ad ad as as ask ask ad ad as as ask ask 
5. ;;; lll kkk jjj ;;; lll kkk jjj 
6. add add fad fad jak jak sad sad fall fall jak jak 
7. add fad; add fad; add jak; add jak; sad fall; sad fall; 
8. a a as as fad fad dad dad ;; ;; ja ja ka ka la la 
9. jas jas kas kas las las jas jas kas kas las las jas jas 
10. jf kd ls ;a jf kd ls ;a jf kd ls ;a jf kd ls ;a 
11. fall fall sad sad all all all sad falls; all sad falls; 
12. lad lad asks asks sas sas kass kass 
13. lad asks sas kass; lad asks sas kass; 
14. a a sad sad dad dad fall fall; a sad dad fall; 
15. dad dad sad sad kad kad lad lad 
16. dad dad; sad sad; kad kad; lad lad; 
17. lad; dad; sad; lass; lad; dad; sad; lass; 
18. fad fad; ads ads; all all; fad ads all lads; 
19. ask a lad; a fall ad; ask a dad; 
20. as a lad; as a dad; as a sad lass; 
 

DRILL #2: H and E 

1. a;sldkfj a;sldkfj aa ;; ss ll dd kk ff jj 
2. as ad all jak fad fall lass as ad all jak fad fall lass 
3. a lad; a dad; ask a dad; ask a lass; a fall fad; 
4. jjj hhh jjj hhh jhj jhj jhj jhj aaa hhh aaa hhh ah ah ha ha 
5. jhj hjh jhj hjh aha hah aha hah had had has as ash ash 
6. ah ah ha ha; had had has ash; has had a hall; as had a hall; 
7. ddd eee ddd eee ded ded ded ded el el led led eel eel eke eke 
8. ede ede ede ede lee lee lee lee fed fed fed fed eke eke eke eke 
9. a lake; a lake; a leek; a leek; a jade; a jade; a desk a desk; 
10. he he she she shed shed heed heed held held he she shed heed held 
11. he held a lash; she held a jade; he she held sash; 
12. he has fled; he has a sale; she has a sale; he as ash; 
13. ask ask has has lad lad all all fall falls 
14. a sash; had all; a fall jak; a lad sash; 
15. he he she she led led held held she she fell fell 
16. he he led led; she she had had; she she fell fell; 
17. a jade shelf; a jade desk shelf;; she had a shed; 
18. he sells desks; she sells desks; he sells jade; 
19. he led; she led; he as jade; she has jade; 
20. she asked a lad; he asked a lass; she fell; he fell; 
 

Drill #3: I and R 
1. a;sldkfj fjdksla; a;sldkfj fjdksla; dad lad fad ask 
2. jh jh jh jh hj hj hj hj hah hah has has had had sash sash 
3. ed ed led led fled fled sled sled ed led fled sled 
4. k k k k ik ik ik ik is is is is if if if if did did did did 
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5. aid aid aid aid kid kid kid kid hail hail hail hail 
6. if if if if is is is is kid kid kid kid his his his his 
7. a kid; a lie; he did aide his lie; if a kid lied; 
8. fff rrr fff rrr fff rrr fff rrr frf frf frf frf rfr rfr rfr rfr 
9. jar jar red red her her far far red jar her fare 
10. rake lake lark jar hear her dark red air 
11. rake rake lake lake lark lark jar jar hear hear her her 
12. dark dark red red air air sir sir fir fir fire fire 
13. he is; she is; if her; if his; her aide; his aide; 
14. he he; if if; is is; ed ed; as as; 
15. she she; her her; hah hah; red red; air air; hair hair; 
16. shed shed; rake rake; hear hear; fare fare; lark lark; 
17. he if is ed as; she her hah red air; 
18. hair shed; rake hear; fare lark; 
19. if he is did fir jak all fall jak did he is if 
20. a red jak; he ask her; she ask her aide; if she fell; 
21. she did; he did; he led her; she is her aide; 
22. she had a red jar; she had a fire sale; 
 

Drill #4: REVIEW 

1. he he has has fir fir; she she had had jak jak; 
2. he had a jade jar; she had a jade jar; 
3. she had a leek sale; she had a leek sale; 
4. if is ha lie rid die did sir fir lie led jar 
5. ad has lad kid rah jak led her ask lid had 
6. fall jeer hah all keel fire hall add iris 
7. if he is she if as is if is she if is he 
8. she did; a jak; he led; she has; he is; if he; 
9. a lid jar; all her ads; a red fish; a jade ad; 
10. if he; 
11. as if she; 
12. he had a desk; 
13. she had a red jar; 
14. he had a lead all fall; 
15. she asked if he reads ads; 
16. she sees all adds she reads; 
17. her dad had a fall sales ad in red; 
18. is is if if ah ah he he el el ad ad ha ha 
19. if if fir fir did did eel eel jak jak are are 
20. eel eel jak jak ire ire are are aid aid red red 
 

Drill #5: O and T 

1. had a fall; as a fall add; a sad dad fall; a dad dad; 
2. he sees her aid; he irks her; a red fish; a red aid; 
3. he sells red desks; she had a jar fall; he sells desks; 
4. lll ooo lll ooo ooo lll ooo lll lol lol lol lol 
5. ol ol ol ol of of of of or or or or for for for for 
6. or or or or for for for for oak oak oak oak off off off off 
7. do so; do so; of old; of old; of oak of oak; of old red oak; 
8. fff ttt fff ttt ttt fff ttt fff ftf ftf ftf ftf 
9. it it it it at at at at tie tie tie tie the the the the fit fit fit fit 
10. tf tf tf tf fit fit fit fit sit sit hit hit kit kit tie tie 
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11. too too toe toe hot hot lot lot too too toe toe hot hot lot lot 
12. too hot; odd fort; odd lot; jot a lot; 
13. to rot; the lot; for this; dot it; for the lot; 
14. sit kid jak kit old hit led is kid dot jak sit 
15. he led she led had see held fled has jade leads 
16. he asked her to led the fled fit tie sit kit 
17. it fit tie sit kit its fits hits kits lit hit tie it 
18. a fit is kit sits it fits a dit a tie sits hits fits 
19. ooo rrr ooo rrr or or or or for for for for ore ore ore ore 
20. he rode; a rod; a door; a rose; a rod; a rod door; a rose door; 
21. or it do to of odd too for she the too 
22. of all she is or the to do if he do so it is it if 
23. if she asked a lad; the lad off to the lake; 
24. he or she; off the old jet; she left the jet; a red salad; 
 

Drill #6 : N and G 

1. has a lad; a fall lad fad; has a red salad; 
2. do it; do it; a tot; a tot; do a lot; do a lot; it is hot; it is hot; 
3. to do; do to; a tot; tot a; do a lot; lot a do; dot it; it dot; 
4. her skis; her kid; his aide; it is far; is a kid; 
5. jjj nnn jjj nnn jjj nnn jjj nnn jnj jnj jnj jnj 
6. nj nj nj nj jn jn jn jn an an an an and and and and 
7. end end ant ant land land hand hand fan fan 
8. fff ggg fff ggg fff ggg fff ggg fgf fgf fgf fgf 
9. fg fg fg fg gf gf gf gf nj nj nj nj jn jn jn jn 
10. he got; to the fog; he got to jog; he got to golf; 
11. no nag ago gone long go on; a nag; no gain; long ago; 
12. log in so soon; a fine sing; led a hand; no gain; 
13. he got an old dog and she is gone; 
14. she jogs in the fog; 
15. she and he jog in the dense fog; 
16. she and he go to golf in dense fog; 
17. she and he golf a nine in the north area 
18. he has an oar; he jogs; do a log for her; she left a red jar; 
19. an an go go in in dig dig end end and and go go to to 
20. he did it for her; he is to take the old jet; 
 

Drill #7: LEFT SHIFT AND PERIOD 

1. aa ;; ss ll dd kk ff jj gg hh ff jj dd kk ss ll aa ;; 
2. hhh eee iii rrr ooo ttt nnn ggg hh ee ii rr oo tt nn gg 
3. is he; an if; do or; go to; an oak; all of; 
4. J J J J Ja Ja Ja Ja K K K K Ka Ka Ka Ka L L L L La La La La 
5. Ha Ha Ha Ha Hal Hal Hal Hal Ja Ja Ja Ja Jan Jan Jan Jan 
6. Kal did it; Hans is red; Jan at the fig; 
7. I I I I Ia Ia Ia Ia Ian Ian Ian Ian 
8. lll … lll … lll … lll … l.l l.l l.l l.l fl. Ed. Ft. hr. in. 
9. I do too. Ian is not. Ola did it. Jan does this. Kent is gone. 
10. Hal did it. I shall get on a train and do this. 
11. J. L. Hanes skis on the lake. Larry also does it. 
12. I said ft. is for feet and rd. is for road and fl. is for floor. 
13. Lt. John let L. K. take the old gong to the lake. 
14. Larry asked the old store kid for a kit. 
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15. I like Ike and John. 
16. Ike said to take the old road to get to the lake. 
17. if so it is to do it do to is he go do if it is to so if 
18. Lars sent the log to the ski lodge. 
19. do is the got if the for the ask the end 
20. O. J. lost one of the logs off the train. 
21. Ja Ja Ka Ka La La Ia Ia Oa Oa Ja Ja Ka Ka La Ia Ia Oa Oa 
 

Drill #8: Review 
1. J. L. O. I. ik rf ol ed nj gf hj tf .l ft. i. e. e.g. 
2. is or to a go is he and got the for led kit 
3. I got the ski. Jan led Nan. Hal is gone. 
4. hj hj hj hj jh jh jh jh ed ed ed ed de de de de she she led led 
5. Heidi had a lead the end of the set one. 
6. sir sir ire ire ore ore his his risk risk fire fire ride ride 
7. Kate is at high risk if he rides the horse. 
8. so if of too of hot old the toe so if of too of hot old toe 
9. Nan took the list to the food store. 
10. nj nj nj nj hj hj hj hj go go go go an an an an got got got got 
11. Lane sings nine songs. 
12. J. K. is going to Idaho to sing the songs. 
13. Nan took the train at nine. 
14. Janet asked to take the ski to the lake. 
15. Karl and Janet said he left the lake at noon. 
16. Jan needs the data sheet too. 
17. I felt ill just as the ski lift started up the hill. 
 

Drill #9: U and C 

1. fjdksla; fjdksla; a;sldkfj a;sldkfj he he he he ir ir ir ir 
2. ot ot o tot ng ng ng ng L. L. L. L. he ir ot ng L 
3. do so to go fan hen log tan son not sign and fan tan 
4. Olga and Jena has the first skate slot. 
5. jjj uuu jjj uuu jjj uuu jjj uuu uj uj uj uj ju ju ju ju us us us us 
6. jug jug jug jug sue sue sue sue lug lug lug lug use use use use 
7. due for us; the red fur; use it again; is it hers; 
8. ddd ccc ddd ccc ddd ccc ddd ccc dcd dcd dcd dcd cod cod cod cod 
9. cog cog cog tic tic tic can can can cot cot cot hot hot hot 
10. ice ice can can doc doc tic tic dock dock cue cue cut cut 
11. cues cues duck duck clue clue coat coat cut cut cake cake 
12. I found a fur coat that had cake on it. 
 

Drill #10: W and Right Shift 

1. aaa ;;; sss lll ddd kkk fff jjj he ir ot ng l. uc he ir ot ng l. 
2. us us cut cut sue sue cot cot nut nut lug lug ice ice can can 
3. Janet took the lead in the race for the record. 
4. sss www sss www sss www sws sws sws sow sow sow sow 
5. wow wow wow lows lows lows lows shows how shows how 
6. cows cows now now row row own own tows tows 
7. how is; so low; to sow; to own; row now; go now; 
8. aaa A A A aaa A A A ccc C C C ccc C C C fff F F F ddd D D D 
9. Dan Del Dennis Fran Frank Francis Sue Stan Scott 
10. Rio Rip Run Willa Will Wanda Alan Ali Ariel Cat Chris Curtis 
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11. Wil left the show which he won the award 
12. Frank will go to Rio next fall. 
 

Drill #11: B and Y 

1. fff bbb fff bbb fff bbb fff bbb fib rib rob but big but bad fibs 
2. bbb fff bbb fff bbb fff bbb fff bid bid bud bud rob rob lob lob 
3. rib fib rub orb rob but bid a rib; to fib; it rubs; or rob; she bid; 
4. jjj yyy jjj yyy jjj yyy jjj yyy jyj jyj jyj jyj jy jy jy jy yj yj yj yj 
5. jay jay lay lay day day say say hay hay stay stay 
6. yj yj yj yj jay jay eye eye dye dye yes yes yet yet 
7. to say; jay eye; dye the eye; a dyed jay eye; 
8. by and by; buy it; a byte; the boy, the buoy; 
9. Jay and Janet went to the store to buy bread. 
10. hhh eee iii rrr ooo ttt nnn ggg L J K … uuu ccc www R F W bbb yyy 
11. he he it it rot rot now now go go us us wow wow by by 
12. no in bow any cut ran bin cow deck any rain wow sub 
13. See the baby cub that Cody went to buy. 
14. Buy the big baby a sub sandwich. 
15. for the hand such did cut now held furl eight ask now 
16. to do to buy can go for all did ask her to buy bow wow 
17. if she had to work and such for this she held the goal 
18. The auburn hair flew in the light wind. 
19. Bobby left the show and went to the city. 
 

Drill #12: REVIEW 
1. tf bf cd uj .l nj gf tf ol rf ik ed hj tf bf cd uj .l nj fg tf ol 
2. by by jay jay lay lay hay hay say say buy buy boy boy yet yet 
3. Fran and Jan knew about the red and gold truck. 
4. clay when they than won sly den win den send tend won one 
5. in a way | she was fine | to buy a hen | they will win 
6. John can bid on the old clock he saw at the station. 
7. I know she will be here soon. 
8. Lt. John Sorensen and Nan went to Sol for the day. 
9. Jana and Rod are in Sweden; Jane and Bo go in June. 
10. Cody and Janet went to the lake to see the boat. 
11. Work for us in Los Angeles then again in San Francisco. 
12. Jana, Aida and Ross went off to the club to golf. 
13. she owns dug buys cog job for yet ask led head red 
14. of if | the all of | and do |cut it | he go | to do it | do it too 
15. Lake Tahoe had a big ice show today. 
16. Jack said to leave this job and find a new one. 
17. Cindy left for work one hour ago. 
18. Rudy and Judy have good jobs in town. 
19. Allan and Allen and Jon and John and Peg and Peggy 
20. John and Jan are going to work then to the sale. 
21. Row the boat to the dock. 
22. Carl has an old kayak and a canoe. 
23. Stan told us to set goals and go for it. 
24. She said for us to get going on our goals. 
25. It is our job to go as high as we can go. 
26. The big signs close to the area will go to Jake 
27. The big boat dock has a lot of birds on it. 
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28. All left the club as the news ended. 
29. Jeff left the club as the news started. 
30. The goal was to lower cost and the task force did it. 
31. Larry likes new stuff so this was not too rough. 
32. I hike each day on the road side near the school. 
 

Drill #13: M and X 
1. ow bf if rf us by ik tf ik nj nj yj ik tf hj cd uj gf by us 
2. bet you but bit dye fib yes by bye boy buy dye yes yet 
3. I can win the gold but I must set a higher goal. 
4. jjj mmm jjj mmm jmj jmj jmj jmj am am am am me me me me 
5. mj mj mj mj jm jm jm jm me me me me may may may may 
6. yam yam yam yam men men men men jam jam jam jam 
7. sss xxx sss xxx sss xxx sss xxx sxs sxs sxs sxs sxs sx sx sx 
8. ox ox ox ox fox fox fox fox fix fix fix fix nix nix nix nix 
9. a fox; an ox; nix it; fix it; hit an ax; by six; by fixing it’ 
10. me ox am ax jam ham hem men lax fox mix lox 
11. to lax; fix it; mix it; six men to fix; six men to hex; 
12. Mix a ham salad for six; Max can fix tea; Max can fix ham for six; 
 

Drill #14: P and V 
1. no cad him bet no in we my be on ad on my ax bet him 
2. just is | of work | to sign | of lace | to flex | a form | sign it 
3. He won a medal at the show for sixth. 
4. ;;; ppp ;;; ppp ;;; ppp ;;; ppp ;p; ;p; ;p; ;p; pen pen lap lap 
5. pa pa pa pa pan pan pan pan nap nap nap nap paw paw paw paw 
6. a pen and cap; pay then pick it up; plan to keep a promise; 
7. fff vvv fff vvv fff vvv have have have have five five five five 
8. vf vf vf vf vie vie vie vie van van van van view view view view 
9. dive dive dive dive go via; vie for; has vim; a view; to live; 
10. cup up vie pen van cap vim rap have keep plan live life 
11. gave it up; pave it; save it; very apartment; give me a cup; 
12. Vic plans to have the van pick us up at five or six. 
 

Drill #15: Q and Comma 
1. ask jam for own buy dig via fix all do dig 
2. a map; an apt.; her plans; have five; 
3. Sixty pints of jam will be sent to her. 
4. aaa qqq aaa qqq aaa qqq aaa qqq qt. qt. qt. qt. 
5. quad quad quad quad quit quit quit quit aqua aqua aqua aqua 
6. quite quite quite quite squad squad squad squad 
7. kkk ,,, kkk ,,, kkk ,,, kkk ,,, kit, kit, kit, kit, kite, kite, kite, kite 
8. a kit, a kite, a bike, a hike, a kit, a kite, a bike, a hike 
9. I see that Pam and Ike are here but Stan will be late. 
10. Enter the words quote, quite, quo, aqua, and quit. 
11. I think I will quit the squad along with Raquel. 
12. We were quite quick to quit the movie. 
 

Drill #16: Review 
1. Virgil and Jack found the mosque at six. 
2. Pam, Quinn, Carl, Van and Hope will be here at five. 
3. Vic and Vim will aid the girl with her sign work. 
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Paragraph #1 
When you strike the enter key at the end of a line it is called a hard return. If you just 
continue to key without striking the enter key the computer will automatically go to 
the next line. This is called a soft return. 
 
Paragraph #2 

There is another phrase for soft return. It is called wordwrap. It is much easier to 
use and saves you time and effort. Strike the enter key at the end of each paragraph. 
4. I will fix the sign and charge them for it. 
5. Jay, Jim, Julie, Janice will sit in the blue auto. 
6. Todd will fish the docks for a big fish. 
7. I want a big bowl of salad and a cup of chili. 
8. Cal and Carl just won a big prize at the fair. 
9. so so an an if if is is us us am am by by or or ox ox 
10. is she in | pay in advance | if he may | in a firm 
11. I will keep pens by my desk in a tan and yellow tray. 
12. I will give the new toy to the little boy down the street. 
13. J. V. M. S. Dr. or Mrs., Ph.D. or Ed.D., July, August, September 
14. Mrs. Mr. Miss Mrs. Marnie Fowers, Dr. Mark V. Jensen, Mr. T. Ott 
15. B. J. Smith has a birthday in March. Go to the party with her. 
16. Mary has a Ph.D. from N.Y.C.; Dolly will get a Ed.D. 
17. jam for pay got the lap ox cut run ran jam ham pan 
18. make them move when both then their there that the 
19. to sit | by me | by six | old oak | did go |for the air 
20. to tie | I own | pay him | cut ties | for they 
21. I may have six students who will do the job for free. 
22. Vicky and John will pack a box lunch for the fair. 
23. I plan to bike for five days with John. 
24. You will find the best price for the tent at Big K. 
25. qa qa qa qa bf bf bf bf by by by by qt. qt. qt. qt. ft. ft. ft. ft. 
26. John is the brainy one and Jess is the brawny one. 
27. sx sx sx sx sw sw sw sw dc dc dc dc de de de de fv fv fv fv fr fr fr fr 
28. I keyed ox, mix, fox, fix, nix, six, and tricks. 
29. ;p ;p ;p ;p lo lo lo lo ki ki ki ki ju ju ju ju 
30. jn jn jn jn jm jm jm jm k, k, k, k, l. l. l. l. 
31. jy jy jy jy jh jh jh jh fg fg fg fg ft ft ft ft fb fb fb fb 
32. fv fv fv fr fr fr de de de dc dc dc sw sw sw sx sx sx aq aq aq 
 

Drill #17: Z and Colon (:) 
1. John won a diving trophy for six events at our state meet. 
2. to busy | down town | by the city | with us 
3. I have to go into town to sign a document with my mom. 
4. aaa zzz aaa zzz aaa zzz aaa zzz aza aza aza aza zap zap zap zap 
5. zoo zoo zoo zoo zip zip zip zip zag zag zag zag oz. oz. oz. oz. 
6. zoo zoo zoo zoo zip zip zip zip maze maze maze maze 
7. eight oz. twelve oz. twenty oz. fifteen oz. nineteen oz. 
8. ;;; ::: ;;; ::: ;;; ::: To: File: Shift: Reply to: Dear Alan: 
9. Leave two spaces after typing a colon. 
10. Shift in opposition when keying capital letters at the beginning of names. 
11. John, Jim, Larry, Ted, Janice, Steve, Paul, Tawna 
12. Zoe, Zen, Liza, Quigg, Paul, Olga, Ivan, Yoda 
13. You must shift with the left hand to get the colon to work. 
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14. hazy quad quit zone quay zeal quote zap qt. zoo Zen Zelda 
15. Joey amazed us all when he won the state math contest. 
16. apt six fix flex flax next harp rip open drop the pen 
17. Lex and Lars are twin boys who like to fix apple pie for six friends. 
18. mime mime mime mime mama mama move move move move 
19. vamp vamp vamp vamp dive dive dive dive five five five five 
20. Glena made the dog work extra hard before putting him in the kennel. 
21. Six of the firms had to pay a large fee to the state. 
22. See the quick red fox jump over the lazy tan dog. 
23. Give me the six big tips to help me with my history quiz. 
 
Paragraph 1 

Always use good form when keying. It will help build speed and accuracy. Always 
look at what you are keying instead of the keyboard. Keep your wrists flat and fingers 
curved over the home keys. 
 
Paragraph 2 
Bouncing hands will cause more errors and slows the typist down. Stay in control 
and be firm when reaching for your keys. 
24.fix it mix it key it tie it hit it bonk it drop it 
25. Key the following: Oxen, exit, axle, sixty, and sixth. 
26. qa qa qa qa aq aq aq aq ki ki ki ki ik ik ik ik qt. qt. qt. qt. 
27. Key the following: Quit, aqua, equal, quiet, and quick. 
28. Lazy Lucy liked to sleep during her first class of the day. 
29. p: qa ;p aq zap zap zip zip size size lazy lazy 
30. Put hot peppers in the zany zesty salsa and put it on his pizza. 
31. Magic Marvin and marvelous Mavis vowed to move faster and with more vim and 
vigor. 
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PREFACE 

 

Why ICT? 

Over the years, computer and its related technologies have changed the landscape of the 

world. Information and communication technology (ICT) has become, within a very short 

time, one of the basic building blocks of modern society. Many countries, including Ghana, 

now regard understanding ICT and mastering the basic skills and concepts of ICT as part of 

the core of education. It is with this respect that the policy makers of Ghana have introduced 

the study of Information and Communications Technology (ICT) into the Senior High School 

curricula of the country.  

 

Who Is This Book For? 

This book is based on the syllabus structured for Senior High Schools in Ghana, and with 

that, it is most suitable for Senior High School students. Notwithstanding, other people who 

are interested n learning ICT can as well use this book to get the best implanted herein. It 

deals with ICT in secondary schools, and with the changing competencies required of both 

students and teachers if they are to function effectively in today's society.  

 

How This Book Is Structured And How It Can Help You. 

This book is intermingled with text and explanatory graphics. it is filled with practical 

activities and assignment which the students will be required to do. It would be extremely 

helpful if users of this book follow the advice, hints and tricks in it. The book also addresses 

the concerns of those who might not have access to computers by providing paper versions of 

some practical activates stated in the syllabus.  

 

 

DEDICATION 

This book is dedicated to Miss Christiana Acheampong, the Senior House Mistress of 

Western Senior High Technical School, Takoradi, for her supports.  
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